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Hardware Overview of the Modem Router 1

The NETGEAR® Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000, in this manual referred
to as the modem router, deIrvers combined WiFi connection speeds of up to AC1900 WiFi (600 Mbps on 2.4
GHz? 802.11n and 1300 Mbps on 5 GHz 802.11ac). Both 2.4 GHz and 5 GHz radios can be active
simultaneously.

The modem router provides fast central storage, backup, and streaming to every device in your home with
the USB 3.0 port (10 times faster than USB 2.0). Sharing content across your network is easy, from accessing
stored photos and music to wirelessly printing. Stream your stored media files anywhere on the network to
DLNA screens. Share your music to Airplay-compatible devices from the USB hard-drive connected to the
router. Use the free NETGEAR ReadySHARE Vault app to back up your Windows computers to a USB hard
drive connected to Nighthawk.

The modem router is compatible with most major DSL Internet service providers and also supports cable or
fiber Internet service.

The chapter contains the following sections:
* Unpack Your Modem Router on page 11

e Attach the Antennas on page 11

e Top Panel with LEDs on page 12

e Back Panel with Ports, Buttons, Connectors, and Switch on page 15
» Side Panels with USB Ports on page 17

* Bottom Panel Product Label on page 17

Note For more information about the topics that are covered in this manual, visit the support
website at support.netgear.com.

Note Firmware updates with new features and bug fixes are made available from time to time at
downloadcenter.netgear.com. You can check for and download new firmware manually. If
the features or behavior of your product does not match what is described in this guide,
you might need to update your firmware.



http://support.netgear.com
http://downloadcenter.netgear.com

Note In this manual, the terms wireless and WiFi are interchangeable.

1. Maximum wireless signal rate derived from IEEE standard 802.11 specifications. Actual data throughput and wireless coverage will vary.
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead,
lower actual data throughput rate and wireless coverage. NETGEAR makes no express or implied representations or warranties about this
product’s compatibility with any future standards. 802.11ac 1300 Mbps is approximately 3x faster than 802.11n 450 Mbps.

2.The 2.4 GHz performance mode requires 256 QAM support on the WiFi client.

3. Up to 1300 Mbps wireless speeds can be achieved when you are connecting to other 802.11ac 1300 Mbps devices.

10
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Unpack Your Modem Router

Your package contains the following items.

5

Figure 1. Package contents for the modem router

Table 1. Legend

Modem router

Antennas (3)

Power supply (varies by region)

DSL micrdfilter (varies by region)

Ethernet cable

28 IS Il O A

Phone cable

Your package might contain more items. The filter or phone cable provided depends on the region. In
some regions, a CD is included in the package.

Attach the Antennas

The router comes with three antennas.

To attach the antennas:

1. Align the antennas with the antenna posts on the back panel of the modem router.

Hardware Overview of the Modem Router
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2. Attach the antennas on the threaded antenna posts.
3. Position the antennas for the best WiFi performance.

NETGEAR recommends that the center antenna be vertical and that you aim the others outward at
45-degree angles, as shown.

Top Panel with LEDs

The status LEDs and buttons are located on the top panel of the modem router.

Figure 2. LEDs and buttons of the modem router

Hardware Overview of the Modem Router
12
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Table 2. LED and button descriptions

LED Description

* Solid amber. The modem router is starting.

If the Power LED lights solid amber during any other time, a power-on self-test
(POST) failure or device malfunction occurred.

For more information, see Power LED Remains Solid Amber on page 298.

Power

* Blinking amber. The modem router was reset to factory default settings and is
restarting.

For more information, see Use the Reset Button on page 238.
* Solid white. The modem router is ready.
* Off. Power is not supplied to the modem router.

Hardware Overview of the Modem Router
13
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LED

Description

For more information, see Power LED Is Off on page 298.

Internet

Solid white. The modem router detected an Internet connection.

Solid amber. The modem router is not connected to a DSL, cable, or fiber
modem, or the modem router did not detect an Internet connection.

For more information, see Troubleshoot the Internet Connection on page 299.
Blinking white. Data is being transmitted over the Internet connection.

Alternating white and amber. The traffic meter is enabled and the traffic limit
is reached.

Off. The modem router cannot connect to the Internet or the Internet connection
failed.

For more information, see Internet LED Is Off on page 300.

DSL

Solid white. The modem router is connected to a DSL service and the DSL
connection is ready.

Blinking white. The modem router is negotiating the best possible speed on
the DSL line.

Off.The modem router is not connected to a DSL service or a DSL connection
is not established.

Solid white. The 2.4 GHz WiFi radio is operating.

2.4 GHz WiFi
Blinking white. The modem router is sending or receiving WiFi traffic over the
2.4 GHz radio.
Off. The 2.4 GHz WiFi radio is off.

5 GHz WiFi Solid white. The 5 GHz WiFi radio is operating.

Blinking white. The modem router is sending or receiving WiFi traffic over the
5 GHz radio.

Off. The 5 GHz WiFi radio is off.

USB 3.0 port 1 and USB|

3.0 port 2

Solid white. A USB device is connected and is ready.
Blinking white. Data is being transmitted to or from the USB device.

Off. No USB device is connected, or someone clicked the Safely Remove
Hardware button and it is now safe to remove the attached USB device.

Ethernet ports 1-4

The LED color indicates the speed: white for Gigabit Ethernet connections and
amber for 100 Mbps or 10 Mbps Ethernet connections.

Hardware Overview of the Modem Router
14
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LED

Description

* Solid white or solid amber. A powered-on device is connected to the Ethernet
port.

* Blinking white or blinking amber. Data is being transmitted over the port.
* Off. No powered-on device is connected to the Ethernet port.

WiFi On/Off button with
WiFi LED

Pressing this button for two seconds turns the 2.4 GHz and 5 GHz WiFi radios on
and off.

If this LED is lit, the WiFi radios are on. If this LED is off, the WiFi radios are turned
off and you cannot use WiFi to connect to the modem router.

For more information, see Control the WiFi Radios on page 123 and WiFi LED Is Off
on page 298.

WPS button with WPS
LED

This button lets you use WPS to join the WiFi network without typing the WiFi
password. The WPS LED blinks white during this process and then lights solid white.

For more information, see Use WPS to Add a Device to the WiFi Network on page
114.

You can use the LED On/Off switch on the back panel of the modem router to turn most LEDs on the top
of the modem router on or off (see Back Panel with Ports, Buttons, Connectors, and Switch on page 15).
If you turn off the LEDs, the Power LED remains on.

Back Panel with Ports, Buttons, Connectors, and Switch

The back panel of the modem router provides ports, buttons, antenna connectors, a DC power connector,
and an LED switch. For information about attaching the antennas, see Attach the Antennas on page 11.

Hardware Overview of the Modem Router
15
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Figure 3. Modem router back panel

In addition to the three antennas, viewed from left to right, the back panel contains the following
components:

LED Off/On switch. Move the LED Off/On switch to to the Off position to turn off all LEDs, except
for the Power LED.

Reset button. For information about using the Reset button, see Return the Modem Router to Its
Factory Default Settings on page 238.

Power On/Off button. Press the Power On/Off button to provide power to the modem router.

DC power connector. Connect the power adapter that came in the product package to the DC power
connector.

Internet port. One Gigabit Ethernet RJ-45 WAN port to connect the modem router to a fiber or cable
modem. This port is colored red.

Note You can use either the Internet port or the DSL port for WAN connectivity.

Hardware Overview of the Modem Router
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» Ethernet LAN ports. Four Gigabit Ethernet RJ-45 LAN ports to connect the modem router to LAN
devices. These ports are colored yellow.

* DSL port. One RJ-11 DSL port for connecting the modem router to an ADSL or VDSL line. This port
is colored gray.

Note You can use either the DSL port or the Internet port for WAN connectivity.

Side Panels with USB Ports

Each side panel provides one USB 3.0 port. The left side panel contains USB port number 1. The right
side panel contains USB port number 2.

Figure 4. Right side panel of the modem router

Bottom Panel Product Label

The product label on the bottom panel of the modem router lists the login information, WiFi network name
(SSID) and password (network key), serial number, and MAC address of the modem router.

Hardware Overview of the Modem Router
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Figure 5. Modem router product label

Hardware Overview of the Modem Router
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Install and Access the Modem Router and
Its Network

This chapter describes how you can install and access the modem router and its network.

The chapter contains the following sections:

Position Your Modem Router on page 20

Connect to the Modem Router on page 20

Set Up Your Modem Router for DSL Service on page 24

Set Up the Modem Router for Cable or Fiber Service on page 32

Log In to the Modem Router After Setup to View or Change Settings on page 39
Change the Language on page 40

Change the admin Password on page 41

Set Up Password Recovery on page 42

Let the Modem Router Automatically Update Its Firmware on page 43

Access the Modem Router with the NETGEAR genie App on page 43

19
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Position Your Modem Router

The modem router lets you access your network anywhere within the operating range of your WiFi network.
However, the operating distance or range of your WiFi connection can vary significantly depending on
the physical placement of your modem router. For example, the thickness and number of walls the WiFi
signal passes through can limit the range.

Additionally, other WiFi access points in and around your home might affect your modem router’s signal.
WiFi access points are routers, repeaters, WiFi range extenders, and any other device that emits a WiFi
signal for network access.

Position your modem router according to the following guidelines:

» Place your modem router near the center of the area where your computers and other devices operate
and within line of sight to your WiFi devices.

» Make sure that the modem router is within reach of an AC power outlet and near Ethernet cables for
wired computers.

* Place the modem router in an elevated location, minimizing the number walls and ceilings between
the modem router and your other devices.

* Place the modem router away from electrical devices such as these:
e Ceiling fans
¢ Home security systems
*  Microwaves
e Computers
e Base of a cordless phone
e 2.4 GHz cordless phone

* Place the modem router away from large metal surfaces, large glass surfaces, insulated walls, and
items such as these:

e Solid metal door

e Aluminum studs

* Fish tanks
e Mirrors

* Brick

e Concrete

If you are using adjacent access points, use different radio frequency channels to reduce interference.

Connect to the Modem Router

During and after installation, you can connect to the modem router’s network through a wired or WiFi
connection. If you set up your computer to use a static IP address, change the settings of your computer
so that it uses Dynamic Host Configuration Protocol (DHCP).

Install and Access the Modem Router and Its Network
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Connect to the Modem Router Through an Ethernet Cable

You can connect your computer to the modem router using an Ethernet cable and join the modem router’s
local area network (LAN).

To connect your computer to the modem router with an Ethernet cable:

1. Make sure that the modem router is receiving power (its Power LED is lit).
2. Connect an Ethernet cable to an Ethernet port on your computer.
3. Connect the other end of the Ethernet cable to one of the numbered Ethernet ports.

Your computer connects to the local area network (LAN). A message might display on your computer
screen to notify you that an Ethernet cable is connected.

Join the WiFi Network of the Modem Router

Choose either the manual or the WPS method to add a WiFi device such as a computer, iPhone, iPad,
or gaming device to the WiFi network of the modem router.

Manual Method

On the WiFi device that you want to connect to the modem router, you can use the software application
that manages your WiFi connections.

To connect a device manually to the WiFi network of the modem router:

1. Make sure that the modem router is receiving power (its Power LED is lit).

2. Onthe WiFi device that you want to connect to your modem router, open the software application that
manages your WiFi connections.

This software scans for all WiFi networks in your area.
3. Look for the modem router's network and select it.

If you did not change the nhame of the network during the setup process, look for the default WiFi
network name (SSID) and select it. The default SSID is on the product label.

4. Enter the modem router password.

Install and Access the Modem Router and Its Network
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The default WiFi password (also referred to as the network key or passphrase) is also on the product
label.

5. Click the Connect button.
The device connects to the WiFi network of the modem router.

Wi-Fi Protected Setup Method

Wi-Fi Protected Setup (WPS) is a standard for easily adding computers and other devices to a home
network while maintaining security. To use WPS (Push 'N' Connect), make sure that all WiFi devices to
be connected to the network are Wi-Fi certified and support WPS. During the connection process, the
client gets the security settings from the modem router so that every device in the network supports the
same security settings.

To use WPS to connect a device to the WiFi network of the modem router:

1. Make sure that the modem router is receiving power (its Power LED is lit).

2. Check the WPS instructions for your computer or WiFi device.

3. Press the WPS button on the top panel of the modem router for three seconds.
4

Within two minutes, press the WPS button on your WiFi device, or follow the WPS instructions that
came with the device.

The WPS process automatically sets up the device with the network password and connects the
device to the WiFi network of the modem router.

For more information, see Use WPS to Add a Device to the WiFi Network on page 114.

Types of Logins

Separate types of logins serve different purposes. This section describes the differences so that you know
which login to use when.

Types of logins:

Install and Access the Modem Router and Its Network
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* ISP login. The login that your Internet service provider (ISP) gave you logs you in to your Internet
service. Your ISP gave you this login information in a letter or some other way. If you cannot find this
login information, contact your ISP.

*  WiFi network key or password. Your modem router is preset with a unique WiFi network name
(SSID) and password for WiFi access. This information is on the product label. Use this information
to connect a WiFi device to the WiFi network of the modem router.

« Modem router login. This logs you in to the modem router interface from an Internet browser as
admin.

NETGEAR genie Automatic Setup Utility

You can use the NETGEAR genie automatic setup utility during initial installation and setup of your modem
router. This utility functions with both types of Internet service that the modem router supports:

e DSL service. If you install your modem router for DSL service (the modem router supports ADSL and
VDSL service), you can set up your modem router with the NETGEAR genie automatic setup utility,
which launches the first time that you set up the Internet connection for your modem router. The
NETGEAR genie automatic setup utility runs on any device with a web browser.

For more information, see Set Up Your Modem Router for DSL Service on page 24.
e Cable or fiber service. If you install your modem router for cable or fiber service, you can set up your
modem router with the NETGEAR genie automatic setup utility, which launches the first time that you

set up the Internet connection for your modem router. The NETGEAR genie automatic setup utility
runs on any device with a web browser.

For more information, see Set Up the Modem Router for Cable or Fiber Service on page 32.

Note After initial installation and setup, the NETGEAR genie Setup Wizard is always
accessible to assist you with setting up an installation with DSL service or an
installation with cable or fiber service. For more information, see Use the Internet
Setup Wizard After Initial Setup on page 46.

Whether you install your modem router for DSL service or for cable or fiber service, you can always use
the genie menus and pages to set up your modem router manually.

Before you start the setup process, get your ISP information and make sure that the settings that are
described here are specified for the computers and devices in the network.

When your Internet service starts, your Internet service provider (ISP) typically gives you all the information
that you need to connect to the Internet. For DSL service, you might need the following information to set
up your modem router:

Install and Access the Modem Router and Its Network
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* The ISP configuration information for your DSL account
e ISP login name and password
* Fixed or static IP address settings (special deployment by ISP; this setting is rare)

If you cannot locate this information, ask your ISP to provide it. When your Internet connection is working,
you no longer need to launch the ISP login program on your computer to access the Internet. When you
start an Internet application, your modem router automatically logs you in.

Set Up Your Modem Router for DSL Service

You can install your modem router for DSL service or for cable or fiber (Ethernet WAN) service. If you
use a DSL modem, follow the procedure that is described in Cable the Modem Router for DSL Service
and Access the Modem Router on page 24. If you use a cable or fiber modem, follow the procedure that
is described in Set Up the Modem Router for Cable or Fiber Service on page 32.

DSL Service

Make sure that your ADSL or VDSL service is active before you install the modem router. You need the
following information to install your DSL modem and connect to the Internet:

* DSL user name and password. This information is included in the welcome letter your DSL ISP sent
you when you signed up for your service. Record your DSL Internet service account user name and
password.

* Your telephone number or DSL account number. If you do not use voice service, you can use your
DSL account number in place of a phone number.

If you do not know or cannot locate your DSL user name and password, call your DSL Internet service
provider (ISP). Be specific when speaking with your DSL Internet service provider. For example, you could
say, “I need my DSL service user name and password. Can you help me?”

Note If your provider says that they do not support NETGEAR services, tell them that you
need only your DSL user name and password. You do not need support.

Cable the Modem Router for DSL Service and Access the
Modem Router

The following figure shows the cabling of your modem router for DSL service.
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Figure 6. Modem router cabling for DSL service

To connect your modem router to a DSL service:

1.

o

10.

Unplug your DSL modem'’s power, leaving the DSL modem connected to the wall jack for your Internet
service.

If your DSL modem includes a battery backup, remove the battery.
Install an ADSL or DSL microfilter between the phone line and the phone.

The product package contains either an ADSL or DSL microfilter.
Use a phone cable to connect the microfilter to the gray DSL port on the modem router.
The product package contains a phone cable.

If your DSL modem includes a battery backup, reinsert the battery.
Plug in your DSL modem's power and turn on your DSL modem.
Connect the power adapter to the modem router and plug it into an electrical outlet.

Wait for the Power LED to light solid white, which takes about two minutes.

If the Power LED does not light, press the Power On/Off button.
Wait for the WiFi LED to light solid white.

If the WiFi LED does not light, press the WiFi On/Off button

Check the DSL LED @
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If the modem router is connected to a DSL service, the DSL LED lights white.
11. Connect a computer to the modem router by one of the following methods:

Ethernet cable. Use an Ethernet cable to connect your computer to a yellow Ethernet LAN port
on the modem router.

The product package contains a yellow Ethernet cable.
Your computer connects to the modem router’'s LAN.

WiFi. Connect to the default WiFi network of the modem router:
a. On your computer or WiFi device, find and select the WiFi network.
The WiFi network name (SSID) is on the product label.
b. Join the WiFi network and enter the WiFi password.
The password (network key) is on the product label.
Your computer or WiFi device connects to the modem router’s WiFi network.

Note If the computer is set to a static (fixed) IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static IP address in
the 192.168.0.2-192.168.0.254 range.

12. Launch a web browser.

The modem router checks the Internet connection.
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My

wiha

You are not yet connected to the Internet

Do you want NETGEAR Genie to help?
9 Yes
C No, I'want to caonfigure the Internet connection myselr.
O 1 have saved the router settings in a file and | want to restore the router to those settings.

If the NETGEAR genie automatic setup utility displays, skip to Step 14. If it does not display, do the
following:

a.
b.

In the address field of the web browser, enter www.routerlogin.net.
When prompted, enter admin for the user name and password for the password.

If the NETGEAR genie automatic setup utility displays, skip to Step 14. If the NETGEAR genie automatic
setup utility still does not display, see Step 13.

13. If the browser cannot display the web page, do the following:

a.

Make sure that the computer is connected to one of the four Ethernet LAN ports or over WiFi to
the modem router.

Make sure that the Power LED of the modem router is lit solid white.

Make sure that your browser does not cache the previous page by closing and reopening the
browser.

Clear the browser cache.

If the computer is set to a static (fixed) IP address (this setting is uncommon), either change the
computer to obtain an IP address automatically from the modem router through DHCP, or change
the IP address of the computer to a static IP address in the 192.168.0.2-192.168.0.254 range.

14. Click the Next button.
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17.
18.
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NETGEAR genie

You are not yet connected to the Internet

Select Country
Country USA
Select Internet Service Provider
Internet Senice Provider: ATAT v

Do you want NETGEAR Genie to help?
® Yes
Mo, | want to configure the Internet connection myself.

| have saved the router settings in a file and | want to restore the router to those settings

From the Country menu, select the country in which you use the modem router.

From the Internet Service Provider menu, select the Internet service provider (ISP) that you are
using.

If your ISP is not in the menu, select Other.

Select the Yes radio button.

Click the Next button.

e e
e e Internet onnect
cic L e e L nmicol

This process can take a minute or two; please wait

‘e
-~

LA

When the modem router is connected to the Internet, the Congratulations! window displays, and you
successfully completed the setup process. If the Congratulations! window does not display, other
windows might display and you might need to provide more information, in which case you must
continue with the next step. The windows that display depend on your type of ISP connection and
configuration.
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Congratulations!
You are successfully connected to the Internet

This router is preset with the following unique wireless network name (SSID) and network key {password)

2.4GHz Wireless Network Name (SSID): NETGEAR23

Wireless Network Key (Password) : jaggedtrumpet276
5GHz Wireless Network Name (SSID): NETGEAR23-5G

Wireless Network Key (Password) © jaggedtrumpet276

19. (Only if you are using a DSL connection and the following window displays) Specify a full scan to let
the Setup Wizard find the PVC protocol.

A window might display that asks you if you need the Setup Wizard to do a full scan to find the PVC
protocol. If this window does not display, continue with the next step.

Setup Wizard

Do you nead Setup Wizard to do full scan to find the PVC/ Prolocol?
®!Yas, (This will lake approximolely 1 1o 6 minules)
Mo. | want to configure the router myself

Do the following:

a. Select the Yes radio button.
b. Click the Next button.

The Setup Wizard performs a full scan, which might take up to six minutes.

Wizard is performing full scan of PVC

This takes approximately 1 to 6 minutes

e,
=

20. (Only if the following window displays) Specify how to manage problems with the detection of the
Internet connection.
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A window might display that states that a problem occurred while the wizard was detecting the Internet
connection. If this window does not display, continue with the next step.

Froblem Detecting the Internet Connection
Thig is mast likely due to one of the Tallowing reasons

1. The modem was not power cycled duning the cabling step
To sobee thiz problam, pewer cycle the modemn (turn it off and on). To power cycle a modem with battery backup, you might need to remeove
and reinsedt its battery. ARter the power cycle, wart 2 minutes for the modem to completely start up

2. The DEL/EIhemel cable is not fully insaned, or is inserted in the wrong place

To sobve this problem, make sure that the DELEthemet cable 1s securely plugged in to the broadband modem port and the router Intemet
paort

O | just power cycled the modem and waited for 2 minutes

) 1 corrected a problem with the DSL/Ethemet cable

e

) None of the above

Take one of the following actions:

» If you did not yet power cycle the modem, do so now:
a. Unplug your modem’s power, leaving the modem connected to the wall jack for your Internet
service.

If your modem includes a battery backup, remove the battery.

Wait 10 seconds.

If your modem includes a battery backup, reinsert the battery.

Plug in your modem’s power and turn on your modem.

Wait two minutes.

Select the | just power cycled the modem and waited for 2 minutes radio button.

Click the Next button.

» See if the DSL cable is not fully inserted or is inserted at the wrong place. If necessary, do the
following:

a. Fully insert the DSL cable in the correct port on the modem and in the gray DSL port on the
modem router.

b. Selectthe | corrected a problem with the DSL/Ethernet cable radio button.
c. Click the Next button.
» Ifyou do not need to power cycle the modem or the DSL cable is already fully inserted in the correct

ports, do the following:
a. Select the None of the above radio button.

b. Click the Next button.

SQ "0 ao0oT

21. (Only if the following window displays) Specify how to manage problems with the detection of the IP
address for the Internet connection.
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A window might display that states that a problem occurred while the wizard was detecting the Internet
connection IP address.

Problem Detecting the Internet Connection - IP Address

Did your Internet Service Provider (ISP) assign to you a fived (static) IP address? This is a very rare special
deployment

Select an option and click Next to proceed

Yas. My ISP assigned a fixed (static) IP address to me.
No, | did not get a fixed (static) IP address from my ISP

| don't know.

If your ISP assigned you a fixed (static) IP address, do the following:
a. Select the Yes radio button.
b. Click the Next button.

Enter the fixed IP settings assigned by your Internet Service Provider and click Next to procead.
My IP Address
Subnet Mask
Default Gateway
Preferred DNS Server

Alternate DNS Server

c. Enter the address information that your ISP gave you for your fixed IP address configuration.
d. Click the Next button.

If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a
fixed IP address, do the following:

a. Select either the No or the | don’t know radio button.
b. Click the Next button.
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Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label

Enter the MAC address here

(format AABBCCDDEEFF)

c. Enterthe MAC address of the computer or router with which you previously were able to connect
to the Internet. You might find the MAC address on the product label of your device. Enter the
MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

22. If the Congratulations! window still does not display and the modem router still does not connect to
the Internet, do the following:
a. Review all your settings and make sure that you selected the correct options and entered everything
correctly.

Run the Setup Wizard one more time.

Contact your ISP to verify that you are using the correct configuration information.

Read Troubleshoot the Internet Connection on page 299.

If problems persist, register your NETGEAR product and contact NETGEAR technical support.

® oo o

Set Up the Modem Router for Cable or Fiber Service

You can install your modem router for cable or fiber (Ethernet WAN) service or for DSL service. If you
use a cable or fiber modem, follow the procedure that is described in this section. If you use a DSL modem,
follow the procedure that is described in Cable the Modem Router for DSL Service and Access the Modem
Router on page 24.

The following figure shows the cabling of your modem router for cable or fiber service.
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Figure 7. Modem router cabling for cable or fiber service

To connect your modem router to a cable or fiber service:

1.

Unplug your cable or fiber modem’s power, leaving the modem connected to the wall jack for your
Internet service.

If your cable or fiber modem includes a battery backup, remove the battery.

Use an Ethernet cable to connect the cable or fiber modem to the red Internet port on the modem
router.

If your cable or fiber modem includes a battery backup, reinsert the battery.
Plug in and turn on your cable or fiber modem.
Connect the power adapter to the modem router and plug it into an electrical outlet.

Wait for the Power LED to light solid white, which takes about two minutes.

If the Power LED does not light, press the Power On/Off button.
Wait for the WiFi LED to light solid white.

If the WiFi LED does not light, press the WiFi On/Off button
Connect a computer to the modem router by one of the following methods:

Ethernet cable. Use an Ethernet cable to connect your computer to a yellow Ethernet LAN port
on the modem router.

The product package contains a yellow Ethernet cable.
Your computer connects to the modem router’'s LAN.

WiFi. Connect to the default WiFi network of the modem router:

a. On your computer or WiFi device, find and select the WiFi network.
The WiFi network name (SSID) is on the product label.

b. Join the WiFi network and enter the WiFi password.
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The password (network key) is on the product label.
Your computer or WiFi device connects to the modem router’s WiFi network.

Note If the computer is set to a static (fixed) IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static IP address in
the 192.168.0.2-192.168.0.254 range.

10. Launch a web browser.

The modem router checks the Internet connection.

Wi

You are not yet connected to the Internet

Do you want NETGEAR Genie to help?

®

vasg
V&S

O No, Iwant to configure the Internet connection myself.

O | have saved the router settings in a file and | want to restore the router to those settings.

If the NETGEAR genie automatic setup utility displays, skip to Step 12. If it does not display, do the
following:

a. Inthe address field of the web browser, enter www.routerlogin.net.
b. When prompted, enter admin for the user name and password for the password.

If the NETGEAR genie automatic setup utility displays, skip to Step 12. If the NETGEAR genie automatic
setup utility still does not display, see Step 11.

11. If the browser cannot display the web page, do the following:
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a. Make sure that the computer is connected to one of the four Ethernet LAN ports or over WiFi to
the modem router.

b.
Make sure that the Power LED of the modem router is lit solid white.

c. Make sure that your browser does not cache the previous page by closing and reopening the
browser.

d. Clear the browser cache.

e. Ifthe computer is set to a static (fixed) IP address (this setting is uncommon), either change the
computer to obtain an IP address automatically from the modem router through DHCP, or change
the IP address of the computer to a static IP address in the 192.168.0.2-192.168.0.254 range.

12. Click the Next button.

NETGEAR genie

You are not yet connected to the Internet

Select Country
Country USA
Select Internet Service Provider
Internet Sernice Provider. ATAT -

Do you want NETGEAR Genie to help?

9 Yes
Mo, | want to configure the Internet connection myself

| have saved the router settings in a file and | want to restore the router to those settings

13. From the Country menu, select the country in which you use the modem router.

14. From the Internet Service Provider menu, select the Internet service provider (ISP) that you are
using.
If your ISP is not in the menu, select Other.

15. Select the Yes radio button.

16. Click the Next button.
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Detecting the Internet Connection

This process can take a minute or two; please wait

i
-
-

"

When the modem router is connected to the Internet, the Congratulations! window displays, and you
successfully completed the setup process. If the Congratulations! window does not display, other
windows might display and you might need to provide more information, in which case you must

continue with the next step. The windows that display depend on your type of ISP connection and
configuration.

Congratulations!
You are successfully connected to the Interet

This router is preset with the following unique wireless network name (SSID) and network key (password)

2.4GHz Wireless Network Name (SSID): NETGEAR23
Wireless Network Key (Password) : jaggedtrumpet276
5GHz Wireless Network Name (SSID): NETGEAR23-5G
Wireless Network Key (Password) : jaggedtrumpet276

17. (Only if the following window displays) Specify how to manage problems with the detection of the
Internet connection.

The window that might display states that a problem occurred while the wizard was detecting the
Internet connection. If this window does not display, continue with the next step.
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Problem Detecting the Internet Connection
This is mast likely due to one of the fallowing reasons

1. The modem was not power cycled dunng the cabling step
To 2abee thiz problem, powar cycle the modem (tum it off and on). To power cycle a modem with battery backup, you might need to remive
and remnsert ks batter Y. After the power c'fcl?. wart 2 minutes for the modem to cnmplele?y start up

2. The DSL/Ethemel cable is not fully insered, or is inserted in the wrong place
To sokve this problem, make sure that the DELEthemnet cable 1s securely plugged i to the broadband modem port and the router Intemet

port

O 1 just power cycled the modem and waited for 2 minutes

O 1 corracted a problem with the DSUEIhemet cable

-

O Mone of the above

Take one of the following actions:

* If you did not yet power cycle the modem, do so now:
a. Unplug your modem’s power, leaving the modem connected to the wall jack for your Internet
service.

If your modem includes a battery backup, remove the battery.

Wait 10 seconds.

If your modem includes a battery backup, reinsert the battery.

Plug in your modem’s power and turn on your modem.

Wait two minutes.

Select the | just power cycled the modem and waited for 2 minutes radio button.

Click the Next button.

» See if the Ethernet cable is not fully inserted or is inserted at the wrong place. If necessary, do the
following:

a. Fully insert the Ethernet cable in the correct port on the modem and in the red Internet port on
the modem router.

b. Selectthe I corrected a problem with the DSL/Ethernet cable radio button.
c. Click the Next button.
« If you do not need to power cycle the modem or the Ethernet cable is already fully inserted in the

correct ports, do the following:
a. Select the None of the above radio button.

b. Click the Next button.

SQ "0 Qo0 o

18. (Only if the following window displays) Specify how to manage problems with the detection of the IP
address for the Internet connection.

The window that might display states that a problem occurred while the wizard was detecting the
Internet connection IP address.
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Problem Detecting the Internet Connection - IP Address

Did your Internet Service Provider (ISP) assign to you a fixed (static) IP address? This is a very rare special
deployment

Select an option and click Next to proceed.
Yas. My ISP assigned a fixed (static) IP address to me.
Mo, | did not get a fixed (static) IP address from my ISP

| don't know.

If your ISP assigned you a fixed (static) IP address, do the following:
a. Select the Yes radio button.

b. Click the Next button.

Enter the ficed IP settings assigned by your Internet Service Provider and click Next to proceed.
My IP Address
Subnet Mask
Default Gateway
Preferred DNS Server

Alernate DNS Server

c. Enter the address information that your ISP gave you for your fixed IP address configuration.
d. Click the Next button.

If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a
fixed IP address, do the following:
a. Select either the No or the | don’t know radio button.

b. Click the Next button.
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Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label

Enter the MAC address here

(format AABBCCDDEEFF)

c. Enterthe MAC address of the computer or router with which you previously were able to connect
to the Internet.
You might find the MAC address on the product label of your device. Enter the MAC address
in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

19. If the Congratulations! window still does not display and the modem router still does not connect to
the Internet, do the following:
a. Review all your settings and make sure that you selected the correct options and entered everything
correctly.

Run the Setup Wizard one more time.

Contact your ISP to verify that you are using the correct configuration information.

Read Troubleshoot the Internet Connection on page 299.

If problems persist, register your NETGEAR product and contact NETGEAR technical support.

® Qo0 T

Log In to the Modem Router After Setup to View or Change
Settings

After you set up the modem router for DSL, cable, or fiber service, you can view or change the settings
for the modem router by accessing NETGEAR genie.

To log in to the modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

The nature of the login window that opens depends on your Internet browser.
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e A username and password are being requested by http://www.routerlogin.net. The site says:
: "NETGEAR D7000"
User Name: T
Paszword:  ssssssss
[ ok ][ cencer |

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.

* ® ”
N ETGEAR genle Firmware Version
D7000 V1.0.0.5_1.0.1
[ sasic |[ABVANGED -
Home >
Internet > .l% ﬂ
Wireless : f«-‘\." Q@ - - -
Attached Devices » < =
Internet Wireless Attached Devices
Parental Controls »
| Name (S5ID): NETGEARAT Z
ReadySHARE ; STATUS: GOOD | e c3a J Number of devices: 1 |
Guest Network > 1
i — ’
Ty i)
|HI
Parental Controls ReadySHARE Guest Network
STATUS: NOT ENABLED | STATUS: No USB drive Status: NOT ENABLED

HELP & SUPPORT 0documentation | Online Support | Router FAQ | GPL SEARCH HELP BB feo

The BASIC Home page displays a dashboard that lets you see the status of your Internet connection
and network at a glance. You can click any of the sections of the dashboard to view more detailed
information. The left column displays the menus, and at the top is an ADVANCED tab that you can
use to access more menus and pages.

Change the Language

By default, the language is set as Auto. You can change the language.
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To change the language:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.

In the upper right corner, select a language from the menu.
When prompted, click the OK button to confirm this change.

The page refreshes with the language that you selected.

Change the admin Password

NETGEAR recommends that you change the default password that you use to log in to the modem router
to a more secure password. This is the password that you use to log in to the modem router with the user
name admin.

The ideal password contains no dictionary words from any language and contains uppercase and lowercase
letters, numbers, and symbols. It can be up to 30 characters.

Note This admin password is not the password that you use for WiFi access. The label
on your modem router shows your unique WiFi network name (SSID) and password
for WiFi access.

To change the password for the user name admin:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

Install and Access the Modem Router and Its Network
41



~

Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

The BASIC Home page displays.
Select ADVANCED > Administration > Set Password.

Old Password ssssssse

SetPassword
Repeat Mew Password

[Z] Enable Password Recovery

Enter the old password.
Enter the new password twice.
Click the Apply button.

Your settings are saved.

Set Up Password Recovery

NETGEAR recommends that you enable password recovery if you change the password for the modem
router user name admin. Then you can recover the password if it is forgotten. This recovery process is
supported in Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.

To set up password recovery:

1.
2.

N

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Set Password.
The Set Password page displays.

Select the Enable Password Recovery check box.
Select two security questions and provide answers to them.
Click the Apply button.
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Your settings are saved.

Let the Modem Router Automatically Update Its Firmware

When you set up your modem router and are connected to the Internet, the modem router automatically
checks for you to see if newer firmware is available. If it is, a message is displayed at the top of the page.
For information about manually upgrading firmware, see Update the Firmware of the Modem Router on
page 233.

To automatically update the firmware:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login pop-up window displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Wait for the modem router to determine if newer firmware is available.

This process might take a few minutes. If the modem router detects new firmware, the modem router
displays a message at the top of the page.

Click the message.
To upgrade the modem router with the latest firmware, click the Yes button.

After the upgrade, the modem router restarts.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the upload. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting
and the Power LED turns solid white.

Access the Modem Router with the NETGEAR genie App

The genie app * is the easy dashboard for managing, monitoring, and repairing your home network from
a smartphone, tablet, or computer. The genie app can help you with the following:
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* Automatically repair common WiFi network problems.

» Easily manage modem router features such as Live Parental Controls, guest access, Internet traffic
meter, speed test, and more.

» Share and stream music or videos.

To use the genie app to access the modem router:

1. Visit the NETGEAR genie web page at www.netgear.com/genie.
2. Follow the onscreen instructions to install the app on your smartphone, tablet, or computer.
3. Launch the genie app.

The genie app dashboard displays.

The following figure shows the genie app dashboard for a Windows computer.

About _ X
ETGEAR genie’
g Select Language
Wireless Network: bt
Internet i
WiFi Connection ' l I II
Router Settings
Network Map Internet WiFi Connection Router Settings
Parental Controls | STATUS GOOD STATUS Connected Click here
i
ReadySHARE %
— ! . .
Network Support l .
- lkl p—
Network Map Parental Controls ReadySHARE
Number of devices: 7 Click here Click here
A al
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Manage the Internet Settings Manually 3

This chapter describes how you can manage the Internet settings of the modem router manually.

Usually, the quickest way to set up the modem router is to allow the NETGEAR genie automatic setup utility
to detect the Internet connection when you first access the modem router with an Internet browser. These
options are described in Install and Access the Modem Router and Its Network on page 19. You can also
customize or specify your Internet settings manually.

The chapter contains the following sections:

* Use the Internet Setup Wizard After Initial Setup on page 46

* Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63

* Manually Set Up a Cable or Fiber Internet Connection on page 73
* Specify an IPv6 Internet Connection on page 84

* Manage the MTU Size on page 98
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Use the Internet Setup Wizard After Initial Setup

Whether you use DSL service or cable or fiber service, you can use the Setup Wizard to detect your
Internet settings and automatically set up your modem router.

Note The Setup Wizard is the same as the NETGEAR genie automatic setup utility that
launches the first time you connect to your modem router.

To use the Setup Wizard:
1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Setup Wizard.

Setup Wizard | |

Select Country
Country. USA

Select Internet Service Provider
Internet Senvice Provider: AT&T -

Auto-Detect Connection Type
The Smart Setup Wizard can detect the type of Internet connection that you have,
Do you want the Smart Setup Wizard to try and detect the connection type now?

2 Yes.
Ho. | want to configure the router myself.
| have saved the router settings in a file and | want to restore the router to those settings.

6. From the Country menu, select the country in which you use the modem router.
7. From the Internet Service Provider menu, select the Internet service provider (ISP) that you are
using.

If your ISP is not in the menu, select Other.

8. Select the Yes radio button.
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If you select the No radio button, you are taken to the Internet Setup page after you click the Next
button. For more information, see one of the following sections:
* Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73

9. Click the Next button.

The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP
configuration.

Detecting the Internet

Lonnecton

This process can take a minute or two; please wait...

Sy

™

When the modem router is connected to the Internet, the Congratulations! window displays, and you
successfully completed the setup process.

If the Congratulations! window does not display, other windows might display and you might need to
provide more information, in which case you must continue with the next step. The windows that
display depend on your type of ISP connection and configuration.

You are successfully connected to the Internet

This router is preset with the following unique wireless network name (SSID) and network key (password)

2.4GHz Wireless Network Name (SSID): NETGEAR23
Wireless Network Key (Password) : jaggedtrumpet276

5GHz Wireless Network Mame (SSID): NETGEAR23-5G

Wireless Network Key (Password) © jaggedtrumpet276

10. (Only if you are using a DSL connection and the following window displays) Specify a full scan to let
the Setup Wizard find the PVC protocol.
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A window might display that asks you if you need the Setup Wizard to do a full scan to find the PVC
protocol. If this window does not display, continue with the next step.

Do you nead Setup Wizard to do full scan to find the PVC/Prolocol?
® Yas, (This will take approximolely 1 to 6 minutes)
Mo | want to configure the router mysetf

Do the following:

a. Select the Yes radio button.
b. Click the Next button.

The Setup Wizard performs a full scan, which might take up to six minutes.

This takes approximately 1 to 6 minutes
vig,
-
-

11. (Only if the following window displays) Specify how to manage problems with the detection of the
Internet connection.

A window might display that states that a problem occurred while the wizard was detecting the Internet
connection. If this window does not display, continue with the next step.

Problem Detecting the Internet Connection
This is most likely due to one of the fallowing reasons

1. The modem was not power cycled during the cabling step

To sabe thiz problem, pewar cycle the modem (tum it off and on). To power cycle a modem with battery backup, you might need to remeve
and reingert its battery. Afler the power cycle, wait 2 minutes for the modem o completely start up

2. The DEL/Ethemel cable is not fully insered, or is inserted in the wrong place

To sobve this problem, make sure that the DSL/Ethemet cable is securely plugged in to the broadband modem port and the router Intemet
port.
O 1 just power cycled the modem and waited for 2 minutes

O 1 corrected a problem with the DSUEhemet cable.

O none of the above
Take one of the following actions:
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* If you did not yet power cycle the modem, do so now:
a. Unplug your modem’s power, leaving the modem connected to the wall jack for your Internet
service.
If your modem includes a battery backup, remove the battery.
Wait 10 seconds.
If your modem includes a battery backup, reinsert the battery.
Plug in your modem’s power and turn on your modem.
Wait two minutes.
Select the | just power cycled the modem and waited for 2 minutes radio button.
Click the Next button.
» Seeifthe DSL or Ethernet cable is not fully inserted or is inserted at the wrong place. If necessary,
do the following:
a. Fully insert the DSL or Ethernet cable in the correct port on the modem and in the correct port
on the modem router.
If you use a DSL cable, it must be connected to the gray DSL port. If you us an Ethernet cable,
it must be connected to the red Internet port.

SQ 0o ao0oT

b. Selectthe | corrected a problem with the DSL/Ethernet cable radio button.
c. Click the Next button.

» If you do not need to power cycle the modem or the DSL or Ethernet cable is already fully inserted
in the correct ports, do the following:
a. Select the None of the above radio button.

b. Click the Next button.

12. (Only if the following window displays) Specify how to manage problems with the detection of the IP
address for the Internet connection.

A window might display that states that a problem occurred while the wizard was detecting the Internet
connection IP address.

Problem Detecting the Internet Connection - IP Address

Did your Internet Service Provider (ISP) assign to you a fixed (static) IP address? This is a very rare special
deploymant

Select an option and click Next to proceed
Yes. My ISP assigned a fixed (static) IP address to me
No, | did not get a fixed (static) IP address from my ISP

| don't know

Take one of the following actions:
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If your ISP assigned you a fixed (static) IP address, do the following:
a. Select the Yes radio button.
b. Click the Next button.

Enter the fixed IP settings assigned by your Internet Service Provider and click Next to procead.
My IP Address
Subnet Mask
Default Gateway
Preferred DNS Server

Alternate DNS Server

c. Enter the address information that your ISP gave you for your fixed IP address configuration.
d. Click the Next button.

If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a
fixed IP address, do the following:

a. Select either the No or the | don’t know radio button.
b. Click the Next button.

Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label

Enter the MAC address here

{format AABECCDDEEFF)

c. Enterthe MAC address of the computer or router with which you previously were able to connect
to the Internet.
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You might find the MAC address on the product label of your device. Enter the MAC address
in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

13. If the Congratulations! window still does not display and the modem router still does not connect to
the Internet, do the following:
a. Review all your settings and make sure that you selected the correct options and entered everything
correctly.

Run the Setup Wizard one more time.

Contact your ISP to verify that you are using the correct configuration information.

Read Troubleshoot the Internet Connection on page 299.

If problems persist, register your NETGEAR product and contact NETGEAR technical support.

® oo o

Manually Set Up an ADSL Internet Connection

You can view or change the modem router's ADSL Internet connection settings manually. The following
sections describe the options that are available to you to manually set up the ADSL Internet connection:

» Specify an ADSL Connection Without a Login Requirement on page 51
» Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service on page 57

Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.

Specify an ADSL Connection Without a Login Requirement

If you want to manually configure the ADSL connection settings, use the information that your ISP gave
you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering
incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for an ADSL Internet connection that does not require a login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.
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A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select Internet.

The Internet Setup page displays.
From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

Select the virtual interface:

Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.

From the Transfer Mode menu, select ADSL(ATM).

10. From the DSL Mode menu, select the ADSL mode that your ISP provided you:

Auto. The modem router detects the DSL mode automatically. (This is the default setting.)
ADSL. Legacy version of ADSL.
ADSL2. Legacy version of ADSL2.

ADSL2+. ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and
ADSL.

11. Specify that your ISP does not require you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the No radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the No radio button.

12. Make sure that the Enable This Interface check box is selected.
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As an example, the following figure shows the settings that display when you configure an ADSL
connection for the Internet interface.

nternet Setup
I cdnce—]
Select Country USA
Select Intemnet Service Provider ATET -
Transfer Mode ADSLATM) -
DSL Mode Auto -
Internet ~

| Enable This Interface

Multiplexing Method LLC-BASED ~
Vel s |z
VCl 35
|Use VLANID 10
Priority (0~ 7) 0

Does your Internet connection require a login?
Yes
@ No

Account Name D7000

Domain Name

Internet IP Address

@ Get Dynamically from ISP
Use Static IP Address
Use Static IP Address

IP Subnet Mask
Gateway IP Address

Use IP Over ATH (IPoA)
IP Address

IP Subnet Mask

Gateway IP Address

Domain Hame Server (ONS) Address
9 Get Automatically from ISP
Use These DNS Servers
Primary DNS
Secondary DNS

NAT (Network Address Translation)
9 Enable

Disable

Router MAC Address
9 Use Default Address
Use Computer MAC Address
Use This MAC Address A4:2B:8C:F8:CE:47

DHCP Options
Viendor Class |dentifier String (Option 60)

Vendor Identifier String (Option 61)

13. Enter the ADSL settings as described in the following table.

Field Description

Multiplexing Method Select LLC-BASED or VC-BASED, as indicated by your ISP.

The multiplexing method can either be virtual circuit (VC) based or
logical link control (LLC) based.
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Field

Description

Note This setting does not apply to the IPTV interface.

VPI

Enter a number between 0 and 255 for the virtual circuit number for
the virtual path identifier (VPI), as indicated by your ISP.

If your ISP did not provide you with a VPI setting, leave the default
setting (8). The VPI might be required not only for a VC-based
connection but also for an LLC-based connection.

Note This setting does not apply to the IPTV interface.

VCI

Enter a number between 32 and 65535 for the virtual circuit number
for the virtual channel identifier (VCI), as indicated by your ISP.

If your ISP did not provide you with a VCI setting, leave the default
setting (35). The VCI might be required not only for a VC-based
connection but also for an LLC-based connection.

Note This setting does not apply to the IPTV interface.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as
indicated by your ISP.

AVLAN ID might be required if you subscribe to both Internet service
and IPTV service. If your ISP did not provide you with a VLAN ID,
leave the Use VLANID check box cleared, which is the default
setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter
the priority value, which is a number from 0 to 7.

You can enter a priority value only in combination with a VLAN ID.
If your ISP did not provide you with a priority value, leave the default
setting (0).

Bridge Mode

This setting is an option that applies to the IPTV interface only.
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Field

Description

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Account Name

Enter the account name, as indicated by your ISP. This name might
also be called the host name.

If your ISP did not provide you with an account name or host name,
leave the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.

If your ISP did not provide you with a domain name, leave this field
blank.

Internet IP Address or IPTV IP Address (depending on your selection in Step 8)

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that
your ISP assigned you for static IP address service. The gateway is
the ISP router to which your modem router connects.

Use IP over ATM (IPoA)

Enter the IP address, IP subnet mask, and gateway IP address that
your ISP assigned you for IPoA service. The gateway is the ISP
router to which your modem router connects.

Domain Name Server (DNS) Address

The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option and
enter the IP address of your ISP primary DNS server. If a secondary
DNS server address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT
is enabled by default because it is required in most situations. Select the NAT setting:
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Field

Description

exists.
* Disable. NAT is disabled.

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer.

This feature allows your modem router to use your computer's MAC address (also called cloning).

Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the
computer that you are now using. You must use the one computer
that is registered by the ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

DHCP Options

Vendor Class ldentifier String
(option 60)

Enter the vendor class identifier (VCI) string, as indicated by your
ISP.

If your ISP did not provide you with a VCI string, leave this field blank.

Client Identifier String (option
61)

Enter the client identifier (client ID) string, as indicated by your ISP.

If your ISP did not provide you with a client ID string, leave this field
blank.

14. Click the Apply button.

Your settings are saved.

15. Click the Test button to test your Internet connection.
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If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Specify an ADSL Connection with a Login Requirement and
PPPoA or PPPoE Service

If you want to manually configure the ADSL connection settings, use the information that your ISP gave
you to log in and connect to your Internet service. If you cannot find this information, contact your ISP.
Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for an ADSL Internet connection that requires a login and uses a
PPPOE or PPPOA service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select Internet.
The Internet Setup page displays.
6. From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

7. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

8. Select the virtual interface:
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Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.

9. From the Transfer Mode menu, select ADSL(ATM).
10. From the DSL Mode menu, select the ADSL mode that your ISP provided you:

Auto. The modem router detects the DSL mode automatically. (This is the default setting.)
ADSL. Legacy version of ADSL.
ADSL2. Legacy version of ADSL2.

ADSL2+. ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and
ADSL.

11. Specify that your ISP requires you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the Yes radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the Yes radio button.

12. Make sure that the Enable This Interface check box is selected.

As an example, the following figure shows the settings that display when you configure an ADSL
connection for the Internet interface.
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nternet Setup
Select Country USA >
Select internet Service Provider AT&T A

Transfer Mode ADSLATM) ~
DSL Mode Auto >
Internet ~
[Y] Enable This Interface
Multiplexing Method LLC-BASED ~
VPl 8
VCl 35 =
luse vLANID 10
Priofity (0~ 7) 0

Does your Internet connection reguire a login?
O Yes
) Mo

Encapsulation

PPPoE (PPP over Ethemet) ~

Login
Password
Service Name
Connection Mode

Idie Timeout (minutes)

Internet IP Address
9 Get Dynamically from ISP
Use Static IP Address

Domain Name Server (DNS) Address
@ Get Automnatically from ISP
Use These DNS Servers
Primary DNS
Secondary DNS

NAT (Network Address Translation)
9@ Enable

Disable

Router MAC Address
© Use Default Address
' Use Computer MAC Address
- Use This MAC Address
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13. Enter the ADSL settings as described in the following table.

Field

Description

Multiplexing Method

Select LLC-BASED or VC-BASED, as indicated by your ISP.

The multiplexing method can either be virtual circuit (VC) based or
logical link control (LLC) based.

Note This setting does not apply to the IPTV interface.
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Field Description

VPI Enter a number between 0 and 255 for the virtual circuit number for
the virtual path identifier (VPI), as indicated by your ISP.

If your ISP did not provide you with a VPI setting, leave the default
setting (8). The VPI might be required not only for a VC-based
connection but also for an LLC-based connection.

Note This setting does not apply to the IPTV interface.

VCI Enter a number between 32 and 65535 for the virtual circuit number
for the virtual channel identifier (VCI), as indicated by your ISP.

If your ISP did not provide you with a VCI setting, leave the default
setting (35). The VCI might be required not only for a VC-based
connection but also for an LLC-based connection.

Note This setting does not apply to the IPTV interface.

Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated
by your ISP.

A VLAN ID might be required if you subscribe to both Internet service
and IPTV service. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7) If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from O to 7.

You can enter a priority value only in combination with a VLAN ID. If
your ISP did not provide you with a priority value, leave the default
setting (0).

Bridge Mode This setting is an option that applies to the IPTV interface only.

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Encapsulation Select the encapsulation, as indicated by your ISP:
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Field Description

*  PPPoE (PPP over Ethernet). Your Internet connection uses PPP
over Ethernet.

*  PPPoA (PPP over ATM). Your Internet connection uses PPP over
ATM.

Login Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.

This login name is often an email address.

Password Enter the password that you use to log in to your Internet service, as
indicated by your ISP.

Service Name Enter the service name that you use to log in to your Internet service,
as indicated by your ISP.

Often, a service name is not required.

Note This field does not display if your selection from the En-
capsulation menu is PPPoA (PPP over ATM).

Connection Mode Select how the Internet connection functions:

¢ Always On. Once the Internet connection is established, it remains
active. This is the default setting.

* Dial on Demand. When someone attempts to connect to the
Internet, the Internet connection is established. When the idle
time-out period expires, the Internet connection is terminated.

* Manually Connect. You must connect to the Internet manually
(see View or Change a TCP/IP Internet Connection on page 249 or
View or Change a PPPoE or PPPoA Internet Connection on page
250).

Idle Timeout (minutes) If you select Dial on Demand from the Connection Mode menu, enter
the idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the
Internet connection active when no one on the network is using the
Internet connection. The default is 5 minutes. To disable the idle
time-out, enter 0. (When you disable the idle time-out, the connection
is not terminated automatically).
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Field Description

Internet IP Address or IPTV IP Address (depending on your selection in Step 8)

Get Dynamically from ISP | Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address Enter the IP address, IP subnet mask, and gateway IP address that
your ISP assigned you for static IP address service. The gateway is
the ISP router to which your modem router connects.

Domain Name Server (DNS) Address

The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP | Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option and
enter the IP address of your ISP primary DNS server. If a secondary
DNS server address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT
is enabled by default because it is required in most situations. Select the NAT setting:

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer.

This feature allows your modem router to use your computer's MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address|The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is
registered by the ISP.
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Field Description

Use This MAC Address Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

14. Click the Apply button.
Your settings are saved.
15. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Manually Set Up aVDSL Internet Connection

You can view or change the modem router’s VDSL Internet connection settings manually. The following
sections describe the options that are available to you to manually set up the VDSL Internet connection:

e Specify a VDSL Connection Without a Login Requirement on page 63
» Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 68

Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.

Specify a VDSL Connection Without a Login Requirement

If you want to manually configure the VDSL connection settings, use the information that your ISP gave
you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering
incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for a VDSL Internet connection that does not require a login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
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A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select Internet.

The Internet Setup page displays.
From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

Select the virtual interface:

Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.
From the Transfer Mode menu, select VDSL(PTM).

When you select VDSL(PTM) from the Transfer Mode menu, the only option in the DSL Mode menu
is VDSL2.

Specify that your ISP does not require you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the No radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the No radio button.

Make sure that the Enable This Interface check box is selected.

As an example, the following figure shows the settings that display when you configure a VDSL
connection for the Internet interface.
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Select Country USA -
Select Internet Service Provider ATET -
Transfer Mode VDSLPTM) -
DSL Mode VDSLZ -

Internet ~

] Enable This Interface

Tluse VLANID 10

Priority (0 ~ 7) 0

Does your Internet connection require a login?

Yes
@ No

1

Account Name

Domain Name

D7000

Internet IP Address
9 Get Dynamically from ISP
7 Use Static IP Address
Use Stalic IP Address

IP Subnet Mask

Gateway IP Address

Domain Name Server (ONS) Address
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Primary DNS
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Router MAC Address
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DHCP Options
Vendor Class |dentifier String (Option 60)

Vendor Identifier String (Option 61)

12. Enter the VDSL settings as described in the following table.

Field

Description

Multiplexing Method

These settings are disabled because they do not apply to a VDSL
connection.

VPI

VCI
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Field

Description

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as
indicated by your ISP.

A VLAN ID might be required if you subscribe to both Internet
service and IPTV service. In some unusual situations, a VLAN
ID is required for VDSL Internet service. If your ISP did not provide
you with a VLAN ID, leave the Use VLANID check box cleared,
which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value,
enter the priority value, which is a number from 0 to 7.

You can enter a priority value only in combination with a VLAN
ID. If your ISP did not provide you with a priority value, leave the
default setting (0).

Bridge Mode

This setting is an option that applies to the IPTV interface only.

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Account Name

Enter the account name, as indicated by your ISP. This name
might also be called the host name.

If your ISP did not provide you with an account name or host
name, leave the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.

If your ISP did not provide you with a domain name, leave this
field blank.

Internet IP Address or IPTV IP Ad

dress (depending on your selection in Step 8)

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address
that your ISP assigned you for static IP address service. The
gateway is the ISP router to which your modem router connects.

Domain Name Server (DNS) Address

The DNS server is used to look up

site addresses based on their domain names.
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Field Description

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option
and enter the IP address of your ISP primary DNS server. If a
secondary DNS server address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT
is enabled by default because it is required in most situations. Select the NAT setting:

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer.

This feature allows your modem router to use your computer's MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address The modem router captures and uses the MAC address of the
computer that you are now using. You must use the one computer
that is registered by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

DHCP Options

Vendor Class ldentifier String Enter the vendor class identifier (VCI) string, as indicated by your
(option 60) ISP.

If your ISP did not provide you with a VCI string, leave this field
blank.
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Field Description

Client Identifier String (option 61) |Enter the client identifier (client ID) string, as indicated by your
ISP.

If your ISP did not provide you with a client ID string, leave this
field blank.

13. Click the Apply button.
Your settings are saved.
14. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Specify aVDSL Connection with a Login Requirement and
PPPoE Service

If you want to manually configure the VDSL connection settings, use the information that your ISP gave
you to log in and connect to your Internet service. If you cannot find this information, contact your ISP.
Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for aVDSL Internet connection that requires alogin and uses a PPPoE
service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
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The BASIC Home page displays.

Select Internet.

The Internet Setup page displays.

From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

Select the virtual interface:

Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.
From the Transfer Mode menu, select VDSL(PTM).

When you select VDSL(PTM) from the Transfer Mode menu, the only option in the DSL Mode menu
is VDSL2.

Specify that your ISP requires you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the Yes radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the Yes radio button.

Make sure that the Enable This Interface check box is selected.

As an example, the following figure shows the settings that display when you configure a VDSL
connection for the Internet interface.
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12. Enter the VDSL settings as described in the following table.

Field

Description

Multiplexing Method

VPI

VCI

These settings are disabled because they do not apply to a VDSL
connection.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as
indicated by your ISP.
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Field

Description

AVLAN ID might be required if you subscribe to both Internet service
and IPTV service. In some unusual situations, a VLAN ID is required
for VDSL Internet service. If your ISP did not provide you with a
VLAN ID, leave the Use VLANID check box cleared, which is the
default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter
the priority value, which is a number from 0 to 7.

You can enter a priority value only in combination with a VLAN ID.
If your ISP did not provide you with a priority value, leave the default
setting (0).

Bridge Mode

This setting is an option that applies to the IPTV interface only.

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Encapsulation

For a PPP over Ethernet (PPPoE) connection, select PPPoE (PPP
over Ethernet) from the menu.

Note PPP over ATM (PPPoA) is not supported for a VDSL
connection.

Login Enter the login name that you use to log in to your Internet service,
as indicated by your ISP.
This login name is often an email address.

Password Enter the password that you use to log in to your Internet service,

as indicated by your ISP.

Service Name

Enter the service name that you use to log in to your Internet service,
as indicated by your ISP.

Often, a service name is not required.

Connection Mode

Select how the Internet connection functions:
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Field

Description

* Always On. Once the Internet connection is established, it
remains active. This is the default setting.

* Dial on Demand. When someone attempts to connect to the
Internet, the Internet connection is established. When the idle
time-out period expires, the Internet connection is terminated.

* Manually Connect. You must connect to the Internet manually
(see View or Change a TCP/IP Internet Connection on page 249
or View or Change a PPPoE or PPPoA Internet Connection on
page 250).

Idle Timeout (minutes)

If you select Dial on Demand from the Connection Mode menu,
enter the idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the
Internet connection active when no one on the network is using the
Internet connection. The default is 5 minutes. To disable the idle
time-out, enter 0. (When you disable the idle time-out, the connection
is not terminated automatically).

Internet IP Address or IPTV IP Address (depending on your selection in Step 8)

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that
your ISP assigned you for static IP address service. The gateway is
the ISP router to which your modem router connects.

Domain Name Server (DNS) Address

The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option and
enter the IP address of your ISP primary DNS server. If a secondary
DNS server address is available, enter it also.

NAT (Network Address Translation)
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Field Description

NAT allows computers on your home network to share the modem router Internet connection. NAT
is enabled by default because it is required in most situations. Select the NAT setting:

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer.

This feature allows your modem router to use your computer's MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address |The modem router captures and uses the MAC address of the
computer that you are now using. You must use the one computer
that is registered by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

13. Click the Apply button.
Your settings are saved.

14. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Manually Set Up a Cable or Fiber Internet Connection

You can view or change the modem router’s cable or fiber Internet connection settings manually. The
following sections describe the options that are available to you to manually set up the cable or fiber
Internet connection:
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» Specify a Cable or Fiber Connection Without a Login Requirement on page 74
» Specify a Cable or Fiber Connection with a Login Requirement and PPPoE Service on page 79

Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.

Note If you connect both a DSL modem and a cable or fiber modem to the modem router and
you want to manually specify the settings for a cable or fiber Internet connection, you
must first set the WAN connection preference manually to the Ethernet WAN port (see
Change the Physical WAN Connection Preference on page 210). If you do not, the DSL
settings take precedence over the cable or fiber settings. However, NETGEAR
recommends that you connect only the modem that you intend to use for your Internet
connection: a DSL modem, cable modem, or fiber modem.

Specify a Cable or Fiber Connection Without a Login
Requirement

If you want to manually configure the cable or fiber connection settings, use the information that your ISP
gave you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering
incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for a cable or fiber Internet connection that does not require a login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
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The BASIC Home page displays.

Select Internet.

The Internet Setup page displays.

From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

Select the virtual interface:

Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.

Specify that your ISP does not require you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the No radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the No radio button.

Make sure that the Enable This Interface check box is selected.

As an example, the following figure shows the settings that display when you configure a cable or
fiber connection for the Internet interface.
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Internet IP Address
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Use Slatic IP Address
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IP Subnet Mask
Gateway IP Address

Use IP Over ATH (IPoA)
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Domain Name Server (DNS) Address
9 Get Automatically from ISP
Use These DNS Servers
Primary DNS

Secondary DNS

HAT (Network Address Translation)
9 Enable

Disable

Router MAC Address
9 Use Default Address
Use Compuler MAC Address
Use This MAC Address A4:2B:8C:FE:CE:47

DHCP Options
Vendor Class Identifier String (Optien 60)
Vendor Identifier String (Option 61)

11. Enter the cable or fiber settings as described in the following table.

Field Description

Transfer Mode These settings are not disabled but do not apply to a cable or
fiber connection. You can ignore these settings.

DSL Mode

Multiplexing Method Unless you changed the physical WAN interface settings so that
the modem router must use the Ethernet WAN interface (see
VPI Change the Physical WAN Connection Preference on page 210),
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Field Description

VCI these settings are not disabled. However, these settings do not
apply to a cable or fiber connection and you can ignore them.

Use VLANID Select the Use VLANID check box and enter the VLAN ID, as

indicated by your ISP.

A VLAN ID might be required if you subscribe to both Internet
service and IPTV service. If your ISP did not provide you with a
VLAN ID, leave the Use VLANID check box cleared, which is the
default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value,
enter the priority value, which is a number from 0 to 7.

You can enter a priority value only in combination with a VLAN
ID. If your ISP did not provide you with a priority value, leave the
default setting (0).

Bridge Mode

This setting is an option that applies to the IPTV interface only.

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Account Name

Enter the account name, as indicated by your ISP. This name
might also be called the host name.

If your ISP did not provide you with an account name or host
name, leave the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.

If your ISP did not provide you with a domain name, leave this
field blank.

Internet IP Address or IPTV IP Address (depending on your selection in Step 8)

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address
that your ISP assigned you for static IP address service. The
gateway is the ISP router to which your modem router connects.
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Field Description

Use IP over ATM (IPoA) These settings are not disabled but do not apply to a cable or
fiber connection. You can ignore these settings.

Domain Name Server (DNS) Address

The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option
and enter the IP address of your ISP primary DNS server. If a
secondary DNS server address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT
is enabled by default because it is required in most situations. Select the NAT setting:

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer. This feature allows your modem router
to use your computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address The modem router captures and uses the MAC address of the
computer that you are now using. You must use the one computer
that is registered by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

DHCP Options
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Field Description
Vendor Class ldentifier String Enter the vendor class identifier (VCI) string, as indicated by your
(option 60) ISP.

If your ISP did not provide you with a VCI string, leave this field
blank.

Client Identifier String (option 61) [Enter the client identifier (client ID) string, as indicated by your
ISP.

If your ISP did not provide you with a client ID string, leave this
field blank.

12. Click the Apply button.
Your settings are saved.

13. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Specify a Cable or Fiber Connection with a Login
Requirement and PPPoE Service

If you want to manually configure the cable or fiber connection settings, use the information that your ISP
gave you to log in and connect to your Internet service. If you cannot find this information, contact your
ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations,
you only need to configure the Internet interface. If you use one or more IPTV devices, you might also
need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note If you must configure the IPTV interface, first use the following procedure to configure
the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for a cable or fiber Internet connection that requires alogin and uses
a PPPoOE service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select Internet.

The Internet Setup page displays.
From the Select Country menu, select the country in which you use the modem router.

The Select Country menu is not available in all countries and might be masked out.

From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.

If your ISP is not in the menu, select Other.

Select the virtual interface:

Internet interface. From the menu above the Enable This Interface check box, leave the default
menu selection at Internet.

 |PTV interface. From the menu above the Enable This Interface check box, select IPTV.

Specify that your ISP requires you to log in:

If you are configuring the Internet interface, scroll down to the Does your Internet connection require
a login? section and select the Yes radio button.

If you are configuring the IPTV interface, scroll down to the Does your IPTV connection require a
login? section and select the Yes radio button.

Make sure that the Enable This Interface check box is selected.

As an example, the following figure shows the settings that display when you configure a cable or
fiber connection for the Internet interface.
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o

Select Country USA >
Select internet Service Provider AT&T A

Transfer Mode ADSLATM) ~

DSL Mode Auto >
Internet ~

[Y] Enable This Interface

Multiplexing Method LLC-BASED ~
VPl 8
VCl 35 =
luse vLANID 10
Priority (0~ 7) 0

Does your Internet connection require a login?

@ Yes
' No

Encapsulation PPPoE (PPP over Ethemet) ~

Login
Password

Service Name

Connection Mode Always On -
Idle Timeout (minutes) g

Internet IP Address
9 Get Dynamically from ISP
Use Static IP Address o -|0 -|0 -0

Domain Hame Server (DNS) Address
9 Get Automatically from ISP
Use These DNS Servers
Primary DNS
Secondary DNS

NAT (Network Address Translation)
9@ Enable

Disable

Router MAC Address
© Use Default Address
Use Computer MAC Address
Use This MAC Address (B 2R : B0 FR - CREAT

11. Enter the cable or fiber settings as described in the following table.

Field Description

Transfer Mode These settings are not disabled but do not apply to a cable or fiber
connection. You can ignore these settings.

DSL Mode

Unless you changed the physical WAN interface settings so that the modem
router must use the Ethernet WAN interface (see Change the Physical WAN
Connection Preference on page 210), these settings are not disabled.
VPI However, these settings do not apply to a cable or fiber connection and you
can ignore them.

Multiplexing Method

VClI
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Field

Description

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as
indicated by your ISP.

AVLAN ID might be required if you subscribe to both Internet service
and IPTV service. If your ISP did not provide you with a VLAN ID,
leave the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter
the priority value, which is a number from 0 to 7.

You can enter a priority value only in combination with a VLAN ID.
If your ISP did not provide you with a priority value, leave the default
setting (0).

Bridge Mode

This setting is an option that applies to the IPTV interface only.

For information about configuring bridge mode, see Enable Bridge
Mode for IPTV Devices on page 215.

Encapsulation

For a PPP over Ethernet (PPPoE) connection, select PPPoE (PPP
over Ethernet) from the menu.

Note PPP over ATM (PPPoA) is not supported for a cable
or fiber connection.

Login Enter the login name that you use to log in to your Internet service,
as indicated by your ISP.
This login name is often an email address.

Password Enter the password that you use to log in to your Internet service,

as indicated by your ISP.

Service Name

Enter the service name that you use to log in to your Internet service,
as indicated by your ISP.

Often, a service name is not required.

Connection Mode

Select how the Internet connection functions:
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Field

Description

* Always On. Once the Internet connection is established, it
remains active. This is the default setting.

* Dial on Demand. When someone attempts to connect to the
Internet, the Internet connection is established. When the idle
time-out period expires, the Internet connection is terminated.

¢ Manually Connect. You must connect to the Internet manually
(see View or Change a TCP/IP Internet Connection on page 249
or View or Change a PPPoE or PPPoA Internet Connection on
page 250).

Idle Timeout (Minutes)

If you select Dial on Demand from the Connection Mode menu,
enter the idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the
Internet connection active when no one on the network is using the
Internet connection. The default is 5 minutes. To disable the idle
time-out, enter 0. (When you disable the idle time-out, the connection
is not terminated automatically).

Internet IP Address or IPTV IP Address (depending on your selection in Step 8)

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that
your ISP assigned you for static IP address service. The gateway is
the ISP router to which your modem router connects.

Domain Name Server (DNS) Address

The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS
addresses to the modem router during login, select this option and
enter the IP address of your ISP primary DNS server. If a secondary
DNS server address is available, enter it also.

NAT (Network Address Translation)
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Field Description

NAT allows computers on your home network to share the modem router Internet connection. NAT

is enabled by default because it is required in most situations. Select the NAT setting:

* Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the
MAC address of the network interface card in your computer when your account is first opened. They
accept traffic only from the MAC address of that computer.

This feature allows your modem router to use your computer's MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address |The modem router captures and uses the MAC address of the
computer that you are now using. You must use the one computer
that is registered by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field
displays the MAC address of the Internet port.

12. Click the Apply button.
Your settings are saved.
13. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 299.

Specify an IPv6 Internet Connection

If you want to use an IPv6 Internet connection, you must specify the settings manually. NETGEAR genie
does not detect an IPv6 Internet connection automatically.

IPV6 Internet Connections and IPv6 Addresses

The modem router can support an IPv6 Internet connection through the following connection types:
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e Auto Detect. For more information, see Set Up an IPv6 Connection Through Auto Detect on page
85.

e 6to4 tunnel. For more information, see Set Up an IPv6 6to4 Tunnel Connection on page 87.

e Pass-through. For more information, see Set Up an IPv6 Pass-Through Connection on page 89.
* Fixed. For more information, see Set Up an IPv6 Fixed Connection on page 90.

e DHCP. For more information, see Set Up an IPv6é DHCP Connection on page 92.

 PPP over Ethernet. For more information, see Set Up an IPv6 PPPoE Connection on page 94.

* Auto Config. For more information, see Set Up an IPv6 Connection Through Auto Config on page
96.

Which connection type you must use depends on your IPv6 ISP. Follow the directions that your IPv6 ISP
gave you.

e If your ISP did not provide details, use the 6to4 tunnel connection type (see Set Up an IPv6 6to4
Tunnel Connection on page 87).

* Ifyou are not sure what type of IPv6 connection the modem router uses, use the Auto Detect connection
type, which lets the modem router detect the IPv6 type that is in use (see Set Up an IPv6 Connection
Through Auto Detect on page 85).

e If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or pass-through but is
IPv6, use the Auto Config connection type, which lets the modem router autoconfigure its IPv6
connection (see Set Up an IPv6 Connection Through Auto Config on page 96).

When you enable IPv6 and select any connection type other than IPv6 pass-through, the modem router
starts the stateful packet inspection (SPI) firewall function on the WAN interface. The modem router
creates connection records and checks every inbound IPv6 packet. If the inbound packet is not destined
to the modem router itself and the modem router does not expect to receive such a packet, or the packet
is not in the connection record, the modem router blocks this packet. This function works in two modes:
In secured mode, the modem router inspects both TCP and UDP packets. In open mode, the modem
router inspects UDP packets only.

IPv6 addresses are denoted by eight groups of hexadecimal quartets that are separated by colons. You
can reduce any four-digit group of zeros within an IPv6 address to a single zero or omit it. The following
errors invalidate an IPv6 address:

* More than eight groups of hexadecimal quartets
* More than four hexadecimal characters in a quartet
* More than two colons in a row

Set Up an IPv6 Connection Through Auto Detect

If you are not sure what type of IPv6 connection the modem router uses, use the Auto Detect connection
type, which lets the modem router detect the IPv6 type that is in use.
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To set up an IPv6 Internet connection through auto detection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > IPv6.

The IPv6 page displays.
6. From the Internet Connection Type menu, select Auto Detect.

Internet Connection Type Auto Detect =

Connection Type DHCP/Auto Config
Router's IPv6 Address On WAN
Mot Available

LAN Setup

Router's IPv6 Address On LAN
Mot Available

IP Address Assignment

Use DHCP Server
@ Auto Config

[T use This Interface ID
0 |0 210 |0

IPv6 Filtering 2 Secured Qpen

The modem router automatically detects the information in the following fields:
e Connection Type. This field indicates the connection type that is detected.

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired for the
modem router's WAN (or Internet) interface. The number after the slash (/) is the length of the
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prefix, which is also indicated by the underline (L) under the IPv6 address. If no address is acquired,
the field displays Not Available.

* Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also
indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays
Not Available.

7. Select an IP Address Assignment radio button:

Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPvV6 client function.

Auto Config. This is the default setting.

8. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use
This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its MAC address.

9. Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.

10. Click the Apply button.

Your settings are saved.

Set Up an IPv6 6t04 Tunnel Connection

With an IPv6 connection, your modem router creates a 6to4 tunnel to a remote relay router. Make sure
that the IPv4 Internet connection is working before you apply the 6to4 tunnel settings for the IPv6
connection.

Note Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 Internet connection by using a 6to4 tunnel:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > IPv6.

The IPv6 page displays.

From the Internet Connection Type menu, select 6to4 Tunnel.

-

Internet Connection Type Gtod Tunnel A

Remote 6tod Relay Router
9 Auto
7 Static |P Address

[=]
o
)
=

LAN Setup

Router's IPv6 Address On LAN
Mot Available

IP Address Assignment

) Use DHCP Server
9! Auto Config

[ Use This Interface ID
0 o o

o

IPv6 Filtering @ Secured Open

The modem router automatically detects the information in the Router’s IPv6 Address On LAN field.
This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number
after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6
address.

Select a Remote 6to4 Relay Router radio button:

Auto. Your modem router uses any remote relay modem router that is available on the Internet.
This is the default setting.

Static IP Address. Enter the static IPv4 (not IPv6) address of the remote relay modem router.
Your IPv6 ISP usually provides this address.

Select an IP Address Assignment radio button:
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Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPv6 client function. This is the default setting.

Auto Config. The modem router automatically configures its IPv6 address based on the IPv6
protocol.

9. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use
This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its MAC address.

10. Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.
11. Click the Apply button.

Your settings are saved.

Set Up an IPv6 Pass-Through Connection

In IPv6 pass-through mode, the modem router works as a Layer 2 Ethernet switch with two ports (LAN
and WAN Ethernet ports) for IPv6 packets. The modem router does not process any IPv6 header packets.

Note Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 pass-through Internet connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > IPv6.
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The IPv6 page displays.

From the Internet Connection Type menu, select Pass Through.
The page adjusts, but no additional fields display.

Click the Apply button.

Your settings are saved.

Set Up an IPv6 Fixed Connection

A fixed IPv6 connection is based on a static or fixed IPv6 address that your IPv6 ISP gave you.

Note Follow the directions that your IPv6 ISP gave you.

To set up afixed IPv6 Internet connection:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.

Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select ADVANCED > Advanced Setup > IPv6.

The IPv6 page displays.
From the Internet Connection Type menu, select Fixed.
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Internet Connection Type Fixed -

WAN Setup
IPv6 Address/Prefix Length

] i) ;0 0 ;|0 0 ;0 st H 10
Default IPvG Gateway

] ;10 .0 ;10 Al 0 0 4iH
Primary DNS

Secondary DNS

LAN Setup
IP Address Assignment

Use DHCP Server
@ Auto Config

IPvE Address/Prefix Length
0 :10 10 -0 ;|0 0 :|0 : 10 10

IPv6 Filtering @ gecured ) Open

7. Configure the fixed IPv6 addresses for the WAN connection:
» IPv6 Address/Prefix Length. The IPv6 address and prefix length of the modem router WAN
interface that your ISP provided to you.

o Default IPv6 Gateway. The IPv6 address of the default IPv6 gateway for the modem router’s
WAN interface that your ISP provided to you.

* Primary DNS. The primary DNS server that resolves IPv6 domain name records for the modem
router that your ISP provided to you.

e Secondary DNS. The secondary DNS server that resolves IPv6 domain name records for the
modem router that your ISP provided to you.

Note If you do not specify the DNS servers, the modem router uses the DNS servers that
are configured for the IPv4 Internet connection on the Internet Setup page (see
Manually Set Up an ADSL Internet Connection on page 51, Manually Set Up a VDSL
Internet Connection on page 63, or Manually Set Up a Cable or Fiber Internet
Connection on page 73).

8. Select an IP Address Assignment radio button:
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Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPv6 client function. This is the default setting.

Auto Config. The modem router automatically configures its IPv6 address based on the IPv6
protocol.

9. Inthe IPv6 Address/Prefix Length fields, specify the static IPv6 address and prefix length of the
modem router’s LAN interface.

If you do not specify an address here, the modem router generates one automatically from its MAC
address.

10. Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.

11. Click the Apply button.

Your settings are saved.

Set Up an IPv6 DHCP Connection

An IPv6 DHCP connection is based on a dynamic IPv6 address that a DHCPV6 server assigns to the
modem router.

Note Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 Internet connection with a DHCP server:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > IPv6.
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The IPv6 page displays.
6. From the Internet Connection Type menu, select DHCP.

Internet Connection Type DHCP v

User Class (if Required)
Domain Name

Router's IPv6 Address On WAN
Mot Available

LAN Setup

Router's IPv6 Address On LAN
Mot Available

IP Address Assignment
Use DHCP Server

@ Auto Config

[[) Use This Interface ID
0 0 o o

IPv6 Filtering @ Secured Open

The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired for the
modem router’'s WAN (or Internet) interface. The number after the slash (/) is the length of the
prefix, which is also indicated by the underline () under the IPv6 address. If no address is acquired,
the field displays Not Available.

* Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired for the modem
router's LAN interface. The number after the slash (/) is the length of the prefix, which is also
indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays
Not Available.

7. If your IPv6 ISP gave you a specific host name, in the User Class (if Required) field, enter the host
name.

If your IPv6 ISP did not give you a specific host name, you can leave this field blank.
8. To specify a domain name, in the Domain Name field, enter a domain name.

If your ISP gave you a specific domain name, enter it in this field. (For example, Earthlink Cable might
require a host name of home, and Comcast sometimes supplies a domain name.)
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If your ISP did not give you a specific domain name, you can either leave this field blank or enter the
domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4 ISP here.) For example,
if your ISP’s mail server is mail.xxx.yyy.zzz, enter xxx.yyy.zzz as the domain name.

Select an IP Address Assignment radio button:

Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPV6 client function. This is the default setting.

Auto Config. The modem router automatically configures its IPv6 address based on the IPv6
protocol.

To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use
This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its MAC address.

Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.

Click the Apply button.

Your settings are saved.

Set Up an IPv6 PPPoE Connection

An IPv6 PPPoE connection is based on a dynamic IPv6 address that a PPPoOE service assigns to the
modem router.

Note Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 PPPoE Internet connection:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 page displays.
6. From the Internet Connection Type menu, select PPPoE.

h

Internet Connection Type PPPoE -

Login
Password
Service Name
Connection Mode Always On
Router's IPv6 Address On WAN
Mot Available

LAN Setup

Router's IPv6 Address On LAN
Mot Available

IP Address Assignment

Use DHCP Server
@ Auto Config

[T use This Interface ID
0 =10 =10 =10

IPV6 Filtering 9 Secured ) Open

The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired for the
modem router's WAN (or Internet) interface. The number after the slash (/) is the length of the
prefix, which is also indicated by the underline () under the IPv6 address. If no address is acquired,
the field displays Not Available.

* Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also
indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays
Not Available.

7. Inthe Login field, enter the login information for the ISP connection.
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This is usually the name that you use in your email address. For example, if your main mail account
is JerAB@ISP.com, you would enter JerAB in this field. Some ISPs (such as Earthlink) require that
you use your full email address when you log in. If your ISP requires your full email address, enter it
in this field.

8. Inthe Password field, enter the password for the ISP connection.
9. Inthe Service Name field, enter a service name.

If your ISP did not provide a service name, leave this field blank.

Note The default setting of the Connection Mode menu is Always On to provide a steady
IPv6 connection. The modem router never terminates the connection. If the connection
is terminated, for example, when the modem is turned off, the modem router attempts
to reestablish the connection immediately after the PPPoOE connection becomes
available again.

10. Select an IP Address Assignment radio button:

Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPv6 client function. This is the default setting.

Auto Config. The modem router automatically configures its IPv6 address based on the IPv6
protocol.

11. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use
This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its MAC address.

12. Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.

13. Click the Apply button.
Your settings are saved.

Set Up an IPv6 Connection Through Auto Config

If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or pass-through but is IPv6,
use the Auto Config connection type, which lets the modem router autoconfigure its IPv6 connection.
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To set up an IPv6 Internet connection through auto-configuration:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 page displays.
6. From the Internet Connection Type menu, select Auto Config.

T

h

Internet Connection Type Auto Config -

DHCP User Class (if Required)

DHCP Domain Name

Router's IPv6 Address On WAN
Mot Available

LAN Setup

Router's IPv6 Address On LAN
Mot Available

IP Address Assignment

_' Use DHCP Server
@ Auto Config

[7] Use This Interface ID
0 :10 -0 |0

IPv6 Filtering @ Secured Qpen

The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired for the
modem router’s WAN (or Internet) interface. The number after the slash (/) is the length of the
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prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired,
the field displays Not Available.

* Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also
indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays
Not Available.

7. If your ISP gave you a specific user class, in the DHCP User Class (If Required) field, enter the user
class.

If your ISP did not give you a specific user class, leave this field blank.
8. To specify a domain name, in the DHCP Domain Name field, enter a domain name.

If your ISP gave you a specific domain hame, enter it in this field. (For example, Earthlink Cable might
require a host name of home, and Comcast sometimes supplies a domain name.)

If your ISP did not give you a specific domain name, you can either leave this field blank or enter the
domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4 ISP here.) For example,
if your ISP’s mail server is mail.xxx.yyy.zzz, enter xxx.yyy.zzz as the domain name.

9. Select an IP Address Assignment radio button:

Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network
(the LAN) through a DHCP server. This method passes more information to LAN devices, but some
IPv6 systems might not support the DHCPv6 client function.

Auto Config. This is the default setting.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use
This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its MAC address.

11. Select the IPv6 filtering mode:

Secured. In secured mode, which is the default mode, the modem router inspects both TCP and
UDP packets.

Open. In open mode, the modem router inspects UDP packets only.

12. Click the Apply button.

Your settings are saved.

Manage the MTU Size

The maximum transmission unit (MTU) is the largest data packet a network device transmits.
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MTU Concepts

When one network device communicates across the Internet with another, the data packets travel through
many devices along the way. If a device in the data path uses a lower MTU setting than the other devices,
the data packets must be split or “fragmented” to accommodate the device with the smallest MTU.

The best MTU setting for NETGEAR equipment is often the default value. In some situations, changing
the value fixes one problem but causes another.

Leave the MTU unchanged unless one of these situations occurs:

* You experience problems connecting to your ISP or other Internet service, and the technical support
of either the ISP or NETGEAR recommends changing the MTU setting. These web-based applications
might require an MTU change:

A secure website that does not open or displays only part of a web page
Yahoo email

MSN portal

America Online’s DSL service

* You use VPN and experience severe performance problems.

* You used a program to optimize MTU for performance reasons and now you are experiencing
connectivity or performance problems.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are willing to
experiment, you can gradually reduce the MTU from the maximum value of 1500 until the problem goes
away. The following table describes common MTU sizes and applications.

Table 9. Common MTU sizes

MTU Application

1500 The largest Ethernet packet size. This setting is typical for connections that do
not use PPPoE or VPN and is the default value for NETGEAR modem routers,
adapters, and switches.

1492 Used in PPPoE environments.

1472 Maximum size to use for pinging. (Larger packets are fragmented.)

1468 Used in some DHCP environments.

1460 Usable by AOL if you do not send or receive large email attachments, for example.

1458 Used in PPPOA environments.
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MTU Application
1436 Used in PPTP environments or with VPN.
1400 Maximum size for AOL DSL.

Change the MTU Size

Warning
An incorrect MTU setting can cause Internet communication problems. For
example, you might not be able to access certain websites, frames within
websites, secure login pages, or FTP or POP servers. Change the MTU only
if you are sure that it is necessary for your ISP connection.

To change the MTU size:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup >WAN Setup.

The WAN Setup page displays.

In the MTU Size field, enter a value from 616 to 1500.

The normal MTU (maximum transmit unit) value for most Ethernet networks is 1500 bytes, 1492 bytes
for PPPOE connections, or 1436 for PPTP connections.

Click the Apply button.

Your settings are saved.
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Manage the WiFi Network Settings 4

This chapter describes how you can manage the WiFi network settings of the modem router.

The chapter includes the following sections:

Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 102
Use WPS to Add a Device to the WiFi Network on page 114

Manage the Basic WiFi Settings and WiFi Security of the Guest Network on page 117
Control the WiFi Radios on page 123

Set Up a WiFi Schedule on page 125

Manage the WPS Settings on page 127

Manage Advanced WiFi Features on page 129

Use the Modem Router as a WiFi Access Point on page 131

For information about setting up an access control list (ACL) and managing WiFi access, see Allow or Block
Access to Your Network on page 136.
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Manage the Basic WiFi Settings and WiFi Security of the Main
Network

The modem router comes with preset security. This means that the WiFi network name (SSID), network
key (password), and security option (encryption protocol) are preset in the factory. The preset SSID and
password are uniquely generated for every device to protect and maximize your WiFi security. You can

find the preset SSID and password on the product label (see Bottom Panel Product Label on page 17).

Note NETGEAR recommends that you do not change your preset security settings. If you do
decide to change your preset security settings, make a note of the new settings and
store the note in a safe place where you can easily find it.

View or Change the Basic WiFi Settings

You can view or change the basic WiFi settings and WiFi security. The modem router simultaneously
supports the 2.4 GHz band for 802.11b/g/n devices and the 5 GHz band for 802.11a/n/ac devices.

Tip If do decide to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To view or change the basic WiFi settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select Wireless.
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Wireless Settings

G civinid

Region Selection
Region: LSA

Wireless Network (2.4GHz bigin)

Mame (SSID): METGEAR47
Channel: Auto -

Mode: Up to 600 Mbps =
V| Enable SSID Broadcast

Security Options
~' Mone
@ WPA2-PSK [AES]
! WPA-PSK [TKIP] + WPAZ-PSK [AES]
' WPANPAZ Enterprise

Security Options (WPA2-PSK)
Passphrase: joyousrosebudb34 (8-63 characters or 64 hex digits)

Wireless Network (5GHz a/n/ac)

Mame (SSID); NETGEAR47-5G
Channel: 149 -
Mode: Upto 1300 Mbps ~

V| Enable SSID Broadcast

Security Options
) Mone
@ WPAZ-PSK [AES]
) WPA-PSK [TKIP] + WPA2-PSK [AES]
| WPAWPAZ Enterprise

Security Options (WPA2-PSK)
Passphrase: joyousrosebud634 (8-63 characters or 64 hex digits)

View or change the basic WiFi settings and security settings.

The following table describes the fields on the Wireless Settings page.

Field Description

Region Selection

operates.

Region From the menu, select the region in which the modem router
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Field

Description

Note It might not be legal to operate the modem router
in a region other than the regions listed in the
menu. If your country or region is not listed, check
with your local government agency.

Wireless Network (2.4GHz b/g/n)

Name (SSID)

The SSID is the WiFi network name. If you did not change the
SSID, the default SSID displays. The default SSID is also printed
on the product label (see Bottom Panel Product Label on page
17).

Note NETGEAR recommends that you do not change
the default SSID. If you must change the SSID,
enter a 32-character (maximum), case-sensitive
name in this field.

Channel

From the Channel menu, select Auto for automatic channel
selection or select an individual channel. The default selection
is Auto.

Note In some regions, not all channels are available.
Do not change the channel unless you experience
interference (shown by lost connections or slow
data transfers). If this situation occurs, experiment
with different channels to see which is the best.

Note If you use multiple WiFi access points (APSs), re-
duce interference by selecting different channels
for adjacent APs. NETGEAR recommends a
channel spacing of four channels between adja-
cent APs (for example, use Channels 1 and 5, or
6 and 10).

Manage the WiFi Network Settings

104




Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Field

Description

Mode

From the Mode menu, select one of the following modes:

* Up to 54 Mbps. Legacy mode. This mode allows 802.11n,
802.11g, and 802.11b devices to join the network but limits
802.11n devices to function at up to 54 Mbps.

* Up to 289 Mbps. Neighbor-friendly mode for reduced
interference with neighboring WiFi networks. This mode
allows 802.11n, 802.11g, and 802.11b devices to join the
network but limits 802.11n devices to function at up to
289 Mbps.

* Up to 600 Mbps. Performance mode. This mode allows
802.11n, 802.11g, and 802.11b devices to join the network
and allows 802.11n devices to function at up to 600 Mbps.
This mode is the default mode.

Note The 600 Mbps performance mode requires
256 QAM support on the WiFi client.

Note WPA-PSK security supports speeds of up to
54 Mbps. Even if your devices are capable of
a higher speed, WPA-PSK security limits their
speed to 54 Mbps.

Enable SSID Broadcast

By default, the modem router broadcasts its SSID so that WiFi
stations can detect the WiFi name (SSID) in their scanned
network lists. To turn off the SSID broadcast, clear the Enable
SSID Broadcast check box. Turning off the SSID broadcast
provides additional WiFi security, but users must know the SSID
to be able to join the WiFi network of the modem router.

Security Options

This information applies to the 2.4 GHz WiFi network.

Note NETGEAR recommends that you do not change your preset security settings (WPA2-

PSK [AES]).
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Field Description

If you must change the WiFi security, select one of the following WiFi security options for the modem
router’s WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the
network. NETGEAR recommends that you do not use an open WiFi network.

WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption
mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you
select Up to 54 Mbps from the Mode menu. For information about configuring WEP, see Configure
WEP Legacy WiFi Security on page 112.

WPA-PSK [TKIP].WPA provides a secure connection but is superseded by WPA2. The WPA-PSK
[TKIP] option displays only if you select Up to 54 Mbps from the Mode menu.

To use WPA security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
modem router's WiFi network, a user must enter this passphrase.

WPA2-PSK [AES]. This option is the default setting. This type of security enables WiFi devices
that support WPA2 to join the modem router’s 2.4 GHz WiFi network. If you did not change the
passphrase, the default passphrase displays. The default passphrase is printed on the product
label (see Bottom Panel Product Label on page 17). WPA2 provides a secure connection but
some older WiFi devices do not detect WPA2 and support only WPA. If your network includes
such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

NETGEAR recommends that you do not change the default passphrase. If you must change the
passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem
router's WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support
either WPA or WPAZ2 to join the modem router’s 2.4 GHz WiFi network. However, WPA-PSK
[TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join
the modem router’s WiFi network, a user must enter this passphrase.

WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a
RADIUS server. For information about configuring WPA/WPA2 Enterprise, see Configure
WPA/WPAZ2 Enterprise WiFi Security on page 109.

Wireless Network (5GHz 802.11a/n/ac)

Enable Video Network If you want to stream high-definition video, select this check

box. When this option is selected, the modem router uses video
reliability algorithms to reduce jitter and packet loss during video
presentations. If you do not stream videos, leave this check box
cleared.
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Field

Description

Name (SSID)

The SSID is the WiFi network name. If you did not change the
SSID, the default SSID displays. The default SSID is also printed
on the product label (see Bottom Panel Product Label on page
17).

Note NETGEAR recommends that you do not change
the default SSID. If you must change the SSID,
enter a 32-character (maximum), case-sensitive
name in this field.

Channel

From the Channel menu, select an individual channel. The
default channel depends on your selection from the Region
menu.

Note In some regions, not all channels are available.
Do not change the channel unless you experience
interference (shown by lost connections or slow
data transfers). If this situation occurs, experiment
with different channels to see which is the best.

Note If you use multiple WiFi access points (APS), re-
duce interference by selecting different channels
for adjacent APs. NETGEAR recommends a
channel spacing of four channels between adja-
cent APs.

Mode

From the Mode menu, select one of the following modes:

¢ Up to 289 Mbps. Legacy mode. This mode allows 802.11ac,
802.11na, and 802.11a devices to join the network but limits
802.11ac and 802.11na devices to function at up to
289 Mbps.

¢ Up to 600 Mbps. Neighbor-friendly mode for reduced
interference with neighboring WiFi networks. This mode
allows 802.11ac, 802.11na, and 802.11a devices to join the
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Field Description

network but limits 802.11ac devices to function at up to
600 Mbps.

* Up to 1300 Mbps. Performance mode. This mode allows
802.11ac, 802.11na, and 802.11a devices to join the
network and allows 802.11ac devices to function at up to
1300 Mbps. This mode is the default mode.

Enable SSID Broadcast By default, the modem router broadcasts its SSID so that WiFi

stations can detect the WiFi name (SSID) in their scanned
network lists. To turn off the SSID broadcast, clear the Enable
SSID Broadcast check box. Turning off the SSID broadcast
provides additional WiFi security, but users must know the SSID
to be able to join the WiFi network of the modem router.

Security Options

This information applies to the 5 GHz WiFi network.

Note NETGEAR recommends that you do not change your preset security settings (WPA2-
PSK [AES])).

If you must change the WiFi security, select one of the following WiFi security options for the modem
router’s WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the
network. NETGEAR recommends that you do not use an open WiFi network.

WPA2-PSK [AES]. This option is the default setting. This type of security enables WiFi devices
that support WPA2 to join the modem router’s 5 GHz WiFi network. If you did not change the
passphrase, the default passphrase displays. The default passphrase is printed on the product
label (see Bottom Panel Product Label on page 17). WPA2 provides a secure connection but
some older WiFi devices do not detect WPA2 and support only WPA. If your network includes
such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

NETGEAR recommends that you do not change the default passphrase. If you must change the
passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem
router's WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support
either WPA or WPAZ2 to join the modem router's 5 GHz WiFi network. However, WPA-PSK [TKIP]
is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
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Field Description

To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join
the modem router’s WiFi network, a user must enter this passphrase.

«  WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a
RADIUS server. For information about configuring WPA/WPA2 Enterprise, see Configure
WPA/WPA2 Enterprise WiFi Security on page 109.

7. Click the Apply button.
Your settings are saved.

If you connected over WiFi to the network and you changed the SSID, you are disconnected from the
network.

8. Make sure that you can reconnect over WiFi to the network with its new settings.

If you cannot connect over WiFi, check the following:

If your computer or WiFi device is already connected to another WiFi network in your area, disconnect
it from that WiFi network and connect it to the WiFi network that the modem router provides. Some
WiFi devices automatically connect to the first open network without WiFi security that they discover.

If your computer or WiFi device is trying to connect to your network with its old settings (before you
changed the settings), update the WiFi network selection in your computer or WiFi device to match
the current settings for your network.

Does your WiFi device display as an attached device? (See View Devices Currently on the Network
on page 251.) If it does, it is connected to the network.

Are you using the correct network name (SSID) and password?

Configure WPA/WPA2 Enterprise WiFi Security

Remote Authentication Dial In User Service (RADIUS) is an enterprise-level method for centralized
Authentication, Authorization, and Accounting (AAA) management. To provide WPA/WPA2 enterprise
WiFi security, the WiFi network that the modem router provides must be able to access a RADIUS server.

Tip If you want to change the WiFi settings of the modem router’'s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To configure WPA/WPA2 enterprise security:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
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A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select Wireless.

The Wireless Settings page displays.

Note If you are configuring a guest network, select Guest Network instead. The Guest
Network Settings page displays.

In the Security Options section below either the Wireless Network (2.4GHz b/g/n) section or the
Wireless Network (5GHz a/n/ac) section, select the WPA/WPA?2 Enterprise radio button.

Security Options
_' None
) WPA2-PSK [AES]
WPA-PSK [TKIP] = WPA2-PSK [AES]
@ WPAWPAZ Enterprise

Security Options (WPANWWPA2 Enterprise)

WPA Mode: WPA [TKIP] + WPAZ [AES] ~
Group Key Update Interval 3600 (Seconds)

RADIUS server IP Address:

RADIUS server Port 1812

RADIUS server Shared Secret

In the Security Options (WPA/WPA2 Enterprise) section, enter the settings as described in the following
table.

Field Description

WPA Mode From the WPA Mode menu, select the enterprise mode:
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Field Description

*  WPA [TKIP] +WPA2 [AES]. This type of security enables WiFi devices
that support either WPA or WPA2 to join the modem router’'s WiFi
network.

*  WPA2 [AES]. WPA2 provides a secure connection but some older WiFi
devices do not detect WPA2 and support only WPA. If your network
includes such older devices, select WPA [TKIP] + WPA2 [AES] security.
If your network includes older devices only, select WPA [TKIP] security.

*  WHPA [TKIP]. WPA provides a secure connection. If your network
includes older devices only, select this type of security.

Group Key Update Enter the interval in seconds after which the RADIUS group key is updated.
Interval The default interval is 3600 seconds.

RADIUS server IP Enter the IPv4 address of the RADIUS server to which the WiFi network
Address can connect.

RADIUS server Port Enter the number of the port on the modem router that is used to access
the RADIUS server for authentication. The default port number is 1812.

RADIUS server Shared |Enter the shared secret (RADIUS password) that is used between the
Secret modem router and the RADIUS server during authentication of a WiFi user.

Click the Apply button.

Your settings are saved.

Make sure that you can reconnect over WiFi to the network with its new security settings.

If you cannot connect over WiFi, check the following:

i your computer or WiFi device is already connected to another WiFi network in your area, disconnect
it from that WiFi network and connect it to the WiFi network that the modem router provides. Some

WiFi devices automatically connect to the first open network without WiFi security that they discover.

If your computer or WiFi device is trying to connect to your network with its old settings (before you
changed the settings), update the WiFi network selection in your computer or WiFi device to match
the current settings for your network.

Does your WiFi device display as an attached device? (See View Devices Currently on the Network
on page 251.) If it does, it is connected to the network.
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Are you using the correct network name (SSID) and password?

Configure WEP Legacy WiFi Security

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is
superseded by WPA-PSK and WPA2-PSK. WEP limits the WiFi transmission speed to 54 Mbps (the
modem router is capable of speeds of up 300 Mbps).

Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To configure WEP security:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select Wireless.

The Wireless Settings page displays.

From the Mode menu, select Up to 54 Mbps.
The page adjusts to display the WEP radio button.

In the Security Options section, select the WEP radio button.
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Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Security Options
None
@ WEP
WPA-PSK [TKIP]
WPA2-PSK [AES]
WPRA-PSK [TKIP] + WPAZ-PSK [AES]
WPAWPAZ Enterprise

Security Encryption (\WEP)
Authentication Type: Automatic -
Encryption Strenath: 64-bit -

Security Encryption (WEP) Key

Key1, @
Key2 €
Key 3:
Key 4. !

From the Authentication Type menu, select one of the following types:
Automatic. Clients can use either Open System or Shared Key authentication.
Shared Key. Clients can use only Shared Key authentication.

From the Encryption Strength menu, select the encryption key size:
64-bit. Standard WEP encryption, using 40/64-bit encryption.

128-bit. Standard WEP encryption, using 104/128-bit encryption. This selection provides higher
encryption security.

In the Passphrase field, enter a phrase.
The phrase must consist of alphanumeric characters.

Click the Generate button.
For each of the key fields, a value is generated and entered automatically.

Specify the active key by selecting the Key 1, Key 2, Key 3, or Key 4 radio button.

Only one key can be the active key. To join the modem router's WiFi network, a user must enter the
key value for the key that you specified as the active key.

To manually change the generated value for the key, do the following:

For 64-bit WEP, enter 10 hexadecimal digits (any combination of 0-9, A—F). The key values are
not case-sensitive.
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For 128-bit WEP, enter 26 hexadecimal digits (any combination of 0-9, A—F). The key values are
not case-sensitive.

To join the modem router’s WiFi network, a user must enter the key value for the key that you specified
in Step 12 as the active key.
14. Click the Apply button.

Your settings are saved.

15. Make sure that you can reconnect over WiFi to the network with its new security settings.

If you cannot connect over WiFi, check the following:

If your computer or WiFi device is already connected to another WiFi network in your area, disconnect
it from that WiFi network and connect it to the WiFi network that the modem router provides. Some
WiFi devices automatically connect to the first open network without WiFi security that they discover.

If your computer or WiFi device is trying to connect to your network with its old settings (before you
changed the settings), update the WiFi network selection in your computer or WiFi device to match
the current settings for your network.

Does your WiFi device display as an attached device? (See View Devices Currently on the Network
on page 251.) If it does, it is connected to the network.

Are you using the correct network name (SSID) and password?

Use WPS to Add a Device to the WiFi Network

WPS (Wi-Fi Protected Setup) lets you connect a computer or WiFi device to the modem router’s network
without entering the WiFi network passphrase or key. Instead, you use a WPS button or enter a PIN to
connect.

If you use the push button method, the WiFi device that you are trying to connect must provide either a
physical button or a software button. If you use the PIN method, you must know the PIN of the WiFi device
that you are trying to connect.

WPS supports WPA and WPA2 WiFi security. If your modem router network is open (no WiFi security is

set, which is not the default setting for the modem router), connecting with WPS automatically sets WPA
+ WPA2 WiFi security on the modem router network and generates a random passphrase. You can view
this passphrase (see View or Change the Basic WiFi Settings on page 102).

Use WPS with the Push Button Method

For you to use the push button method to connect a WiFi device to the modem router’s WiFi network, the
WiFi device that you are trying to connect must provide either a physical button or a software button. You
can use the physical button and software button to let a WiFi device join only the main WiFi network, not
the guest WiFi network.
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To let a WiFi device join the modem router’s main WiFi network using WPS with the push button
method:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.

The BASIC Home page displays.
5. Select ADVANCED >WPS Wizard.

The page displays a description of the WPS method.
6. Click the Next button.

Select a setup method:

2 Push Bulton (recommended)
You can efther press the physical push button on the router or click the button (soft push button) in this screen.

'l

PIN Mumber
This is the security PIN of the WPS client. While connedling, WPS-enabled adapters provide a randamily-genarated security PIN

By default, the Push Button (recommended) radio button is selected.
Either click the =" button onscreen or press the WPS button on the right side panel of the modem
router.

For two minutes, the modem router attempts to find the WiFi device (that is, the client) that you want
to join the modem router’s main WiFi network.

During this time, the WiFi LED on the top panel of the modem router blinks white.

8. Within two minutes, go to the WiFi device and press its WPS button to join the modem router’'s main
WiFi network without entering a password.
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After the modem router establishes a WPS connection, the WiFi LED lights solid white and the Add
WPS Client page displays a confirmation message.

9. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC
> Attached Device.

The WiFi device displays onscreen.

Use WPS with the PIN Method

To use the PIN method to connect a WiFi device to the modem router’s WiFi network, you must know the
PIN of the WiFi device that you are trying to connect.

To let a WiFi device join the modem router’s WiFi network using WPS with the PIN method:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED >WPS Wizard.
The page displays a description of the WPS method.
6. Click the Next button.
The Add WPS Client page adjusts.
The Push Button (recommended) radio button is selected by default.

7. Select the PIN Number radio button.
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J—M

Select a setup method:
Push Button (recommended)
2 PIN Number
Thiz is the security PIM of the WPS clienl While connecting, WPS-enabled adapters provide a randomily-generated security PIN,
Enter Client's PIM

8. In the Enter Client's PIN field, enter the PIN number of the WiFi device.
9. Click the Next button.

For four minutes, the modem router attempts to find the WiFi device (that is, the client) that you want
to join the modem router’s main WiFi network.

During this time, the WiFi LED on the top panel of the modem router blinks white.

10. Within four minutes, go to the WiFi device and use its WPS software to join the network without entering
a password.

When the modem router establishes a WPS connection, the WiFi LED lights solid white and the Add
WPS Client page displays a confirmation message.

11. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC
> Attached Device.

The WiFi device displays onscreen.

Manage the Basic WiFi Settings and WiFi Security of the Guest
Network

A guest network allows visitors to use the Internet without using your WiFi security key. By default, the
guest WiFi network is disabled. You can enable and configure the guest WiFi network for each WiFi band.
The modem router simultaneously supports the 2.4 GHz band for 802.11n, 802.11g, and 802.11b devices
and the 5 GHz band for 802.11ac, 802.11na, and 802.11a devices.

The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For
example, if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band,
the guest WiFi network also functions in the Up to 54 Mbps mode in the 2.4 GHz band. For information
about configuring the WiFi mode, see View or Change the Basic WiFi Settings on page 102.

The modem router provides two default guest networks with the following names (SSIDs):

¢ 2.4 GHz band. NETGEAR_Guestl

e 5 GHz band. NETGEAR-5G_Guestl

By default, these networks are configured as open networks without security but are disabled. You can
enable one or both networks. You can also change the SSIDs for these networks.
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To set up a guest network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

The BASIC Home page displays.

4. Select Guest Network.
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Guest Network

Select the wireless network to configure (2.4GHz bigin)

Profile S5ID Guest Hetwork Security Enable Broadcast 551D
@ 1 METGEAR_Guest Yes Mone Mo Yes
Wireless Network (2.4GHz bigin)
Mame (SSID): NETGEAR_Guestl
Channel; Auto -
Mode: 'Up to 600 Mbps ~

| Enable Guest Metwork
¥ Enable SSID Broadcast
T Allow guests to see each other and access my local network

Security Options
@ None
T WPAZ-PSK [AES]
O WPA-PSK [TKIP] + WPAZ-PSK [AES]
O WPAWPAZ Enterprise

Select the wireless network to configure (5GHz alniac)
Profile SSID Guest Hetwork Security Enable Broadcast SSID

@ 1 METGEAR-5G_Guest1 Yes Mone Mo Yes

Wireless Network (5GHz a/nlac)
Mame (SSID). NETGEAR-5G_Guest]
Channel: 149 =
Mode: 'Upto 1300 Mbps ~
| Enable Guest Network
Y| Enable S5ID Broadcast
("] Allow guests to see each other and access my local network

Security Options
@ Mone
") WPA2-PSK [AES]
©) WPA-PSK [TKIP] + WPA2-PSK [AES]
_ WPANPAZ Enterprise

5. Enable the guest network and configure its WiFi settings as described in the following table.

Field Description

Wireless Network (2.4GHz b/g/n)

Name (SSID) The SSID is the 2.4 GHz WiFi band name. If you did not
change the SSID, the default SSID displays, which is
NETGEAR_Guestl.
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Field

Description

To change the SSID in the 2.4 GHz WiFi band for the guest
WiFi network, enter a 32-character (maximum),
case-sensitive name in this field.

Channel

This field is of an informational nature and shows the channel
that is configured in the 2.4 GHz band for the main WiFi
network. You cannot change the channel in the 2.4 GHz
band for the guest WiFi network.

Mode

This field is of an informational nature and shows the mode
that is configured in the 2.4 GHz band for the main WiFi
network. You cannot change the mode in the 2.4 GHz band
for the guest WiFi network.

Enable Guest Network

By default, the guest WiFi network is disabled. To enable
the guest WiFi network for the 2.4 GHz WiFi band, select
the Enable Guest Network check box.

Enable SSID Broadcast

By default, the modem router broadcasts its SSID of the 2.4
GHz WiFi band so that WiFi stations can detect the WiFi
name (SSID) in their scanned network lists. To turn off the
SSID broadcast for the 2.4 GHz WiFi band for the guest WiFi
network, clear the Enable SSID Broadcast check box.

Allow guests to see each other and
access my local network

By default, WiFi clients that are connected to the 2.4 GHz
WiFi band of the guest WiFi network cannot access WiFi
devices or Ethernet devices that are connected to the main
WiFi network. To allow access to the main WiFi network,
select the Allow guests to see each other and access my
local network check box.

Security Options

If you want to change the WiFi security, select one of the following WiFi security options for the

2.4 GHz band of the guest WiFi network:

* None. An open WiFi network that does not provide any security. Any WiFi device can join the
2.4 GHz band of the guest WiFi network. This is the default setting for the guest WiFi network.

*  WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption
mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you
configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see
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Field Description

View or Change the Basic WiFi Settings on page 102). For information about configuring WEP,
see Configure WEP Legacy WiFi Security on page 112.

WPA-PSK [TKIP]. WPA provides a secure connection but is superseded by WPA2. The WPA-PSK
[TKIP] option displays only if you configure the WiFi mode for the main WiFi network as Up to
54 Mbps in the 2.4 GHz band (see View or Change the Basic WiFi Settings on page 102).

To use WPA security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
2 .4 GHz band of the guest WiFi network, a user must enter this passphrase.

WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices
do not detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect
to the 2.4 GHz band of the guest WiFi network at the fastest speed. If your network includes older
devices that do not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support
either WPA or WPA2 to join the 2.4 GHz band of the guest WiFi network. However, WPA-PSK
[TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To
join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

WPA/WPAZ2 Enterprise. This type of security requires that your WiFi network can access a
RADIUS server. For information about configuring WPA/WPA2 Enterprise, see Configure
WPA/WPA2 Enterprise WiFi Security on page 109.

Passphrase The passphrase that provides users access to the guest

WiFi network in the 2.4 GHZ band. The passphrase is also
referred to as the password or key.

Wireless Network (5GHz a/n/ac)

Name (SSID) The SSID is the 5 GHz WiFi band name. If you did not

change the SSID, the default SSID displays, which is
NETGEAR-5G_Guestl. To change the SSID in the 5 GHz
WiFi band for the guest WiFi network, enter a 32-character
(maximum), case-sensitive name in this field.

Channel This field is of an informational nature and shows the channel

that is configured in the 5 GHz band for the main WiFi
network. You cannot change the channel in the 5 GHz band
for the guest WiFi network.

Mode This field is of an informational nature and shows the mode

that is configured in the 5 GHz band for the main WiFi
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Field Description

network. You cannot change the mode in the 5 GHz band
for the guest WiFi network.

Enable Guest Network By default, the guest WiFi network is disabled. To enable

the guest WiFi network for the 5 GHz WiFi band, select the
Enable Guest Network check box.

Enable SSID Broadcast By default, the modem router broadcasts its SSID of the 5

GHz WiFi band so that WiFi stations can detect the WiFi
name (SSID) in their scanned network lists. To turn off the
SSID broadcast for the 5 GHz WiFi band for the guest WiFi
network, clear the Enable SSID Broadcast check box.

Allow guests to see each other and By default, WiFi clients that are connected to the 5 GHz WiFi
access my local network band of the guest WiFi network cannot access WiFi devices

or Ethernet devices that are connected to the main WiFi
network. To allow access to the main WiFi network, select
the Allow guests to see each other and access my local
network check box.

Security Options

If you want to change the WiFi security, select one of the following WiFi security options for the 5 GHz
band of the guest WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the
5 GHz band of the guest WiFi network. This is the default setting for the guest WiFi network.

WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices
do not detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect
to the 5 GHz band of the guest WiFi network at the fastest speed. If your network includes older
devices that do not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
5 GHz band of the guest WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support
either WPA or WPA2 to join the 5 GHz band of the guest WiFi network. However, WPA-PSK
[TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
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Field Description

To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To
join the 5 GHz band of the guest WiFi network, a user must enter this passphrase.

«  WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a
RADIUS server. For information about configuring WPA/WPA2 Enterprise, see Configure
WPA/WPA2 Enterprise WiFi Security on page 109.

Passphrase The passphrase that provides users access to the guest
WiFi network in the 5 GHZ band. The passphrase is also
referred to as the password or key.

6. Click the Apply button.
Your settings are saved.
7. Make sure that you can reconnect over WiFi to the guest network.

If you cannot connect over WiFi, check the following:

tof your computer or WiFi device is already connected to another WiFi network in your area, disconnect
it from that WiFi network and connect it to the WiFi network that the modem router provides. Some
WiFi devices automatically connect to the first open network without WiFi security that they discover.

Does your WiFi device display as an attached device? (See View Devices Currently on the Network
on page 251.) If it does, it is connected to the network.

Are you using the correct network name (SSID) and password?

Control the WiFi Radios

The modem router provides internal WiFi radios that broadcast signals in the 2.4 GHz and 5 GHz ranges.
By default, they are on so that you can connect over WiFi to the modem router. When the WiFi radios are
off, you can still use an Ethernet cable for a LAN connection to the modem router.

You can turn the WiFi radios on and off with the WiFi On/Off button on the modem router, or you can log
in to the modem router and enable or disable the WiFi radios through the web management interface. If
you are close to the modem router, it might be easier to press the WiFi On/Off button. If you are away
from the modem router or already logged in, it might be easier to enable or disable the radios through the
web management interface. You can also turn the WiFi radios off and on based on a schedule. (See Set
Up a WiFi Schedule on page 125.)
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Use the WiFi On/Off Button

To turn the WiFi radios off and on with the WiFi On/Off button:

* Press the WiFi On/Off button on the top panel of the modem router for two seconds.

If you turned off the WiFi radios, the 2.4 GHz WiFi LED, 5 GHz WiFi LED, WiFi LED, and WPS LED
turn off. If you turned on the WiFi radios, these LEDs lights solid white.

Tip If you want to disable the WiFi radio or radios of the modem router, use a wired
connection to avoid being disconnected when WiFi radio or radios turn off.

Enable or Disable the WiFi Radios

If you used the WiFi On/Off button to turn off the WiFi radios, you cannot log in to the modem router to
turn them back on. You must press the WiFi On/Off button again for two seconds to turn the WiFi radios
back on.

To enable or disable the WiFi radios:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup >Wireless Settings.

Manage the WiFi Network Settings
124



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Advanced Wireless Settings

Wireless Settings (2.4GHz bigin)
V| Enable Wireless Router Radio
] Enable 20740 MHz coexistence

Fragmentation Length (256-2346) 2346
CTS/MRTS Threshold (1-2347) 2347
Preamble Mode Long Preamble -

| Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

Period Start End Recurrence Pattern

Wireless Settings (5GHz a/nfac)
] Enable Wireless Router Radio

Fragmentation Length (256-2346) 2346
CTS/RTS Threshold (1-2347) 2347
Preamble Mode Long Preamble -

Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

Period Start End Recurrence Pattern

6. Do one of the following in the Advanced Wireless Settings (2.4GHz b/g/n) section, Advanced Wireless
Settings (5GHz 802.11a/n/ac) section, or both sections:

Turn off the radio. Clear the Enable Wireless Router Radio check box.

Tthe 2.4 GHz WiFi LED, 5 GHz WiFi LED, WiFi LED, and WPS LED turn off.

Turn on the radio. Select the Enable Wireless Router Radio check box.

The 2.4 GHz WiFi LED, 5 GHz WiFi LED, WiFi LED, and WPS LED lights solid white.

7. Click the Apply button.

Your settings are saved.

Set Up aWiFi Schedule

You can use this feature to turn off the WiFi signal from your modem router at times when you do not
need a WiFi connection. For example, you might turn it off for the weekend if you leave town.
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Note You can set up a WiFi schedule only if the modem router is connected to the Internet

and synchronized its internal clock with a time server on the Internet. For more
information about whether the modem router synchronized its clock, see Set Up a

Schedule for Keyword Blocking and Outbound Firewall Rules on page 154.

To set up the WiFi schedule:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.

Type http://www.routerlogin.net.
A login window opens.

Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are

case-sensitive.
The BASIC Home page displays.
Select ADVANCED > Advanced Setup > Wireless Settings.

Advanced Wireless Settings

Wireless Settings (2.4GHz bigin)
V] Enable Wireless Router Radio
| Enable 20740 MHz coexistence

Fragmentation Length (256-2346) 2346
CTSMRT3 Threshold (1-2347) 2347
Preamble Mode Long Preamble ~

| Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

Period Start End Recurrence Pattern
+—— a2 new perios GG

Wireless Settings (5GHz a/nfac)
V] Enable Wireless Router Radio

Fragmentation Length (256-2346) 2346
CTE/RTS Threshold (1-2347) 2347
Preamble Mode Long Preamble -

Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

Period Start End Recurrence Pattern

5. Click the Add a new period button.
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When to turn off wireless signal
Start: 0000 ~
End: 00:00 ~

Recurrence Pattern

9 Daily
Select Days
Sunday Monday Tuesday Wednesday
Thursday Friday Salurday

Use the menus, radio buttons, and check boxes to set up a period during which you want to turn off
the WiFi signal and specify whether the schedule is recurrent.

Click the Apply button.
The Advanced Wireless Settings page displays.

Select the Turn off wireless signal by schedule check box to activate the schedule.
Click the Apply button.

Your settings are saved.

Manage the WPS Settings

Wi-Fi Protected Setup (WPS) lets you join the WiFi network without typing the WiFi password. You can
change the WPS default settings.

To manage WPS settings:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

The BASIC Home page displays.
Select ADVANCED > Advanced Setup > Wireless Settings.
The Advanced Wireless Settings page displays.

Scroll down to the bottom of the screen.
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WPS Settings
Routers PIM: 18934137
Disable Routers PIN
4| Keep Existing Wireless Settings (2.4GHz bigin)
4| Keep Existing Wireless Settings (5GHz a/nfac)

The Router’s PIN field displays the fixed PIN that you use to configure the modem router’s WiFi settings
from another platform through WPS.

6. To disable the PIN, select the Disable Router’s PIN check box.

By default, the Disable Router’s PIN check box is cleared and the modem router’s PIN is enabled.
For enhanced security, you can disable the modem router’s PIN by selecting the Disable Router’s
PIN check box. However, when you disable the modem router’'s PIN, WPS is not disabled because
you can still use the physical WPS button.

Note The PIN function might temporarily be disabled automatically if the modem router
detects suspicious attempts to break into the modem router’s WiFi settings by using
the router’s PIN through WPS.

7. To allow the wireless settings to be changed automatically when you use WPS, clear one or both of
the Keep Existing Wireless Settings check boxes.

By default, both Keep Existing Wireless Settings check boxes are selected. NETGEAR recommends
that you leave these check boxes selected. If you clear a check box, the next time a new WiFi client
uses WPS to connect to the modem router, the modem router's associated WiFi settings change to
an automatically generated random SSID and passphrase. For information about viewing this SSID
and passphrase, see View or Change the Basic WiFi Settings on page 102. Clear a Keep Existing
Wireless Settings check box only if you want to allow the WPS process to change the associated
SSID and passphrase for WiFi access.

Warning
If you clear a Keep Existing Wireless Settings check box and use WPS to add
acomputer or WiFi device to the modem router’s WiFi network, the associated
SSID and passphrase are automatically generated and other WiFi devices
that are already connected to the modem router’s WiFi network might be
disconnected.

8. Click the Apply button.
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Your settings are saved.

Manage Advanced WiFi Features

For most WiFi networks, the advanced WiFi features work fine and you do not need to change the settings.

Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To manage advanced WiFi features:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.
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Advanced Wireless Settings

Wireless Settings (2.4GHz bigin)
V| Enable Wireless Router Radio
] Enable 20740 MHz coexistence

Fragmentation Length (256-2346) 2346
CTS/MRTS Threshold (1-2347) 2347
Preamble Mode Long Preamble -

Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

T Ao e peros |

Wireless Settings (5GHz a/n/ac)
] Enable Wireless Router Radio

Fragmentation Length (256-2346) 2346
CTS/RTS Threshold (1-2347) 2347
Preamble Mode Long Preamble -

Turn off wireless signal by schedule
The wireless signal is scheduled to turn off during the following time period:

Period Start End Recurrence Pattern

Enter the settings as described in the following table.

The descriptions in the table (not the settings onscreen) apply to both the Advanced Wireless Settings
(2.4GHz b/g/n) section and the Advanced Wireless Settings (5GHz 802.11a/n/ac) section, except
where noted.

Field Description

Enable 20/40 MHz Coexistence | By default, 20/40 MHz coexistence is enabled to prevent interference
between WiFi networks in your environment at the expense of the
WiFi speed. If no other WiFi networks are present in your
environment, you can clear the Enable 20/40 MHz Coexistence
check box to increase the WiFi speed to the maximum supported
speed.

Note This setting applies to the 2.4 GHz radio only.

Fragmentation Length The fragmentation length (the default is 2346), the CTS/RTS
(256-2346) threshold (the default is 2347), and the preamble mode (the default
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Field

Description

CTS/RTS Threshold (1-2347)

Preamble Mode

is Long Preamble) are reserved for WiFi testing and advanced
configuration only.

Do not change these settings unless directed by NETGEAR support
or unless you are sure what the consequences are. Incorrect settings
might disable the WiFi function of the modem router unexpectedly.

7. Click the Apply button.

Your settings are saved.

Use the Modem Router as a WiFi Access Point

You can set up the modem router to function as a WiFi access point (AP) on the same local network as
another router. When the modem router functions as a WiFi AP, many router-related features are disabled.

Tip If you wantto change the modem router’s function, use a wired connection to avoid being
disconnected when the new function takes effect.

To set up the modem router as an AP:
1. Use an Ethernet cable to connect the red Internet port on the back panel of the modem router to a

LAN port on the other router.
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Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Wireless Access Point.
The Wireless Access Point page displays.

Select the Enable Access Point Mode check box.

The information onscreen adjusts.

Scroll down and select the radio button for the IP address setting that you want to use:

Get dynamically from existing router. The other router on the network assigns an IP address to
the modem router while the modem router functions in access point mode.

Enable fixed IP settings on this device (not recommended). Use this setting if you want to
manually assign a specific IP address to the modem router while it functions in access point mode.
Using this option effectively requires advanced network experience.
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Note To avoid interference with other routers or gateways on your network, NETGEAR
recommends that you use different WiFi settings on each router. You can also turn
off the WiFi radio on the other router or gateway and use the modem router only for
WiFi client access.

8. Click the Apply button.
The IP address of the modem router changes, and you are disconnected.

9. To reconnect, close and restart your browser and type http://www.routerlogin.net.

Manage the WiFi Network Settings
133



Control Access to the Internet 5

The modem router comes with a built-in firewall that helps protect your home network from unwanted intrusions
from the Internet.

This chapter includes the following sections:

Set Up Parental Controls on page 135

Allow or Block Access to Your Network on page 136

Use Keywords to Block Internet Sites on page 143

Manage Simple Outbound Firewall Rules for Services and Applications on page 147
Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules on page 154
Set Up Security Event Email Notifications on page 156

For information about more advanced ways to configure Internet security, see Manage Port Forwarding and
Port Triggering on page 276.
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Set Up Parental Controls

The first time that you select Parental Controls from the BASIC Home page, your browser goes to the
Parental Controls website. You can learn more about Parental Controls or download the application.

To set up Parental Controls:

1.
2.

~

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select Parental Controls.

The Parental Controls website opens.

Click the button for the app or version that you want to download and use.
Follow the onscreen instructions to download and install the genie app.
Open the genie app and select Parental Controls.

After installation, Live Parental Controls automatically starts.

Live Parental Controls :
Powered by OpenDNS ISKEGRAR

You're about to setup NETGEAR Live Parental Controls Powered by OpenDNS on your router to filter websites visited on your
computers and other networked devices.

LIVE PARENTAL =
CONTROLS ENABLED

FILTERING: HIGH

H

v Set different fillering rules F— =
for each user on your network.

+ Sat rules bosed on the time of day.,

Our custom settings let you relax seourity settings for some users or at some times of the day. Learn more

9. Click the Next button, read the note, and click the Next button again.
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Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log in or create
a free account.

Setting up Live Parental Controls
Welcome, this setup wizard wil quiddy configure NETGEAR Live Parental Controls Powered by OpenDNS on your NETGEAR router.

In order to use Live Parental Controle, you need a free OpenDINS account. Do you already have ane?

() Yes, use my existing OpenDNS account.
) No, T need to creats a frea OpenDNS account.

10. Select a radio button as follows:

If you already own an OpenDNS account, leave the Yes radio button selected.

If you do not own an OpenDNS account, select the No radio button.

If you are creating an account, the Create a free OpenDNS account page displays. Do the following:
a. Complete the fields.

b. Click the Next button.

After you log on or create your account, the filtering level page displays.

11. Select the radio button for the filtering level that you want and click the Next button.
The Setup is complete page displays.

12. Click the Take me to the status screen button.
The Status page displays. Parental Controls are now set up for the modem router.

13. To enable Parental Controls, click the Enable Live Parental Controls button.

Allow or Block Access to Your Network

You can use access control to block or allow access of devices to your network. You define access by
selecting or specifying the MAC addresses of the wired and WiFi devices that either can access your
entire network or are blocked from accessing your entire network.

Enable and Manage Network Access Control

When you enable access control, you must select whether new devices are allowed to access the network
or are blocked from accessing the network. By default, currently connected devices are allowed to access
the network, but you can also block these devices from accessing the network.

To set up network access control:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.
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A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Security > Access Control.

Access Control

¥ Cancel

You can use Access Control to allow or block computers or electronic devices from accessing your network.
71 Turn Access Contral On
Access Rule:This is a general rule. You can also allow or block individual devices,

@ Allow all new devices to connect
Block all new devices from connecting

n m IP Address MAC Address Connection Type ;

[T [ Alowed [BUSINESSLAPTOP | 19216802 | 60:66:66:DA667C [Wireless(NETGEAR4T-5G) |
| | Allowed | - | 192 168.0.3 | DO:DF:41ED:41:41 |Wire|ess[NETGEAR4?} '

rView list of allowed devices not currently connected to the network

rView list of blocked devices not currently connected to the network

The previous figure shows two WiFi devices connected.

6. Select the Turn on Access Control check box.

You must select this check box before you can specify an access rule and use the Allow and Block
buttons. When the Turn on Access Control check box is cleared, all devices are allowed to connect,
even if a device is in the list of blocked devices.

7. Click the Apply button.
Your settings are saved.

8. Select an access rule for new devices:
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Allow all new devices to connect. With this setting, if you add a new device, it can access your
network. You do not need to enter its MAC address on this screen. NETGEAR recommends that
you leave this radio button selected.

Block all new devices from connecting. With this setting, if you add a new device, before it can
access your network, you must enter its MAC address for an Ethernet connection and its MAC
address for a WiFi connection in the allowed list. For more information, see Manage Network Access
Control Lists on page 139.

The access rule does not affect previously blocked or allowed devices. It applies only to devices joining
your network in the future after you apply these settings.

9. To manage access for currently connected computers and devices:
i you blocked all new devices from connecting, to allow the computer or device that you are currently
using to continue to access the network, select the check box next to your computer or WiFi device
in the table, and click the Allow button.

To either continue to allow or to block other computers and devices that are currently connected,
select the check box next to the computer or device in the table, and click either the Allow button
or the Block button.

Access Control

| x  Cancel I ABPH

You can use Access Control to allow or block computers or electronic devices from accessing your network.

] Turn Access Control On
Access Rule:This is a general rule. You can also allow or block individual devices.

@ allow all new devices to connect
") Block all new devices from connecting

"W ] et | Dovcorome | _adiess | Wachdiress | Comecion s

| ] | Allowed |BUSINESSLAPTOP | 192.168.0.2 | 60:66:66:DA66:7C |Wireless(NETGEAR4T-5G)
| &1 | Blocked | -~ | 19216803 | DODF41ED4141 | Wireless(NETGEARAT)

»View list of allowed devices not currently connected to the network

»View list of blocked devices not currently connected to the network

10. Click the Apply button.
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Your settings are saved.

Manage Network Access Control Lists

You can use access control to block or allow access to your network. An access control list (ACL) functions
with the MAC addresses of wired and WiFi devices that can either access your entire network or are
blocked from accessing your entire network.

The modem router can detect the MAC addresses of devices that are connected to the network and list
the MAC addresses of devices that were connected to the network.

Each network device owns a MAC address, which is a unique 12-character physical address, containing
the hexadecimal characters 0-9, a—f, or A—F (uppercase or lowercase) only, and separated by colons
(for example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the label of the WiFi card or network
interface device. If you cannot see the label, you can display the MAC address using the network
configuration utilities of the computer. You might also find the MAC addresses through the web management
interface of the modem router (see View Devices Currently on the Network on page 251).

Add Devices to or Remove Them from the Allowed List

If you set up an access list that blocks all new devices from accessing your network, you must specify
which devices are allowed to access your network.

To add or remove devices that are allowed:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Security > Access Control.
6. Click the View list of allowed devices not currently connected to the network link.
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pecesston cHCTEEES
You can use Access Control to allow or block computers or electronic devices from accessing your network.

[¥| Turn Access Control On
Access Rule:This is a general rule. You can also allow or block individual devices.

@ Allow all new devices to connect
) Block all new devices from connecting

"W | Saus | beucelame | Adiess |  WaCAdiress | Comeciontipe

IE | Allowed ]BUSINESSLAFTDP[ 192.168.0.2 [ 60:66:66:DA66 7C pwreless{METGEmm

wView list of allowed devices not currently connected to the network

eicte . QTN it
o e MAC Adress Comecion e

B | MACMADZ | 60:28:4B:28:9A 28 | Wireless

kView list of blocked devices not currently connected to the network

A table displays the detected device name, MAC address, and connection type of the devices that
are not connected but allowed to access the network.

To add a device to the allowed list, do the following:
a. Click the Add button.

The Add Allowed Device page displays.

. Enter the MAC address and device name for the device that you want to allow.
c. On the Add Allowed Device page, click the Apply button.
The device is added to the allowed list on the Access Control page.

To remove a device from allowed list, do the following:
a. Select the check box for the device.

b. Click the Delete button.
The device is removed from the allowed list.

Click the Apply button.

Control Access to the Internet
140



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Your settings are saved.

Add Devices to or Remove Them from the Blocked List

If you set up an access list that allows all new devices to access your network but you want to block some
devices from accessing your network, you must specify the devices that you want to block.

To add or remove devices that are blocked:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.

Select ADVANCED > Security > Access Control.
Click the View list of blocked devices not currently connected to the network link.

Control Access to the Internet
141



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

feessstonl | oIS
You can use Access Control to allow or block computers or electronic devices from accessing your network.

| Turn Access Control On
Access Rule:This is a general rule. You can also allow or block individual devices.

@ Allow all new devices to connect
) Block all new devices from connecting

n m IP Address MAC Address Connection Type

| F1 | Alowed | BUSINESSLAPTOP | 19216802 | 60:66:66DAB67C  |Wireless(NETGEAR4T)

¥ View list of allowed devices not currently connected to the network

vView list of blocked devices not currently connected to the network

I T — Comocton Tpe

| B | | DO:DF:41ED:41:41 | Wireless

A table displays the detected device name, MAC address, and connection type of the devices that
are not connected and blocked from accessing the network.

To add a device to the blocked list, do the following:
a. Click the Add button.

The Add Blocked Device page displays.

. Enter the MAC address and device name for the device that you want to block.
c. On the Add Blocked Device page, click the Apply button.
The device is added to the blocked list on the Access Control page.

To remove a device from blocked list, do the following:
a. Select the check box for the device.

b. Click the Delete button.
The device is removed from the blocked list.

Click the Apply button.
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Your settings are saved.

Use Keywords to Block Internet Sites

You can block keywords and domains (websites) to prevent certain types of HTTP traffic from accessing
your network. By default, keyword blocking is disabled and no domains are blocked.

Set Up Blocking

You can set up blocking of specific keywords and domains to occur continuously or according to a schedule.

To set up keyword and domain blocking:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http:/lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Security > Block Sites.

Control Access to the Internet
143



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Block Sites

Keyword Blocking
@ Mever
) Per Schedule
) Always

Type keyword or domain name here.

|
+ Add Keyword

Block sites containing these keywords or domain names:

-~

_alolo Keyword

["] Allow trusted IP address to visit blocked sites
Trusted IP Address 192 (. (168 [. |O . |2

Specify a keyword blocking option:

Per Schedule. Use keyword blocking according to a schedule that you set.

For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules

on page 154.
Always. Use keyword blocking continuously.

In the Type keyword or domain name here field, enter a keyword or domain.

Here are some sample entries:
e Specify XXX to block http://ww.badstuff.com/xxx.html.

e Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.

e Enter a period (.) to block all Internet browsing access.

Click the Add Keyword button.

The keyword or domain is added to the Block sites containing these keywords or domain names

field (which is also referred to as the blocked list).

To add more keywords or domains, repeat Step 7 and Step 8.
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The keyword list supports up to 32 entries.
10. Click the Apply button.

Your settings are saved.

Remove a Keyword or Domain from the Blocked List

If you no longer need a keyword or domain on the blocked list, you can remove the keyword or domain.

To remove a keyword or domain from the blocked list:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Security > Block Sites.
The Block Sites page displays.

6. Inthe Block sites containing these keywords or domain names field, select the keyword or domain.
7. Click the Delete Keyword button.

The keyword or domain is removed from the blocked list.
8. Click the Apply button.

Your settings are saved.

Remove All Keywords and Domains from the Blocked List

You can simultaneously remove all keywords and domains from the blocked list.

To remove all keywords and domains from the blocked list:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Security > Block Sites.

The Block Sites page displays.

Click the Clear List button.

All keywords and domains are removed from the blocked list.
Click the Apply button.

Your settings are saved.

Specify aTrusted Computer

You can exempt one trusted device from blocking and logging. The device that you exempt must be
assigned a fixed (static) IP address.

To specify a trusted device:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Security > Block Sites.
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ites

o

Block

Keyword Blocking
9 Mever

) Per Schedule
) Always

Type keyword or domain name here.

|
+ Add Keyword

Block sites containing these keywords or domain names:

-~

_alolo Keyword

["] Allow trusted IP address to visit blocked sites
Trusted IP Address 192 (. (168 [. |O . |2

6. Scroll down and select the Allow trusted IP address to visit blocked sites check box.
7. Inthe Trusted IP Address field, enter the IP address of the trusted device.

The first three octets of the IP address are automatically populated and depend on the IP address
that is assigned to the modem router on the LAN Setup screen.

8. Click the Apply button.

Your settings are saved.

Manage Simple Outbound Firewall Rules for Services and
Applications

A firewall protects one network (the trusted network, such as your LAN) from another (the untrusted
network, such as the Internet), while allowing communication between the two.

The modem router provides one default outbound firewall rule: It allows all access to the Internet (that is,
the WAN). You can add simple rules to prevent access to specific services and applications on the Internet.
In addition, you can specify if a rule applies to one user, a range of users, or all users on your LAN.

The modem router lists many default services and applications that you can use in outbound rules. You
can also add an outbound firewall rule for a custom service or application.
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For information about blocking specific keywords, URLS, or sites, see Use Keywords to Block Internet
Sites on page 143. This type of blocking is another aspect of the outbound firewall. For information about
inbound firewall rules, see Manage Port Forwarding and Port Triggering on page 276.

Note Service blocking means the same thing as applying outbound firewall rules.

Add an Outbound Firewall Rule

You can add an outbound firewall rule to prevent access to a specific service or application on the Internet.

To add an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Security > Block Services.

Hlosk e (% Cancel |

Services Blocking
@ MNever
' Per Schedule
) Always

Service Table
# Service Type Port IP Address

6. Inthe Service Blocking section, specify how the modem router applies outbound rules:

Per Schedule. Use keyword blocking according to a schedule that you set.
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For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
on page 154.

Always. Use keyword blocking continuously.

7. Below the Service Table, click the Add button.

Senice Type User Defined -
Protocol TCP -
Starting Port (1-65535)

Ending Port (1~65535)
Senice Typellser Defined

Filter Services For:
Onily This IP Address: 182 . 168 _ 0

IP Address Range: 192 ./i68 .10
tp 192 . 168 . 0

9 All IP Addresses

8. From the Service Type menu, select service or application to be covered by this rule.

If the service or application does not display in the list, you can add it (see Add an Outbound Firewall
Rule for a Custom Service or Application on page 150).

9. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP addresses:

Only This IP Address. Enter the required address in the fields to apply the rule to a single device
on your LAN.

IP Address Range. Enter the required addresses in the start and end fields to apply the rule to a
range of devices.

» Al IP Addresses. All computers and devices on your LAN are covered by this rule.

By default, the All IP Addresses radio button is selected.

10. Click the Add button.
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The new rule is added to the Service Table on the Block Services page.

Add an Outbound Firewall Rule for a Custom Service or
Application
The modem router lists many default services and applications that you can use in outbound rules. If the

service or application is not predefined, you can specify a custom service or application in an outbound
rule.

To add an outbound firewall rule for a custom service or application:

1. Find out which protocol and port number or range of numbers the service or application uses.

You can usually find this information by contacting the publisher of the service or application or through
online user or news groups.

A

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

w

A login window opens.
4. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

5. Click the OK button.
The BASIC Home page displays.
6. Select ADVANCED > Security > Block Services.

e %= camncer

Services Blocking
@ Mever
' Per Schedule
) Always

Service Table
# Service Type Port IP Address

7. If this is the first time that you add an outbound firewall rule, in the Service Blocking section, specify
how the modem router applies outbound rules:
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Per Schedule. Use keyword blocking according to a schedule that you set.

For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules

on page 154.

Always. Use keyword blocking continuously.

8. Below the Service Table, click the Add button.

m “ : :

Senice Type

Protocol

Starfing Port

Ending Port

Senice Type/User Defined

User Defined -

TCP -
(1~65535)
(1~65535)

Filter Services For:
Only This IP Address:

IP Address Range:

9 Al IP Addresses

192 ./168 .0

182 . 168 .0

to:1192 /168 L0

9. From the Service Type menu, select User Defined.
10. Specify a new outbound rule as described in the following table.

Field

Description

Protocol

Select the protocol (TCP or UDP) that is associated with the service or
application. If you are unsure, select TCP/UDP.

Starting Port

Enter the start port for the service or application.

Ending Port

If the service or application uses a range of ports, enter the end port for
the range. If the service or application uses a single port, repeat the port
number that you entered in the Starting Port field.

Service Type/User Defined

Enter the name of the custom service or application.

11. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP addresses:

Only This IP Address. Enter the required address in the fields to apply the rule to a single device

on your LAN.

IP Address Range. Enter the required addresses in the start and end fields to apply the rule to a

range of devices.

» Al IP Addresses. All computers and devices on your LAN are covered by this rule.
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By default, the All IP Addresses radio button is selected.

12. Click the Add button.

The new rule is added to the Service Table on the Block Services page.

Change an Outbound Firewall Rule

You can change an existing outbound firewall rule.

To change an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are

case-sensitive.
4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Security > Block Services.

Block Services , ——

Services Blocking

) Mever
) Per Schedule
@ Always
Service Table
# Service Type Port IP Address
i@ 1 Age-of-Empire AT624 47624 Any
2 Quakellal 27960 27960 Any

6. In the Service Table, select the radio button for the rule.
7. Click the Edit button.
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The Block Services Setup page displays.

Change the settings.

For more information about the settings, see Add an Outbound Firewall Rule for a Custom Service or
Application on page 150.

Click the Accept button.

Your settings are saved. The changed rule displays in the Service Table on the Block Services page.

Remove an Outbound Firewall Rule

You can remove an outbound firewall rule that you no longer need.

To remove an outbound firewall rule;

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Security > Block Services.
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Block Services , —

Services Blocking

) Mever
) Per Schedule
@ Always
Service Table
¥ Senvice Type Port IP Address
@ 1 Age-of-Empire 4T624 47624 Any
2 Quakellal 27960 27960 Any

In the Service Table, select the radio button for the rule.
Click the Delete button.
The rule is removed from the Service Table.

Set Up a Schedule for Keyword Blocking and Outbound
Firewall Rules

You can set up a schedule that you can apply to keyword blocking (see Use Keywords to Block Internet
Sites on page 143) and outbound firewall rules (see Manage Simple Outbound Firewall Rules for Services
and Applications on page 147).

If applied, the schedule specifies the days and time that keyword blocking, outbound firewall rules, or both
are active.

By default, no schedule is set and you can either enable or disable these features.

To set up a schedule for blocking:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
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The BASIC Home page displays.
5. Select ADVANCED > Security > Schedule.

---------

Days to Block:
[V Every Day

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Time of day to block: (use 24-hour clock)

¥ an Day

Stant Blocking 0  Hour 0 |Minute

End Blocking 24 Hour 0 [Minute

Time Zone

(GMT-08:00) Pacific Time (US & Canada), Tijuana -

[¥! Automatically adjust for daylight savings time

Current Time: Friday, 20 Mar 2015 05:29:14

6. Set up the schedule for blocking:

» Days to Block. Select the check box for each day that you want to block access or specify that
blocking occurs on every day by selecting the Every Day check box.

By default, the Every Day check box is selected.

» Time of Day to Block. Select a start and end time for blocking in 24-hour format or select the All
Day check box for 24-hour blocking.

By default, the All Day check box is selected.

7. From the Time Zone menu, select your time zone.

8. Ifyou live in an area that observes daylight saving time, select the Automatically adjust for daylight
savings time check box.
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Note If the modem router synchronized its internal clock with a time server on the Internet
and you selected the correct time zone, the Current Time field displays the correct
date and time.

Click the Apply button.

Your settings are saved.

Set Up Security Event Email Notifications

The modem router can email you its logs of its activity. The log records router activity and security events
such as attempts to access blocked sites or services.

To set up email notifications:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Security > E-mail.
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[ Turn E-mail Notification On

Send alerts and logs through e-mail

Your Quigoing Mail Server

Send to This E-mail Address

Qutgaing Mail Server Port Number
Secure connection (use SSL)

My mail server requires authentication
User Name

Password

25

Send Alert Immediately
If a DoS attack is detected
If a Port Scan is detected

When someone atempts to visit a blocked site

Send logs according to this schedule

Hourly
Day| Sunday
Time | 1:00 Y am pm

6. Select the Turn Email Notification On

check box.

7. Enter the settings as described in the following table.

Field

Description

Send alerts and logs through e-mail

Your Outgoing Mail Server

Enter the name of your ISP’s outgoing (SMTP) mail server
(such as mail.myISP.com).

You might be able to find this information in the configuration
window of your email program. If you leave this field blank,
log and alert messages are not sent.

Send to This E-mail Address

Enter the email address to which logs and alerts must be
sent.

Secure connection (use SSL)

Select this check box to send messages over a secure
connection.
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Field Description

My mail server requires authentication|If your outgoing email server requires authentication, select
this check box and specify the following settings:

* In the User Name field, enter the user name for the
outgoing email server.

* Inthe Password field, enter the password for the outgoing
email server.

Send Alert Immediately

If a DoS attack is detected Select this check box to enable the modem router to send an
email alert when it detects a denial of service (DoS) attack.

If a Port Scan is detected Select this check box to enable the modem router to send an
email alert when it detects a port scan.

When someone attempts to visit a By default, this check box is selected and email alerts are
blocked site sent immediately when someone attempts to visit a blocked
site.

Send logs according to this schedule

To send logs based on a schedule, select one of the following options from the menu:
*  When log is full. This is the default selection.
* Hourly. Logs are sent every hour.

* Daily. Logs are sent every day. From the Time menu, specify the time of day, and select the am
or pm radio button.

* Weekly. Logs are sent every week. From the Day menu, select the day. From the Time menu,
specify the time of day, and select the am or pm radio button.

If you do not want logs to be sent at all, select None from the menu.

8. Click the Apply button.
Your settings are saved.

Logs are sent automatically. If the log fills before the specified time, it is sent. After the log is sent, it
is cleared from the modem router memory. If the modem router cannot email the log and the log buffer
fills, the modem router overwrites the log.
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Optimize Performance 6

This chapter describes how you can optimize the modem router’s performance and manage the traffic flows
through the modem router.

The chapter contains the following sections:
*  Optimize Traffic with QoS on page 160

* Manage Default and Custom QoS Rules on page 161

e Manage Uplink Bandwidth Control on page 168

* Manage Wi-Fi Multimedia Quality of Service on page 169

e Manage Implicit Beamforming on page 170

» Improve Network Connections with Universal Plug and Play on page 171
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Optimize Traffic with QoS

You can use Quality of Service (Qo0S) to assign different priorities to Internet traffic, applications, and
services. The modem router provides default QoS rules. You can add custom QoS rules and manage
both default and custom QoS rules (see Manage Default and Custom QoS Rules on page 161).

NETGEAR recommends that you enable QoS if you use streaming Internet. However, when QoS assigns
a high priority to streaming video, it also assigns lower priority to the rest of your Internet traffic. That
means that other tasks such as downloading content from the Internet take longer.

To view the default QoS rules with their default priorities and turn on QoS:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Setup > QoS Setup.
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QoS Sethp  — e o T

7| Enable WMM {Wi-Fi multimedia) settings (2.4GHz big/n)
/| Enable WMM (Wi-Fi multimedia) settings (5GHz ain)

"I Turn Internet Access QoS On

POWERED Y

. . . T 4 A
Uplink bandwidth Maximum 512  Kbps OO'(L A

Qos Mode: @ (oS Rules
Add Rules @ QoS by Senvice ) QoS by Device
Applications MSMN Messenger -
Prigrity MNormal -

QoS rules:

[queue 1: Highest [queue 2: High [queue 3: Normal Queue 4 Low
IF Phone ; MEN Messenger = f i
Vonage IP Phone - Yahoo Messenger
Google Talk s Metieeting i o At

(YT atnn
b o b

Edit " Delete , x Delete All

If you did not add any custom rules or change priorities, the QoS rules table displays the default QoS
rules and their default priority queues, from the highest queue (the leftmost column) to the lowest

priority (the rightmost column).

6. Select the Turn Internet Access QoS On check box.
7. Click the Apply button.

Your settings are saved. The modem router assigns traffic priorities according to the QoS rules and
their priority queues.

Manage Default and Custom QoS Rules

You can add custom QoS rules and change and remove both default and custom QoS rules. You can
add QoS rules for services and applications but also for specific devices on your network.

Add a Custom QoS Rule for a Service or Application

If the service or application for which you want to assign a traffic priority is not part of the default QoS
rules, you can add a custom QoS rule.
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To add a custom QoS rule for a service or application:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Setup > QoS Setup.

QoS Setup P

/| Enable WMM (Wi-Fi multimedia) settings (2.4GHz big/n)
/| Enable WMM (Wi-Fi multimedia) settings (5GHz ain)

"I Turn Internet Access QoS On

POWERED Y

: . : = 4 A
Uplink bandwidth Maximum 512  Kbps OOKL A

Qos Mode: @ £oS Rules
Add Rules @ QoS by Service ) QoS by Device
Applications MSM Messenger -
Prigrity Mormal -

QoS rules:

[Queue 1: Highest [queue 2: High [Queue 3: Normal Queue 4: Low
IF Phone _: MSHN Messenger = f i
Vonage IF Phone = Yahoo Messenger
Google Talk s Metieeting i £ i

Elmbon e P Ak
Fl b F] P 4 b * b

Edit - " Delete . ® Delete All

6. Make sure that the QoS By Service radio button is selected.
7. From the Applications menu, select Add a new application.

This selection is located all the way at the bottom of the Applications menu.
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Priority

QoS Policy for

Priority Mormal -
Specified Port Range

Connection Type TCP/UDP ~

Starling Port
Ending Port

(1~65535)
(1~65535)

Specify a new QoS rule for a service or application as described in the following table.

Field

Description

QoS Policy for

Enter a name for the QoS rule.

Priority

Select the priority (Highest, High, Normal, or Low) that must be
assigned to the service or application.

The priority selections correspond to the queue columns in the QoS
rules table.

Specified Port Range

Connection Type

Select the protocol (TCP or UDP) that is associated with the service or
application.

If you are unsure, select TCP/UDP.

Starting Port

Enter the start port number for the service or application.

Ending Port

Enter the end port number for the service or application.

9. On the QoS - Priority Rules page, click the Apply button.

The new QoS rule is added to the QoS rules table.

10. On the QoS Setup page, click the Apply button.

Your settings are saved.

Add a Custom QoS Rule for a Device

You can assign a traffic priority to a device on your network.
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To add a QoS rule for a device:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Setup > QoS Setup.

QoS Setup

e —— T R R
[ x _Cancel IR SKpRIyS

[¥] Enable wmm (Wi-Fi multimedia) settings (2.4GHz big/n)
/| Enable WMM (Wi-Fi multimedia) settings (5GHz ain)

[1 Turn Internet Access QoS On

DCI'W{HDH‘\'/
Uplink bandwidth Maximum 512 Kbps ~ : '
Speedtest OO'(LA
Qos Mode: @ £oS Rules
Add Rules @ 0108 by Senice ©) QoS by Device
Applications MSM Messenger -
Priority MNormal -
+  Add [ “Reset

QoS rules:
[Queue 1: Highest [queue 2: High [Queue 3: Normal Queue 4: Low

IF Phone _:: MSHN Messenger = f i

Vonage IF Phone = Yahoo Messenger

Google Talk i Metieeting i £ i

Blmbion e PR AL

ame

b 4 b

Edit

Delete

6. Select the By Device radio button.

The following figure shows only part of the QoS Setup page.
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Add Rules 7 QoS by Service @ (Q0S by Device
QoS Policy Priority [ Device Name MAC Address

Pri_MAC_DA947C MNormal [ BUSINESSLAPTOP 60:66 66:DA66TC

QoS Policy for

MAC Address

Device Name

Priority MNormal =

+ hdd CReset

7. Either select the radio button for a device in the MAC Device List to complete the fields automatically
(by default, each device is assigned a normal priority) or specify the settings for the device as described

in the following table.

Field

Description

QoS Policy for

Enter a name for the QoS rule.

MAC Address Enter the MAC address for the device.
Device Enter the name of the device.
Priority Select the priority (Highest, High, Normal, or Low) that must be

assigned to the service or application.

The priority selections correspond to the queue columns in the QoS
rules table.

8. Click the Add button.

The new QoS rule is added to the QoS rules table.

9. Click the Apply button.

Your settings are saved.

Change a QoS Rule or Change the Priority for a Rule

You can change an existing default or custom QoS rule. For default rules, you can change only the priority.
For custom rules, you can change the priority and other settings.

To change a QoS rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
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A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Setup > QoS Setup.

QoS Setup P——
| Cancel]

[¥] Enable wmm (Wi-Fi multimedia) settings (2.4GHz big/n)
[7] Enable WMM (Wi-Fi multimedia) settings (5GHz a/n)

[ Turn Internet Access QoS On

POWERED &Y

Uplink bandwidth Maximum 512 Kbps + OO|<|_A

Qos Mode: @ QoS Rules
Add Rules @ QoS by Senvice ) QoS by Device
Applications MSM Messenger -
Priority MNormal -

QoS rules:
[Queue 1: Highest [Queue 2: High [Queue 3: Normal Queue 4. Low
- - -~ -~
IP Phone = MSN Messenger [
Vonage IF Phone = Yahoo Messenger B
Google Talk s MetMeeting i = ut
F] LR 3 Fl I 4 P Fl 3

6. Inthe QoS rules table, click the service, application, or device to select it.
The Edit button becomes available.

7. Click the Edit button.
The QoS Priority Rules page displays.
8. Change the settings.
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For more information about the settings, see Add a Custom QoS Rule for a Service or Application on
page 161 or Add a Custom QoS Rule for a Device on page 163.

On the QoS - Priority Rules page, click the Apply button.

Your settings are saved. If you changed the priority, the QoS rule now displays in a different column
of the QoS rules table on the QoS Setup page.

Remove a QoS Rule

You can remove an individual custom or default QoS rule.

To remove a QoS rule:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > QoS Setup.
The QoS Setup page displays.

In the QoS rules table, click the service, application, or device to select it.
The Delete button becomes available.

Click the Delete button.

The QoS rule is removed.

Remove All QoS Rules

You can permanently remove all custom and default QoS rules.

Warning
If you remove all QoS rules, both the custom and default QoS rules are
permanently removed. The only way to get the default QoS rules back is by
returning the modem router to factory default settings.

Optimize Performance
167



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

To remove all QoS rules:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > QoS Setup.
The QoS Setup page displays.

Warning
If you click the Delete All button, all default and custom QoS rules are
permanently removed.

Click the Delete All button.

All QoS rules are permanently removed.

Manage Uplink Bandwidth Control

Uplink bandwidth control lets you check the maximum uplink bandwidth that your Internet connection can
support and specify the maximum uplink bandwidth.

To specify the maximum uplink bandwidth:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
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The BASIC Home page displays.
5. Select ADVANCED > Setup > QoS Setup.
Qo3 Setup

I o P R

/| Enable WMM (Wi-Fi multimedia) settings (2.4GHz big/n)
/| Enable WMM (Wi-Fi multimedia) settings (5GHz a/n)

"I Turn Internet Access QoS On

POWERED &Y

. : _ = p 4
Uplink bandwidth Maximum 512 Kbps OO'{LA

Qos Mode: @ QoS Rules
Add Rules @ QoS by Service ) QoS by Device
Applications MSMN Messenger -
Priority Mormal -

QoS rules:

[Queue 1: Highest [queue 2: High [queve 3: Normal Cueue 4 Low
IP Phone ; MSN Messenger = f i
Vonage IP Phone - Yahoo Messenger
Google Talk s MetiMeeting i = o~

Elnbonae P AlLE
4 I 4 F L] ¥ L b

Edit . " Delete ’ X Delete All

6. To find out what uplink bandwidth your Internet connection supports, click the Speedtest button.
The speed test checks your uplink bandwidth and the supported uplink bandwidth displays.

7. Inthe Uplink bandwidth Maximum field, enter the maximum uplink bandwidth that you want to
specify.

8. From the associated menu, select Kbps or Mbps.

9. Click the Apply button.

Your settings are saved.

Manage Wi-Fi Multimedia Quality of Service

Wi-Fi Multimedia Quality of Service (WMM QoS) prioritizes WiFi voice and video traffic over the WiFi link.

WMM QoS prioritizes WiFi data packets from different applications based on four access categories:
voice, video, best effort, and background. For an application to receive the benefits of WMM QoS, WMM
must be enabled on both the application and the client running that application. Legacy applications that
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do not support WMM and applications that do not require QoS are assigned to the best effort category,
which receives a lower priority than voice and video.

WMM QoS is automatically enabled for the modem router. In some circumstances you might want to
disable WMM.

To manage WMM QoS:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > QoS Setup.

The QoS Setup page displays.

Disable or enable WMM QoS by doing the following:

» To disable WMM QoS for the 2.4 GHz radio, clear the Enable WMM (Wi-Fi multimedia) settings
(2.4GHz b/g/n) check box.

» To enable WMM QoS for the 2.4 GHz radio, select the Enable WMM (Wi-Fi multimedia) settings
(2.4GHz b/g/n) check box.

By default, WMM QoS is enabled for the 2.4 GHz radio.

» To disable WMM QoS for the 5 GHz radio, clear the Enable WMM (Wi-Fi multimedia) settings
(5GHz a/n) check box.

» To enable WMM QoS for the 5 GHz radio, select the Enable WMM (Wi-Fi multimedia) settings
(5GHz a/n) check box.

By default, WMM QoS is enabled for the 5 GHz radio.

Click the Apply button.

Your settings are saved.

Manage Implicit Beamforming

The modem router supports beamforming to enhance the WiFi range and performance for your WiFi
devices. With beamforming, when you connect to the WiFi network, the modem router actively tracks your
device and directs WiFi to your device, rather than just blasting it out in all directions.

Optimize Performance
170



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

The modem router uses explicit and implicit beamforming to improve WiFi performance. Explicit
beamforming requires the devices to support beamforming. (Typically, 802.11ac devices support
beamforming.) Implicit beamforming means that the modem router supports beamforming even with
devices that do not support beamforming.

The modem router supports implicit beamforming for both 2.4 GHz and 5 GHz devices, which means that
the modem router can provide beamforming benefits of better range and performance for all WiFi devices,
even older 802.11a/b/g/n devices and not just the latest WiFi devices.

Both explicit and implicit beamforming are enabled by default. Explicit beamformaing is always enabled
(you cannot disable it), but you can disable implicit beamforming.

To manage implicit beamforming:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Wireless Settings.
The Advanced Wireless Settings page displays.

6. Scroll to the very bottom of the page.
7. Disable or enable implicit beamforming by doing the following:

» To disable implicit beamforming, clear the Enable Implicit BEAMFORMING check box.
» To enable implicit beamforming, select the Enable Implicit BEAMFORMING check box.

By default, implicit beamforming is enabled.

8. Click the Apply button.

Your settings are saved.

Improve Network Connections with Universal Plug and Play

Universal Plug and Play (UPnP) helps devices such as Internet appliances and computers access the
network and connect to other devices as needed. UPnP devices can automatically discover the services
from other registered UPnP devices on the network.
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If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time communications
such as instant messaging or remote assistance, keep UPnP enabled, which it is by default.

To manage Universal Plug and Play:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > UPnP.
The UPnP page displays.

Select the Turn UPnP On check box.

By default, this check box is selected. You can disable or enable UPnP for automatic device
configuration. If the Turn UPnP On check box is cleared, the modem router does not allow any device
to automatically control router resources, such as port forwarding.

Enter the advertisement period in minutes.

The advertisement period specifies how often the modem router broadcasts its UPnP information.
This value can range from 1 to 1440 minutes. The default period is 30 minutes. Shorter durations
ensure that control points detect current device status at the expense of more network traffic. Longer
durations can compromise the freshness of the device status but can significantly reduce network
traffic.

Enter the advertisement time to live in hops.

The time to live for the advertisement is measured in hops (steps) for each UPnP packet sent. Hops
are the steps a packet takes between routers. The number of hops can range from 1 to 255. The
default value for the advertisement time to live is 4 hops, which should be fine for most home networks.
If you notice that some devices are not being updated or reached correctly, it might be necessary to
increase this value.

Click the Apply button.

The UPnP Portmap Table displays the IP address of each UPnP device that is accessing the modem
router and which ports (internal and external) that device opened. The UPnP Portmap Table also
displays what type of port is open and whether that port is still active for each IP address.

10. To refresh the information in the UPnP Portmap table, click the Refresh button.
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This chapter describes how to access and manage a storage device attached to your modem router.
ReadySHARE lets you access and share a USB storage device connected to the modem router. (If your
storage device uses special drivers, it is not compatible.)

Note You can use the USB port on the modem router only to connect a USB storage device such
as a flash drive or hard drive or a printer. Do not connect a computer, USB modem, CD
drive, or DVD drive to the modem router USB port.

The chapter includes the following sections:
* USB Device Requirements on page 173

e Connect a USB Device to the Modem Router on page 174

* Access a Storage Device Connected to the Modem Router on page 175
e Back Up Windows Computers with ReadySHARE Vault on page 176

* Back Up Mac Computers with Time Machine on page 177

 Manage Access to a Storage Device on page 179

e Enable FTP Access Within Your Network on page 182

» View Network Folders on a Device on page 183

* Add a Network Folder on a Storage Device on page 184

» Change a Network Folder, Including Read and Write Access, on a USB Drive on page 186
e Approve USB Devices on page 188

« Safely Remove a USB Device on page 189

e Use the Modem Router as a Media Server on page 190

Note For more information about ReadySHARE features, visit netgear.com/readyshare.
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USB Device Requirements

The modem router works with most USB-compliant external flash and hard drives. For the most up-to-date
list of USB devices that the modem router supports, visit kbserver.netgear.com/readyshare.

Some USB external hard drives and flash drives require you to load the drivers onto the computer before
the computer can access the USB device. Such USB devices do not work with the modem router.

The modem router supports the following file system types for full read/write access:

FAT16

FAT32

NTFS

NTFS with compression format enabled
Ext2

Ext3

Ext4

The modem router supports the following file system types with read-only access:

HFS
HFS+

Connect a USB Device to the Modem Router

ReadySHARE lets you access and share a USB device that is connected to a USB port on the modem
router. (If your USB device uses special drivers, it is not compatible.) One USB port is on the back panel
of the modem router and another is on the right side panel.

Each side panel provides one USB 3.0 port. The left side panel contains USB port 1. The right side panel
contains USB port 2.
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Figure 8. USB port on the modem router

To connect a USB device:

1. Connect your USB storage device to one of the USB ports on the modem router.
2. If your USB device uses a power supply, connect it.

You must use the power supply when you connect the USB device to the modem router.

When you connect the USB device to the USB port of the modem router, it might take up to two minutes
before the USB device is ready for sharing. By default, the USB device is available to all computers
on your local area network (LAN).

Access a Storage Device Connected to the Modem Router

From a computer or device on the network, you can access a storage device that is connected to the
modem router.

Access the Device from a Windows Computer

To access the device from aWindows computer:

1. Connect a USB storage device to a USB port on the modem router.
2. If your USB device uses a power supply, connect it.

You must use the power supply when you connect the USB device to the modem router.
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When you connect the storage device to the modem router’s port, it might take up to two minutes
before the storage device is ready for sharing. By default, the device is available to all computers on
your local area network (LAN).

3. Launch a web browser from a computer that is connected to the network.
4. In the address field of the browser, enter \\readyshare.

Windows file manager automatically opens and displays the files and folders on the device.

Access the Device from a Mac

To access the device from a Mac:

1. Connect a USB storage device to the USB port on the modem router.
2. If your USB device uses a power supply, connect it.

You must use the power supply when you connect the USB device to the modem router.

When you connect the storage device to the modem router’s port, it might take up to two minutes
before the storage device is ready for sharing. By default, the device is available to all computers on
your local area network (LAN).

On a Mac that is connected to the network, select Go > Connect to Server.
In the Server Address field, enter smb://readyshare.

When prompted, select the Guest radio button.

Click the Connect button.

o gk w

A window opens automatically and displays the files and folders on the device.

Back Up Windows Computers with ReadySHARE Vault

The modem router comes with free backup software for all the Windows computers in your home. Connect
a USB hard disk drive (HDD) to the modem router for centralized, continuous, and automatic backup.

The following operating systems support ReadySHARE Vault:
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Windows 7
Windows 8
Windows 8.1

To back up your Windows computer:

o0k whPRE

7.

Connect a USB HDD to one of the USB ports on the modem router.

Visit www.netgear.com/readyshare.

Scroll down to the A Happy Home Is Filled With Love And Safely Stored Data section.
Click the Download the installer and get started link.

Follow the onscreen instructions to download the utility file.

Launch the ReadySHAREVault-install.exe file and install the utility.

The Dashboard page displays.
Use the dashboard or the Backup tab to set up and run your backup.

Back Up Mac Computers with Time Machine

You can use Time Machine to back up your Mac computers onto a USB hard drive that is connected to
the USB port on the modem router. You can access the connected storage device from your Mac with a
wired or wireless connection to your modem router.

Set Up a USB Hard Drive on a Mac

NETGEAR recommends that you use a new USB HDD or format your old USB disk to do the Time Machine
backup for the first time. Use a blank partition to prevent some issues during backup using Time Machine.
The modem router supports GUID or MBR partitions.

To format your USB hard disk drive and specify partitions:

9

Physically connect the USB hard drive to your Mac.

On your Mac, go to Spotlight (or the magnifying glass) at the top right of the screen and search for
Disk Utility.

To format your USB device, open the Disk Utility, click the Erase tab, and click the Erase button.
Click the Partition tab.

Click the Partition Layout menu and set the number of partitions that you want to use.

Click the Options button.

The Partition options display.

Select the GUID Partition Table or Master Boot Record radio button.
For the format, select Mac OS Extended (Journaled).
Click the OK button.

10. Click the Apply button.

Share a Storage Device
177


www.netgear.com/readyshare

Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Your settings are saved.

Prepare to Back Up a Large Amount of Data

Before you back up a large amount of data with Time Machine, NETGEAR recommends that you follow
this procedure.

To prepare to back up a large amount of data:

1.

2
3.
4

Upgrade the operating system of the Mac computer.

. Verify and repair the backup disk and the local disk.

Verify and repair the permissions on the local disk.
Set Energy Saver by doing the following:

a.

cC.
d.
e.

From the Apple menu, select System Preferences.
The System Preferences screen displays.

From the View menu, select Energy Saver.

The Energy Saver screen displays.

Click the Power Adapter tab.
Select the Wake for Wi-Fi network access check box.
Click the Back arrow to save the changes and exit the screen.

Modify your security settings by doing the following:
a. From the Apple menu, select System Preferences.

The System Preferences screen displays.
From the View menu, select Security.
The Security & Privacy screen displays.

Click the Advanced button at the bottom of the screen.
Leave the Log out after minutes of inactivity check box cleared.
Click the OK button.

Your settings are saved.

Use Time Machine to Back Up onto a Storage Device

You can use Time Machine to back up your Mac computers onto a USB hard disk drive that is connected
to the USB port on the modem router.

To back up your Mac onto a USB hard drive:

1. Prepare your USB device with a compatible format and partitions.
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See Set Up a USB Hard Drive on a Mac on page 177.

If you plan to back up a large amount of data, see Prepare to Back Up a Large Amount of Data on
page 178.

2. If your USB device uses a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router.

When you connect the USB device to the USB port on the modem router, it might take up to two
minutes before the USB device is ready for sharing. By default, the USB device is available to all
computers on your local area network (LAN).

3. On your Mac computer, select Go > Connect to Server.
The Connect to Server screen displays.

4. Type afp://routerlogin.net.

5. When prompted to enter your name and password, select the Guest radio button.
6. Click the Connect button.
A list of connected devices displays. This list includes the name admin when you log in as admin.
7. From the Apple menu, select System Preferences.
8. Open Time Machine.
9. Click the Select Backup Disk button and select your USB device from the list.

10. Click the Use for Backup button.

Note If you do not see the USB partition that you want in the Time Machine disk list, go
to Mac finder and click that USB patrtition. It displays in the Time Machine list.

11. When prompted to enter your name and password, select the Guest radio button and click the Connect
button.

When the setup is complete, the Mac automatically schedules a full backup. You can back up immediately
if you want.

Manage Access to a Storage Device

You can specify the device name, workgroups, and network folders for a storage device connected to the
USB port on the modem router.

To specify the storage device access settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.
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A login window opens.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
Click the Edit button.

USB Storage (Advanced Settings)

Network/Device Name  readyshare
Workgroup  Workgroup

Enable Access Method Link Port
V] Network Connection Weadyshare

¥l HTTP http:ireadyshare. routerlogin.netishares 80
il HTTPS (via internet) https:10.0.0.0/shares 443
= FTP ftp:ireadyshare routerlogin.net'shares 21
[ FTP (via internet) fip://0.0.0.0/shares 21

Available Network Folders

_|Share Name Read Access | Write Access | Folder Name | Volume Name | _Total Space Free Space
@ |Wreadyshare\USB_Storage All -no password  |All-no password  [U\ U Drive 37GB 617.7MB

Create Network Folder x Delete
Safely Remove USB Device

The previous figure shows one USB device attached to the modem router.

To specify a name that is used to access the USB device or devices that are connected to the modem
router, in the Network/Device Name field, enter a name.

By default, the name is readyshare.

To specify a name for the workgroup that the USB device or devices are members of, in the Workgroup
field, enter a name.
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By default, the name is WORKGROUP. The nhame works only in an operating system that supports
NetBIOS, such as Microsoft Windows. If you are using a Windows workgroup rather than a domain,
the workgroup name is displayed here.

Enable or disable access methods by selecting or clearing the corresponding check boxes and
specifying access to the storage device as described in the following table.

Access
Method

Description

Network
Connection

Enabled by default. You can type \\readyshare to access the storage device within
your network. If you change the name in the Network/Device Name field from
readyshare to another name, the link changes accordingly.

HTTP

Enabled by default. You can type http://readyshare.routerlogin.net/shares to
access the USB device within your network and download or upload files. In this
URL, readyshare is the name that is specified in the Network/Device Name field.
If you change the name in the Network/Device Name field from readyshare to
another name, the link changes accordingly.

You can also click the link that is shown in the Link column. The fixed port is number
is 80.

HTTPS (via
internet)

Disabled by default. If you enable this feature, remote users can type https://<public
IP address>/<shares> to access the USB device over the Internet. <public IP
address> is the external or public IP address that is assigned to the modem router
(for example, 1.1.10.102).

This feature supports file uploading only. The default port is number 443, which you
can change.

FTP

Enabled by default. You can type ftp://readyshare.routerlogin.net/shares to access
the USB device within your network and download or upload files. In this URL,
readyshare is the name that is specified in the Network/Device Name field. If you
change the name in the Network/Device Name field from readyshare to another
name, the link changes accordingly.

You can also click the link that is shown in the Link column. The fixed port is number
is 21.

FTP (via
internet)

Disabled by default. If you enable this feature, remote users can type ftp://<public
IP address>/shares to access the USB device over the Internet and download or
upload files. <public IP address> is the external or public IP address that is assigned
to the modem router (for example, 1.1.10.102).

The default port is number 21, which you can change.
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Access Description
Method

If you set up Dynamic DNS (see Set Up and Manage Dynamic DNS on page 193),
you can also type a URL domain name. For example, if your domain name is MyName
and you use the NETGEAR DDNS server, you can type
ftp://IMyName.mynetgear.com to access the USB device over the Internet and
download or upload files.

10. Click the Apply button.

Your settings are saved.

Enable FTP Access Within Your Network

File Transfer Protocol (FTP) lets you download (receive) and upload (send) large files faster.

Note For information about using FTP to access a storage device over the Internet, see
Manage Dynamic DNS and Access Storage Devices Through the Internet on page
193.

To enable FTP access within your network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
6. Click the Edit button.
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USB Storage (Advanced Settings)

Network/Device Name  readyshare
‘Workgroup  Workgroup

Enable Access Method Link Port
] Network Connection Weadyshare
[ HTTP hitp:/ireadyshare routerlogin.netishares 80
[ HTTPS (via internet) https:10.0.0.0/shares 443
= FTP ftp:lireadyshare routerlogin.net’shares 21
[ FTP (via internet) fip:/10.0.0.0/shares 21
Available Network Folders
| Share Name Read Access | Write Access | Folder Name | Volume Name | Total Space  |Free Space
@ |Weadyshare\USB_Storage All - no password  |All - no password  [U)\ U Drive 37GB 617.7 MB
Create Network Folder x Delete
Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.

7. Select the FTP check box.
8. Click the Apply button.

Your settings are saved.

View Network Folders on a Device

You can view or change the network folders on a USB storage device connected to the modem router.

To view network folders:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.

The BASIC Home page displays.
5. Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
6. Click the Edit button.
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USB Storage (Advanced Settings)

Network/Device Name  readyshare
‘Workgroup  Workgroup

Enable Access Method Link Port
] Network Connection Weadyshare -
[ HTTP http:iireadyshare routerlogin.netishares 80
[ HTTPS (via internet) https:10.0.0.0/shares 443
= FTP ftp:lireadyshare routerlogin.net’shares 21
[ FTP (via internet) fip:/10.0.0.0/shares 21
Available Network Folders
] Share Name Read Access | Write Access | Folder Name | Volume Name | Total Space Free Space
@ |Weadyshare\USB_Storage  |All-no password  |All-no password |\ U Drive 37GB 617.7 MB
Create Network Folder x Delete
Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.
7. The Available Networks Folder section shows the following settings:
* Share Name. The default share name is USB_Storage.

* Read Access and Write Access. The permissions and access controls on the network folder.
All-no password (the default) allows all users to access the network folder. The password for
admin is the same one that you use to log in to the modem router.

e Folder Name. Full path of the network folder.
* Volume Name. Volume name from the storage device.
» Total Space and Free Space. The current utilization of the storage device.

Add a Network Folder on a Storage Device

You can add network folders on a storage device connected to the USB port on the modem router.
To add a network folder:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
Click the Edit button.

USB Storage (Advanced Settings)

[ reresn X py ]

Network/Device Name  readyshare
Workgroup  Workgroup

Enable Access Method Link Port
[¥] Network Connection \Wweadyshare -
= HTTP hitp:/readyshare routerlogin.netishares 80
il HTTPS (via internet) hitps:10.0.0.0/shares 443
[ FTP fip.lireadyshare.routerlogin.net/shares 21
| FTP (via internet) fip:110.0.0.0/shares 21
Available Network Folders
Share Name Read Access Write Access | Folder Name Volume Name Total Space Free Space
@ |Wreadyshare\USB_Storage All - no password  |All-no password  [U)\ U Drive 37GB 617.7 MB
Create Network Folder
Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.

In the Available Network Folders table, select a device.
Click the Create Network Folder button.

Create Network Folder

" Apply >

USB Device: U: (U Drive) ~
Share Name:

Read Access: All-no password -
Write Access: All-no password -

Close Window
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If this pop-up window does not display, your web browser might be blocking pop-ups. If it is, change
the browser settings to allow pop-ups.

From the USB Device menu, select the USB drive.

Note NETGEAR recommends that you do not attach more than one drive to each USB
port (for example, through a USB hub).

Click the Browse button and in the Folder field, select the folder.
In the Share Name field, type the name of the share.
From the Read Access menu and the Write Access menu, select the settings that you want.

All-no password (the default) allows all users to access the network folder. The other option is that
only the admin user is allowed access to the network folder. The password for admin is the same one
that you use to log in to the modem router.

Click the Apply button.
The folder is added on the storage device.
Click the Close Window button.

The pop-up window closes.

Change a Network Folder, Including Read and Write Access,
on a USB Drive

You can change network folders on storage devices connected to the USB port on the modem router.

To change a network folder:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
Click the Edit button.
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USB Storage (Advanced Settings)

[ reresn X ney ]

Network/Device Name  readyshare
Workgroup  Workgro i.lp

Enable Access Method Link Port
V] Network Connection \readyshare -
[ HTTP Al I i 80
[ HTTPS (via internet) https:10.0.0.0/shares 443
= FTP fip:ireadyshare routerlogin.net/shares 21
[ FTP (via internet) ftp:/10.0.0.0/shares 21
Available Network Folders
Share Name Read Access Write Access Folder Name Volume Name Total Space Free Space
@ |Weadyshare\USB_Storage  |All-no password  |All-no password |\ U Drive 37GB 617.7 MB
Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.

7. In the Available Network Folders table, select a device.
8. Click the Edit button.

Edit Network Folder

. Apply »

USB Device: Lz (U Drive)

File System: FAT32

Share Name: USB_Storage

Read Access: All- no password -
Write Access: All-no password -

Close Window

9. Change the settings in the fields as needed.

For more information about the settings, see Add a Network Folder on a Storage Device on page 184.
10. Click the Apply button.

Your settings are saved.
11. Click the Close Window button.
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The pop-up window closes.

Approve USB Devices

For more security, you can set up the modem router to share only USB devices that you approve.

To allow only approved USB devices to connect to the modem router and specify which USB devices
are approved:

1.
2.
3.

Make sure that the USB device or devices that you want to approve are attached to the modem router.
Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.

Select ADVANCED > Advanced Setup > USB Settings.
The USB Settings page displays.
Select the No radio button.

By default the Yes radio button is selected. This setting lets you connect and access all your USB
devices.

Click the Apply button.
Your settings are saved.
Click the Approved Devices button.
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USB Drive Approved Devices m -

[”] Allow only approved devices

Approved USB Devices
Volume Name Device Name Capacity

4 Delete

Available USBE Devices
Volume Name Device Name Capacity
) Volume Mame STORE N GO 37GB

In the Available USB Devices table, select the USB device that you want to approve.
Click the Add button.
The USB device is added to the Approved USB Devices table.

To approve another USB device that is already attached to the modem router, repeat Step 10 and
Step 11.

Select the Allow only approved devices check box.

Click the Apply button.

Your settings are saved.

To approve another USB device that is not attached to a USB port, first remove an attached USB device from
a USB port (see Safely Remove a USB Device on page 189), attach the other USB device, and repeat this
procedure.

Safely Remove a USB Device

Before you physically disconnect a USB device from the USB port on the modem router, log in to the
modem router, and take the drive offline.

To remove a USB device safely:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
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The BASIC Home page displays.
5. Select BASIC > ReadySHARE.
The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.

If more than one USB device is attached, the Available Networks Folders table displays the attached
devices, but you cannot select a device on this page.

6. Click the Edit button.

USB Storage (Advanced Settings) T— .
k. " T GEETED

Network/Device Name  readyshare

Workgroup  Workgroup

Enable Access Method Link Port
V] MNetwork Connection Weadyshare
¥l HTTP http:iireadyshare.routerlogin.net/shares 80
il HTTPS (via internet) hitps:110.0.0.0/shares 443
/ FTP ftp:ireadyshare routerlogin.net'shares 21
[ FTP (via internet) fip://0.0.0.0/shares 21
Available Network Folders

] Share Name Read Access | Write Access | Folder Name | Volume Name | Total Space Free Space

@ |Wreadyshare\USB_Storage All -no password  |All-no password  [U)\ U Drive 37GB 617.7MB
Create Network Folder x Delete
Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.

7. Inthe Available Network Folders table, select the device.
8. Click the Safely Remove USB Device button.

The device goes offline and a pop-up window opens.

9. Click the OK button.
10. Physically disconnect the USB device.

Use the Modem Router as a Media Server

The modem router can function as a ReadyDLNA media server, which lets you view movies and photos
on DLNA/UPNP AV-compliant media players, such as Xbox360, Playstation, and NETGEAR media players.

Enable the Media Server

By default, the media server is not enabled.

Share a Storage Device
190



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

To enable the media server and specify its name:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select Advanced > ReadySHARE > Media Server.

] Enable Media Server
Media Server Hame: ReadyDLMNA ‘D7000

Content Scan

@ Automatic (when new files added)
Rescan media files

Select the Enable Media Server check box.
In the Media Server Name field, specify the name of the media server.

By default, the name is ReadyDLNA:D7000. The suffix :D7000 is added to any name that you specify.
That is, if you specify the name as MyMedia, the complete name of the media server becomes
MyMedia:D7000.

Note By default, the Automatic (when new files added) radio button is selected to enable
the modem router to scan for content when new files are added. You cannot clear
this radio button.

Click the Apply button.
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Your settings are saved.

Rescan the Media Files for Content

When new media files are added, the modem router scans for content automatically. You can also rescan
the media files for content.

To rescan the media files for content:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select Advanced > ReadySHARE > Media Server.
The Media Server (Settings) page displays.

6. Click the Rescan media files button.
The modem router rescans for content.
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Manage Dynamic DNS and Access Storage 8
Devices Through the Internet

With Dynamic DNS, you can use the Internet and a personal domain name to access a USB storage device
that is attached to a USB port on the modem router when you are not home. If you know the IP address of

the modem router (and the IP address did not change), you can also access the USB storage device by using
the IP address.

This chapter includes the following sections:
* Set Up and Manage Dynamic DNS on page 193

» Access Storage Devices Through the Internet on page 197

Note For information about how to connect the device and specify its settings, see Share a
Storage Device on page 173.
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Set Up and Manage Dynamic DNS

Internet service providers (ISPs) assign numbers called IP addresses to identify each Internet account.
Most ISPs use dynamically assigned IP addresses. This means that the IP address can change at any
time. You can use the IP address to access your network remotely, but most people do not know what
their IP address is or when this address changes.

To make it easier to connect, you can get a free account with a Dynamic DNS service that lets you use
a domain name to access your home network. To use this account, you must set up the modem router
to use Dynamic DNS. Then the modem router notifies the Dynamic DNS service provider whenever its
IP address changes. When you access your Dynamic DNS account, the service finds the current IP
address of your home network and automatically connects you.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic DNS service
does not work because private addresses are not routed on the Internet.

Your Personal FTP Server

With your customized free URL, you can use FTP to access your network when you are not home through
Dynamic DNS. To set up your FTP server, you must register for a NETGEAR Dynamic DNS (DDNS)
service account and specify the account settings (see Set Up a New Dynamic DNS Account on page 194).

To set up your personal account and use FTP:
1. Get your NETGEAR Dynamic DNS domain name.

For more information, see Set Up a New Dynamic DNS Account on page 194.
2. Make sure that your Internet connection is working.

Your modem router must use a direct Internet connection. It cannot connect to a different router to
access the Internet.

3. Connect a USB storage device to one of the USB ports of the modem router.
4. Setup FTP access on the modem router.

For more information, see Set Up FTP Access Through the Internet on page 198.

5. On a remote computer with Internet access, you can use FTP to access your modem router using
ftp://yourname.mynetgear.com, in which yourname is your specific domain name.

For more information, see Use FTP to Access Storage Devices Through the Internet on page 200.

Set Up a New Dynamic DNS Account

NETGEAR offers you the opportunity to set up and register for a free Dynamic DNS account.
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To set up Dynamic DNS and register for a free NETGEAR account:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Dynamic DNS.

[l use a Dynamic DNS Service

Service Provider NETGEAR
Do you have a NETGEAR DDNS or a Ho-IP DDNS account?
Yes
9 Mo

Please enter the following information for registration.

Host Mame .mynetgearcom
Email
Password (6~32 characters) TIITI L
Register By submitting this form | agree to the terms of service and that | will only create one free account.

Select the Use a Dynamic DNS Service check box.

From the Service Provider menu, select NETGEAR.

Select the No radio button.

In the Host Name field, enter the name that you want to use for your URL.

© 0N
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The host name is sometimes called the domain name. Your free URL includes the host name that
you specify and ends with mynetgear.com. For example, specify MyName.mynetgear.com.

10. In the Email field, enter the email address that you want to use for your account.

11. In the Password (6~32 characters) field, enter the password that you want to use for your account.
12. Click the Register button.

13. Follow the onscreen instructions to register for your NETGEAR Dynamic DNS service.

Specify a DNS Account That You Already Created

If you already created a Dynamic DNS account with NETGEAR, No-IP, or Dyn, you can set up the modem
router to use your account.

To set up Dynamic DNS if you already created an account:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Advanced Settings > Dynamic DNS.
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["use a Dynamic DNS Service

Service Provider NETGEAR
Do you have a NETGEAR DDNS or a No-IP DDNS account?
Yes
@' Mo

Please enter the following information for registration,

Host Mame .mynetgear.com
Email
Password (6~32 characters) Il
Register By submitting this form | agree to the terms of service and that | will only create one free account,

6. Select the Use a Dynamic DNS Service check box.
From the Service Provider menu, select your provider.
8. Select the Yes radio button.

N

The page adjusts.

9. Inthe Host Name field, enter the host name (sometimes called the domain hame) for your account.
10. Depending on the type of account, specify your user name or email address:

For a No-IP or Dyn account, in the User Name field, enter the user name for your account.
For a NETGEAR account, in the Email field, enter the email address for your account.

11. In the Password (6~32 characters) field, enter the password for your DDNS account.
12. Click the Apply button.

Your settings are saved.

13. To verify that your Dynamic DNS service is enabled in the modem router, click the Show Status
button.

A message displays the Dynamic DNS status.

Access Storage Devices Through the Internet

If you connect a USB storage device to the modem router, you can access the USB device through the
Internet when you are not home. After you gain access, you can use FTP to share files on the USB device.

Manage Dynamic DNS and Access Storage Devices Through the Internet
197



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

To access devices from a remote computer:

1. Launch a web browser on a computer that is not on your home network.
2. Connect to your modem router on your home network:

To connect with Dynamic DNS, type the DNS name.
For more information about Dynamic DNS, see Set Up and Manage Dynamic DNS on page 193.
To connect without Dynamic DNS, type the modem router’s Internet port IP address.

You can view the modem router’s Internet IP address on the BASIC Home page.
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Set Up FTP Access Through the Internet

If you attach a storage device to the modem router, you can access the storage device from your network
(see Enable FTP Access Within Your Network on page 182). You can also set up FTP access through the
Internet so that you can access the storage device from outside your local network, for example, when
you are not at home.

To set up FTP access through the Internet:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.

The BASIC Home page displays.
5. Select BASIC > ReadySHARE.

The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
6. Click the Edit button.

USB Storage (Advanced Settings) T— .
ik ” T TS

Network/Device Name  readyshare

Workgroup  Workgroup

Enable Access Method Link Port
V] MNetwork Connection Weadyshare
¥l HTTP http:iireadyshare routerlogin.net/shares 80
il HTTPS (via internet) https:10.0.0.0/shares 443
/A FTP ftp:ireadyshare routerlogin.net'shares 21
[ FTP (via internet) fip://0.0.0.0/shares 21
Available Network Folders
] Share Name Read Access | Write Access | Folder Name | Volume Name | Total Space Free Space
@ |Wreadyshare\USB_Storage All -no password  |All-no password  [U)\ U Drive 37GB 617.7MB
Create Network Folder x Delete
Safely Remove USB Device
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The previous figure shows a USB device attached to the modem router.

7. Select the FTP (via internet) check box.
8. Click the Apply button.

Your settings are saved.

9. To limit access to the admin user, do the following:
a. In the Available Network Folders list, select a device.

If only one device is connected, it is automatically selected.

b. Click the Edit button.

USB Device: U: (U Drive)

File System: FAT32

Folder: Ui
Share Name: USB_Storage

Read Access: All- no password -

Write Access: All- no password -

Close Window

c. Inthe Read Access menu, select admin.
The default setting is All - no password.

d. Inthe Write Access menu, select admin.
The default setting is All - no password.

e. Click the Apply button.
Your settings are saved.
f. Click the Close Window button.

The pop-up window closes.

Use FTP to Access Storage Devices Through the Internet

If you attached a storage device to the modem router, before you can access the storage device through
the Internet with FTP, you must first set it up (see Set Up FTP Access Through the Internet on page 198).

To access a USB device with FTP from a remote computer to download or upload a file:

1. Take one of the following actions:
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To download a file from a storage device connected to the modem router, launch a web browser.

To upload a file to a storage device connected to the modem router, launch an FTP client such as
Filezilla.

2. Type ftp:// and the Internet port IP address in the address field of the browser.
For example, if your IP address is 10.1.65.4, type ftp://10.1.65.4.
If you are using Dynamic DNS, type the DNS name.

For example, type ftp://MyName.mynetgear.com.

3. When prompted, log in:

To log in as admin, in the user name field, enter admin and in the password field, enter the same
password that you use to log in to the modem router.

To log in as guest, in the user name field, enter guest.

The guest user name does not need a password.

The files and folders that your account can access on the USB device display. For example, you might
see share/partitionl/directoryl.

4. Navigate to a location on the USB device.
5. Download or upload the file.
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Share a USB Printer 9

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port on your modem
router. You can share this USB printer among the Windows and Mac computers on your network.

The chapter includes the following sections:
» Install the Printer Driver and Cable the Printer on page 203

* Download the ReadySHARE Printer Utility on page 203

e Install the ReadySHARE Printer Utility on page 203

e Use the Shared Printer on page 205

* View or Change the Status of a Printer on page 206

» Use the Scan Feature of a Multifunction USB Printer on page 206
 Change NETGEAR USB Control Center Settings on page 208
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Install the Printer Driver and Cable the Printer

Some USB printer manufacturers (for example, HP and Lexmark) request that you do not connect the
USB cable until the installation software prompts you to do so.

To install the driver and cable the printer:

1. Oneach computer on your network that shares the USB printer, install the driver software for the USB
printer.

If the printer driver is not installed, contact the printer manufacturer.

2. Use a USB printer cable to connect the USB printer to one of the USB ports on the modem router.

Each side panel provides one USB 3.0 port. The left side panel contains USB port 1. The right side
panel contains USB port 2.

Download the ReadySHARE Printer Utility

The utility works on Windows computers, Mac computers, smartphones, and tablets.

To download the ReadySHARE Printer utility:

1. Visit netgear.com/readyshare.
2. Scroll down to the Print From the Comfort of Your Home Network section at the bottom of the page.
3. Click one of the following links:

Download PC installer and get started. This is the utility for Windows computers.
Download Mac installer and get started. This is the utility for MAC computers.
Download the genie App and get started. This is the utility for smartphones and tablets.

4. Follow the onscreen instructions to download the ReadySHARE Printer utility setup file.

Install the ReadySHARE Printer Utility

You must install the ReadySHARE Printer utility on each computer that will share the printer. After you
install it, the utility displays as NETGEAR USB Control Center on your computer.

To install the utility:

1. If necessary, unzip the ReadySHARE Printer utility setup file.
2. Double-click the ReadySHARE Printer utility setup file that you downloaded.
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——

Welcome to the InstallShield Wizard for
NETGEAR USB Control Center

The InstallShield(R) Wizard will install NETGEAR USB Control
Center on your computer. To continue, click Next.

WARNING: This program is protected by copyright law and
international treaties.

3. Follow the wizard instructions to install NETGEAR USB Control Center.

After the InstallShield Wizard completes the installation, the NETGEAR USB Control Center prompts
you to select a language.

4. Select a language from the list and click the OK button.

System Tools About

Device: Simbus
Waiting B Co

B WP - Canon - MP180
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Some firewall software, such as Comodo, blocks NETGEAR USB Control Center from accessing the
USB printer. If you do not see the USB printer displayed onscreen, you can disable the firewall
temporarily to allow the utility to work.

Select the printer and click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only the computer that you
are using can use this printer.

Click the Disconnect button.
The status changes to Available. Now all computers on the network can use the printer.
To exit the utility, select System > Exit.

Use the Shared Printer

For each computer, after you click the Connect and Disconnect buttons once, the utility automatically
manages the printing queue. By default, the utility starts automatically whenever you log on to Windows
and runs in the background.

Manually Connect and Print

For each computer, after you click the Connect and Disconnect buttons once, the utility automatically
manages the printing queue. By default, the utility starts automatically whenever you log on to Windows
and runs in the background.

To manually connect and print:

1.

3.
4.

Click the NETGEAR USB Control Center icon =.
The main screen displays.
Click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only the computer that you
are using can use this printer.

Use the print feature in your application to print your document.
To release the printer so that all computers on the network can use it, click the Disconnect button.

Print and Release the Printer

To print and release the printer to any computer on the network:

1.

2.

To print your document, use the print feature in your application.

The NETGEAR USB Control Center automatically connects your computer to the USB printer and
prints the document. If another computer is already connected to the printer, your print job goes into
a queue to wait to be printed.

If your document does not print, use the NETGEAR USB Control Center to check the status.
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See View or Change the Status of a Printer on page 206.

View or Change the Status of a Printer

To view or change the status:
1. Click the NETGEAR USB Control Center icon &.

{8} NETGEAR USB Control Center
Svstern  Tools About

‘ Device Status
® sudio - - Logitech Speaker Manually Connected by netgear-8dc0086
2 :MFP - HP - Photosmart C5200 series Available

The Status column shows the status for each device:

» Available. No print jobs are in progress. You can use the USB printer from any computer in the
network.

* Connected. Your computer is connected to the printer and will be released when your print job is
done.

* Manually Connected by. Only the connected computer can use the printer.

e Waiting to Connect. Your computer is not connected to the shared printer yet.

To print from your computer when the status shows Manually connected by another computer, click
the Disconnect button.

The printer is released from the connection and the status changes to Available.

3. To print from your computer when the status shows Waiting to Connect, do the following:

a. Click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only your computer can
use the printer.

b. To allow the printer to be shared, click the Disconnect button.

The printer is released from the connection and the status changes to Available.

Use the Scan Feature of a Multifunction USB Printer

If your USB printer supports scanning, you can also use the USB printer for scanning. For example, the
USB printer displayed in the Windows Printers and Faxes window is ready for print jobs.
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"% Printers and Faxes

File Edt Wiew Favorites Tools Help

Qrm._k \‘) lﬁ' psaarm lL_ Folders '

Address |92 Printers and Faxes

- @ Photosmart C5200 series
Printer Tasks ﬂ
=

0
L Paused
Add a printer =

&5 Set up faxing

See Also

2] Traubleshect printing
) Get help with printing

Other Places

e

To use the scan feature of a multifunction USB printer:
1. Click the NETGEAR USB Control Center icon m.

it NETGEAR USB Control Center

Svstem  Tools About

Device Status
@ Audio - - Logitech Speaker Manually Connected by netgear-8dc0086
{2:MFP - HP - Photosmart C5200) series Available

2. Make sure that the printer status shows as Available.
3. Click the Network Scanner button.

@IH’G‘EAR USB Control Center
System Tools About

| Device Status
EAMFP - Canon - MP180

Awailable

Conngct Disconnact Metwork Scanner
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The scanner screen displays so that you can use the USB printer for scanning.

Change NETGEAR USB Control Center Settings

You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows.
You can also change the language and specify the time-out to release the printer connection.

To turn off automatic NETGEAR USB Control Center startup:
1. Click the NETGEAR USB Control Center icon m.

1t NETGEAR USB Control Center
System  Tools About

Device Status
@ Audio- - Logitech Speaker Manually Connected by netgear-8dc0086
2:MFP - HP - Photosmart C5200 series Ayvailable

2. Select Tools > Configuration.

£ Control Center - Configuration @

Basic

Automatically execute when logging on Windows

Timeout
E minute (1-600)

~Language

Engish |
| German

| Swedish

| French

| Dutch

| Italian

|

(0[5>

<

Note: Language setting will take effect on next execution.

I OK ] [ Cancel ]

3. Clear the Automatically execute when logging on Windows check box.
4. Click the OK button.

Your settings are saved.
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Change the NETGEAR USB Control Center Language

To change the language:

1. Click the NETGEAR USB Control Center icon m.
The main page displays.

2. Select Tools > Configuration.
The Control Center - Configuration page displays.

3. From the Language menu, select a language.
4. Click the OK button.

The next time NETGEAR USB Control Center starts, the language changes.

Specify the Time-out

To specify the time-out:

1. Click the NETGEAR USB Control Center icon m.
The main page displays.

2. Select Tools > Configuration.
The Control Center - Configuration page displays.

3. Inthe Timeout field, type the number of minutes.

The time-out is the number of minutes that a computer holds its connection to the printer when the
connection is not being used.

4. Click the OK button.

Your settings are saved.
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Manage the WAN and LAN Network Settings 10

This chapter describes how you can manage the WAN and LAN network settings of the modem router.
The chapter includes the following sections:

* Change the Physical WAN Connection Preference on page 210

* Enable and Configure a VLAN on page 212

* Enable Bridge Mode for IPTV Devices on page 215

* Manage the WAN Security Settings on page 216

e Set Up a Default DMZ Server on page 217

* Manage NAT Filtering on page 218

* Manage the SIP Application-Level Gateway on page 219

* Manage the Modem Router’s LAN IP Address Settings on page 219
* Manage the Router Information Protocol Settings on page 221
 Manage Reserved LAN IP Addresses on page 222

* Change the Modem Router’'s Device Name on page 225

* Manage the DHCP Server Address Pool on page 225

* Disable the Built-In DHCP Server on page 227

* Set Up and Manage Custom Static Routes on page 228
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Change the Physical WAN Connection Preference

The modem router can autodetect the type of WAN connection. However, you can also set the WAN
connection preference manually to either the DSL port or the Ethernet WAN port.

Note The modem router does not support load balancing over DSL and Ethernet WAN
interfaces. Only one WAN interface (either the DLS port or the Ethernet WAN port)
can be active at any time.

To change the WAN connection preference:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Setup >WAN Setup.
The WAN Setup page displays.

6. From the WAN Preference menu, select one of the following options:

Auto-Detect. The modem router automatically detects whether the WAN connection is DSL over
the DLS port or Ethernet over the Internet port. Auto-Detect is the default setting.

Must use DSL WAN. The modem router uses the DSL port for a DSL WAN connection. The Internet
port is shut down.

Must use Ethernet WAN. The modem router uses the Internet port for an Ethernet WAN connection.
The DSL port is shut down.

7. Click the Apply button.

Your settings are saved.
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Enable and Configure a VLAN

A network of computers and devices can behave as if they were connected to the same network even
though they might actually be physically on different segments of a LAN. Virtual LANs (VLANS) are
configured through software rather than hardware, which makes them very flexible.

If you enable a VLAN and if the network devices (hubs and switches) on your LAN support the VLAN
(802.1Q) standard, the VLAN ID for the wireless access point is associated with all traffic coming from
the modem router.

If you are subscribed to IPTV service, the modem router might require VLAN tags to distinguish between
the Internet traffic and the IPTV traffic.

For information about enabling and configuring the virtual IPTV interface, see one of the following sections:
* Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73

Note If your ISP provides directions for how to set up VLANS for IPTV and Internet service,
follow those directions.

To enable and configure a VLAN for the virtual Internet interface and another VLAN for the virtual
IPTV interface:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select BASIC > Internet.
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nternet Setup

Select Country USA
Select Internet Service Provider ATAET -
Transfer Mode VDSL(PTM) ~
DSL Mode VDSL2 -
Internet -

[¥/ Enable This Interface

[Cluse vianD 10

Priority (0~ 7) 0

6. Configure a VLAN for the virtual Internet interface:

a. Make sure that Internet is selected from the menu above the Enable This Interface check box
and that the Enable This Interface check box is selected for the virtual Internet interface (it is by
default).

b. Select the Use VLANID check box.

c. Enter a VLAN ID that applies to the virtual Internet interface.

The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is 10.

d. To specify a priority for the VLAN, in the Priority (0 ~ 7) field, enter a value from 0 to 7.
e. Click the Apply button.
Your settings are saved for the virtual Internet interface.

7. From the menu above the Enable This Interface check box, select IPTV.
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[ cancel R est

Select Country LISA
Select Internet Service Provider Dther -

Transfer Mode VDSLIPTM) -
DSL Mode VDSL2 -
IPTV

[¥| Enable This Interface
[T] Use VLANID 0
Priority (0 ~ 7)

[ Bridge Mode
(f select Bridge Mode, the LAN4 port will be configured as IPTV port, you can
select max.3 LAN ports for 3 IPTV devices to connectto . LANT is reserved for
wired internet)

Enable IPTV on LAM4
__|Enable IPTV on LANZ
"l Enable IPTV on LAN2

The previous figure shows only the top of the Internet Setup page.

Configure a VLAN for the virtual IPTV interface:

a. Make sure that the Enable This Interface check box is selected for the virtual IPTV interface.
If you already enabled and configured the virtual IPTV interface, the check box is selected.

b. Select the Use VLANID check box.

c. Enter a VLAN ID that applies to the virtual IPTV interface.
The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is 0.

d. To specify a priority for the VLAN, in the Priority (0 ~ 7) field, enter a value from 0 to 7.

e. Click the Apply button.
Your settings are saved for the virtual IPTV interface.

Note Forinformation about enabling bridge mode for the IPTV virtual interface, see Enable
Bridge Mode for IPTV Devices on page 215.
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Enable Bridge Mode for IPTV Devices

Some devices, such as an IPTV, cannot function behind the modem router’s network address translation
(NAT) service or firewall. Based on what your Internet service provider (ISP) requires, for the device to
connect to the ISP’s network directly, you can enable the bridge between the device and the modem
router’s IPTV virtual interface. In bridge mode, by default, the LAN 4 port on the back panel of the modem
router is bound to the IPTV virtual interface.

In addition to connecting an IPTV device to the LAN 4 port, you can connect an IPTV device to the LAN
3 port and another one to the LAN 2 port. That is, the modem routercan support up to three IPTV devices.
The LAN 1 port is reserved for a wired Internet connection. Do not connect an IPTV device to the LAN 1
port.

For information about enabling and configuring the virtual IPTV interface, see one of the following sections:
* Manually Set Up an ADSL Internet Connection on page 51

e Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73

To enable bridge mode for one or more IPTV devices:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.

The BASIC Home page displays.

5. Select BASIC > Internet.
The Internet Setup page displays.
6. From the menu above the Enable This Interface check box, select IPTV.
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Select Country LISA
Select Internet Service Provider Dther -

Transfer Mode VDSL(PTM) ~

DSL Mode VDSL2 -
IPTV

[¥| Enable This Interface
[ use vLaNID
Priority (0 ~ 7)

[ ]

| Bridge Mode
(f select Bridge Mode, the LAN4 port will be configured as IPTV port, you can
select max.3 LAN ports for 3 IPTV devices to connectto . LANT is reserved for
wired internet)

Enable IPTV on LAM4
__|Enable IPTV on LAN3
"l Enable IPTV on LAN2

7. Make sure that the Enable This Interface check box is selected for the virtual IPTV interface.
If you already enabled and configured the virtual IPTV interface, the check box is selected.

8. Select the Bridge Mode check box.

By default, the LAN 4 port is bound to the virtual IPTV interface and the Enable IPTV on LAN4 check
box is automatically selected.

9. Ifyou also connected an IPTV device to the LAN 3 port, select the Enable IPTV on LANS3 check box.
10. If you also connected an IPTV device to the LAN 2 port, select the Enable IPTV on LAN2 check box.
11. Click the Apply button.

Your settings are saved.

Manage the WAN Security Settings

The WAN security settings include port scan protection and denial of service (DoS) protection, which can
protect your LAN against attacks such as Syn flood, Smurf Attack, Ping of Death, and many others. By
default, DoS protection is enabled and a port scan is rejected.

You can also enable the modem router to respond to a ping to its WAN (Internet) port. This feature allows
your modem router to be discovered. Enable this feature only as a diagnostic tool or if a specific reason
exists.
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To change the default WAN security settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Setup >WAN Setup.
The WAN Setup page displays.

6. To enable a port scan and disable DoS protection, select the Disable Port Scan and DoS Protection
check box.

7. To enable the modem router to respond to a ping, select the Respond to Ping on Internet Port check
box.

8. Click the Apply button.

Your settings are saved.

Set Up a Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and videoconferencing
applications that are incompatible with Network Address Translation (NAT). The modem router is
programmed to recognize some of these applications and to work correctly with them, but other applications
might not function well. In some cases, one local computer can run the application correctly if the IP
address for that computer is entered as the default DMZ server.

Warning
DMZ servers pose a security risk. A computer designated as the default DMZ
server loses much of the protection of the firewall and is exposed to exploits
from the Internet. If compromised, the DMZ server computer can be used to
attack other computers on your network.

The modem router usually detects and discards incoming traffic from the Internet that is not a response
to one of your local computers or a service or application for which you set up a port forwarding or port
triggering rule. Instead of discarding this traffic, you can direct the modem router to forward the traffic to
one computer on your network. This computer is called the default DMZ server.
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To set up a default DMZ server:

1.
2.

o

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

The BASIC Home page displays.
Select ADVANCED > Setup >WAN Setup.
The WAN Setup page displays.

Select the Default DMZ Server check box.
Enter the IP address of the server.
Click the Apply button.

Your settings are saved.

Manage NAT Filtering

Network Address Translation (NAT) determines how the modem router processes inbound traffic. Secured
NAT protects computers on the LAN from attacks from the Internet but might prevent some Internet games,
point-to-point applications, or multimedia applications from working. Open NAT provides a much less
secured firewall but allows almost all Internet applications to work. Secured NAT is the default setting.

To change the default NAT filtering settings:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup >WAN Setup.
The WAN Setup page displays.

Select a NAT Filtering radio button:
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Secured. Provides a secured firewall to protect the computers on the LAN from attacks from the
Internet but might prevent some Internet games, point-to-point applications, or multimedia
applications from functioning. By default, the Secured radio button is selected.

Open. Provides a much less secured firewall but allows almost all Internet applications to function.

Click the Apply button.

Your settings are saved.

Manage the SIP Application-Level Gateway

The application-level gateway (ALG) for the Session Initiation Protocol (SIP) is enabled by default for
enhanced address and port translation. However, some types of VolP and video traffic might not work
well when the SIP ALG is enabled. For this reason, the modem router provides the option to disable the
SIP ALG.

To change the default SIP ALG setting:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup >WAN Setup.

The WAN Setup page displays.

To disable the SIP ALG, select the Disable SIP ALG check box.
The SIP ALG is enabled by default.

Click the Apply button.

Your settings are saved.

Manage the Modem Router’'s LAN IP Address Settings

The modem router is preconfigured to use private IP addresses on the LAN side and to act as a DHCP
server. The modem router’s default LAN IP configuration is as follows:
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LAN IP address. 192.168.0.1 (this is the same as www.routerlogin.net and www.routerlogin.com)
Subnet mask. 255.255.255.0

These addresses are part of the designated private address range for use in private networks and are
suitable for most applications. The IP address and subnet mask identify which addresses are local to a
specific device and which must be reached through a gateway or modem router. You might want to change
these settings if you need a specific IP subnet that one or more devices on the network use, or if competing
subnets use the same IP scheme.

To change the LAN IP address settings:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Setup > LAN Setup.
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LAN Setup

Device Name

LAN TCPAP Setup
IF Address 192 |./1e8 . 0O i 3

IP Subnet Mask 2595 |.|2595 [.[255 |.i0
RIP Direction Both -
RIP Version Disable

4

[¥!Use Router as DHCP Server

Single/Start IP Address 192 |.[168 [.|O ol
Finish IP Address 192 |.|1e8 |.|D . 254
Address Reservation

# IP Address MAC Address

6. Inthe IP Address field, enter the LAN IP address for the modem router.
7. Inthe IP Subnet Mask, enter the LAN subnet mask for the modem router.
8. Click the Apply button.

Your settings are saved.

If you changed the LAN IP address of the modem router, you are disconnected when the changes
take effect.

To reconnect, close your browser, relaunch it, and log in to the modem router at its new LAN IP
address.

Manage the Router Information Protocol Settings

Router Information Protocol (RIP) lets the modem router exchange routing information with other routers.
By default, RIP is enabled in both directions (in and out) without a particular RIP version.

To manage the RIP settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.
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A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

6. From the RIP Direction menu, select an RIP direction:

Both. The modem router broadcasts its routing table periodically and incorporates information that
it receives. This is the default setting.

Out Only. The modem router broadcasts its routing table periodically but does not incorporate the
RIP information that it receives.

In Only. The modem router incorporates the RIP information that it receives but does not broadcast
its routing table.

7. From the RIP Version menu, select an RIP version:

Disabled. The RIP version is disabled. This is the default setting.

RIP-1. This format is universally supported. It is adequate for most networks, unless you are using
an unusual network setup.

RIP-2. This format carries more information. Both RIP-2B and RIP-2M send the routing data in
RIP-2 format. RIP-2B uses subnet broadcasting. RIP-2M uses multicasting.

8. Click the Apply button.

Your settings are saved.

Manage Reserved LAN IP Addresses

When you specify a reserved IP address for a computer on the LAN, that computer always receives the
same IP address each time it accesses the modem router’s DHCP server.

Reserve a LAN IP address

You can assign a reserved IP address to a computer or server that requires permanent IP settings.
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To reserve an IP address:

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

In the Address Reservation section, click the Add button.

Either select a device from the Address Reservation Table table by selecting the corresponding radio
button or specify the reserved IP address information:

In the IP Address field, enter the IP address to assign to the computer or device.
Choose an IP address from the modem router’s LAN subnet, such as 192.168.0.x.
In the MAC Address field, enter the MAC address of the computer or device.

In the Device Name field, enter the name of the computer or device.

Click the Add button.
The reserved address is entered into the table on the LAN Setup page.

The reserved address is not assigned until the next time the computer or device contacts the modem
router's DHCP server. Reboot the computer or device, or access its IP configuration and force a DHCP
release and renew.

Change a Reserved IP Address

You can change a reserved IP address entry.

To change a reserved IP address entry:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.
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A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

In the Address Reservation section, select the radio button next to the reserved address.
Click the Edit button.

The Edit page displays.

Change the settings.
Click the Apply button.

Your settings are saved.

Remove a Reserved IP Address Entry

You can remove a reserved IP address entry.

To remove areserved IP address entry:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

In the Address Reservation section, select the radio button next to the reserved address.
Click the Delete button.
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The address entry is removed.

Change the Modem Router’s Device Name

The modem router’s device name is D6100. This device name displays in a file manager when you browse
your network.

To change the modem router’s device name:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

In the Device Name field, enter a new name.
Click the Apply button.

Your settings are saved.

Manage the DHCP Server Address Pool

By default, the modem router acts as a Dynamic Host Configuration Protocol (DHCP) server. The modem
router assigns IP, DNS server, and default gateway addresses to all computers that are connected to its
LAN and WiFi network. The assigned default gateway address is the LAN address of the modem router.

These addresses must be part of the same IP address subnet as the modem router’s LAN IP address.
The default DHCP address pool is 192.168.0.2—-192.168.0.254.

The modem router delivers the following parameters to any LAN device that requests DHCP:
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* An IP address from the range that you define

* Subnet mask

* Gateway IP address (the modem router's LAN IP address)

* DNS server IP address (the modem router's LAN IP address)

To specify the pool of IP addresses that the modem router assigns:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.

A e (x cancel N Apply > |

Device Hame D7000

LAN TCPIP Setup

IP Address 192 . 168 . O s |

IP Subnet Mask 255 |.|2585 .255 . 0O
RIP Direction Both -
RIP Version Disable ~

[¥] use Router as DHCP Server

Single/Start IP Address 192 |[.|168 [.|0O . 2
Finish IP Address 192 (.|1&68 |.|0 . 254
Address Reservation

# IP Address Device Name MAC Address

T G

6. Make sure that the Use Router as DHCP Server check box is selected.
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This check box is selected by default.

7. Specify the range of IP addresses that the modem router assigns:
* Inthe Single/Start IP Address field, enter the lowest number in the range.

This IP address must be in the same subnet as the modem router. By default, the starting IP
address is 192.168.0.2.

* Inthe Finish IP Address field, enter the number at the end of the range of IP addresses.

This IP address must be in the same subnet as the modem router. By default, the ending IP address
is 192.168.0.254.

8. Click the Apply button.

Your settings are saved.

Disable the Built-In DHCP Server

By default, the modem router functions as a DHCP server. The modem router assigns IP, DNS server,
and default gateway addresses to all devices connected to the LAN. The assigned default gateway address
is the LAN address of the modem router.

You can use another device on your network as the DHCP server or specify the network settings of all
your computers.

Note If you disable the DHCP server and no other DHCP server is available on your
network, you must set your computer IP addresses manually so that they can access
the modem router.

To disable the built-in DHCP server:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.
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The LAN Setup page displays.

6. Clear the Use Router as DHCP Server check box.
7. Click the Apply button.

Your settings are saved.

Set Up and Manage Custom Static Routes

Static routes provide detailed routing information to your modem router. Typically, you do not need to add
static routes. You must configure static routes only for unusual cases such as when you use multiple
routers or multiple IP subnets on your network.

As an example of when a static route is needed, consider the following case:
* Your primary Internet access is through an ADSL modem to an ISP.

* You use an ISDN router on your home network for connecting to the company where you are employed.
This router’s address on your LAN is 192.168.0.100.

* Your company’s network address is 134.177.0.0.

When you first configured your modem router, two implicit static routes were created. A default route was
created with your ISP as the gateway and a second static route was created to your local network for all
192.168.0.x addresses. With this configuration, if you attempt to access a device on the 134.177.0.0

network, your modem router forwards your request to the ISP. The ISP forwards your request to the
company where you are employed, and the request is likely to be denied by the company’s firewall.

In this case, you must define a static route, instructing your modem router that 134.177.0.0 is accessed
through the ISDN modem router at 192.168.0.100. Here is an example:

e Through the destination IP address and IP subnet mask, specify that this static route applies to all
134.177.x.x addresses.

e Through the gateway IP address, specify that all traffic for these addresses is forwarded to the ISDN
modem router at 192.168.0.100.

A metric value of 1 works fine because the ISDN modem router is on the LAN.

Set Up a Static Route

You can add a static route to a destination IP address and specify the subnet mask, gateway IP address,
and metric.

To set up a static route:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.

Click the Add button.

Route Mame

" Private

V] active

Destination IP Address
IP Subnet Mask
Gateway IP Address

Metric

To make the route private, select the Private check box.
A private static route is not reported in RIP.

To prevent the route from becoming active after you click the Apply button, clear the Active check
box.

In some situations, you might want to set up a static route but keep it disabled until a later time. By
default, the Active check box is selected and a route becomes active after you click the Apply button.

Enter the settings as described in the following table.

Field Description

Destination IP Address Enter the IP address for the final destination of the route.

IP Subnet Mask Enter the IP subnet mask for the final destination of the route.

If the destination is a single host, enter 255.255.255.255.
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Field Description

Gateway IP Address Enter the IP address of the gateway.

The IP address of the gateway must be on the same LAN segment as
the modem router.

Metric Enter a number from 1 through 15.

This value represents the number of routers between your network and
the destination. Usually, a setting of 2 or 3 works, but if this is a direct
connection, set it to 1.

10. Click the Apply button.

Your settings are saved. The static route is added to the table on the Static Routes page.

Change a Static Route

You can change an existing static route.

To change a static route:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.

6. In the Static Routes table, select the radio button to the left of the route.
7. Click the Edit button.

The page adjusts.

8. Change the settings for the route.
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For more information about the settings, see Set Up a Static Route on page 228.
Click the Apply button.

The route is updated in the table on the Static Routes page.

Remove a Static Route

You can remove an existing static route that you no longer need.

To remove a static route:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.

In the Static Routes table, select the radio button to the left of the route.
Click the Delete button.

The route is removed from the table on the Static Routes page.
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Manage the Modem Router and Monitor the 11
Traffic

This chapter describes how you can manage the settings for administering and maintaining your modem
router and monitor the network.

The chapter includes the following sections:

Update the Firmware of the Modem Router on page 233

Manage the Configuration File of the Modem Router on page 235
Recover the admin Password on page 237

Return the Modem Router to Its Factory Default Settings on page 238
View the Status and Statistics of the Modem Router on page 240
View Devices Currently on the Network on page 251

Manage the Activity Log and Syslog on page 252

Monitor and Meter Internet Traffic on page 256

Manage the Modem Router Remotely on page 264

Configure the Modem Router as a DSL Modem Only on page 266

Note For information about changing the admin password, see Change the admin Password on
page 41. For information about setting up password recovery, see Set Up Password
Recovery on page 42.
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Update the Firmware of the Modem Router

The modem router firmware is stored in flash memory.

You can check to see if new firmware is available and update the modem router to the new firmware. You
can also visit the NETGEAR support website, download the firmware manually, and update the modem
router to the new firmware.

Check for New Firmware and Update the Modem Router

For you to check for new firmware, the modem router must be connected to the Internet.

To check for new firmware and update your modem router:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Firmware Update.
The Firmware Update page displays.

Click the Check button.

The modem router detects new firmware if any is available and displays a message asking if you want
to download and install it.

To download and install the new firmware, click the Yes button.

The modem router locates the firmware, downloads it, and begins the update.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the upload. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting
and the Power LED turns solid white.
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A progress bar shows the progress of the firmware upload process. The firmware upload process
takes several minutes. When the upload is complete, your modem router restarts.

Verify that the modem router runs the new firmware version:
a. Launch an Internet browser from a computer or WiFi device that is connected to the network.

b. Type http://www.routerlogin.net.
A login window opens.

c. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

d. Click the OK button.
The BASIC Home page displays.

The firmware version is stated in the top right, under the Logout button.

Read the new firmware release notes to determine whether you must reconfigure the modem router
after updating.

Manually Upload New Firmware and Update the Modem
Router

Downloading firmware and updating the modem router are two separate tasks that are combined in the
following procedure.

To download new firmware manually and update your modem router:

1.

Visit downloadcenter.netgear.com, locate the support page for your product, and download the new
firmware.

Read the new firmware release notes to determine whether you must reconfigure the modem router
after updating.

Launch an Internet browser from a computer or WiFi device that is connected to the network.

Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Administration > Firmware Update.
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The Firmware Update page displays.

8. Locate and select the firmware file on your computer:
a. Click the Browse button.

b. Navigate to the firmware file.
The file ends in .img. An example of a firmware file name is D7000-V1.0.0.14_1.01.img.

c. Select the firmware file.
9. Click the Upload button.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the upload. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting
and the Power LED turns solid white.

A progress bar shows the progress of the firmware upload process. The firmware upload process
takes several minutes. When the upload is complete, your modem router restarts.

10. Verify that the modem router runs the new firmware version:
a. Launch an Internet browser from a computer or WiFi device that is connected to the network.

b. Type http://www.routerlogin.net.
A login window opens.
c. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

d. Click the OK button.
The BASIC Home page displays.

The version firmware is stated in the top right, under the Logout button.

Manage the Configuration File of the Modem Router

The configuration settings of the modem router are stored within the modem router in a configuration file.
You can back up (save) this file to your computer or restore it.

Back Up the Settings

You can save a copy of the current configuration settings.
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To back up the modem router’s configuration settings:

1.
2.

8.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Backup Settings.
The Backup Settings page displays.

Click the Back Up button.
Choose a location to store the file on your computer.

The name of the backup file is NETGEAR_D7000.cfqg.

Follow the directions of your browser to save the file.

Restore the Settings

If you backed up the configuration file, you can restore the configuration from this file.

To restore configuration settings that you backed up:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Backup Settings.
The Backup Settings page displays.

Click the Browse button and navigate to and select the saved configuration file.
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The name of the backup file from which you can restore the configuration is NETGEAR_D7000.cfg.
Follow the directions of your browser to locate and select the file.
7. Click the Restore button.

The configuration is uploaded to the modem router. When the restoration is complete, the modem
router reboots. This process takes about two minutes.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the restoration.
For example, do not close the browser, click a link, or load a new page. Do
not turn off the modem router.Wait until the modem router finishes restarting
and the Power LED turns solid white.

Recover the admin Password

NETGEAR recommends that you enable password recovery if you change the password for the modem
router user name admin. Then you can recover the password if it is forgotten. This recovery process is
supported in Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.

For information about setting up password recovery, see Set Up Password Recovery on page 42. The
following procedure works only if you did set up password recovery.

To recover your password:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Inthe address field of your browser, type www.routerlogin.net.

A login window opens.
3. Click the Cancel button.

If password recovery is enabled, you are prompted to enter the serial number of the modem router.
The serial number is on the product label on the bottom panel of the modem router.

4. Enter the serial number of the modem router.
5. Click the Continue button.

A screen displays requesting the answers to your security questions.

6. Enter the saved answers to your security questions.
7. Click the Continue button.

A screen displays your recovered password.

8. Click the Login again button.
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A login window opens.

9. With your recovered password, log in to the modem router.

Return the Modem Router to Its Factory Default Settings

Under some circumstances (for example, if you lost track of the changes that you made to the modem
router settings or you move the modem router to a different network), you might want to erase the
configuration and reset it to factory default settings.

If you do not know the current IP address of the modem router, first try to use an IP scanner application
to detect the IP address before you reset the modem router to factory default settings.

To reset the modem router to factory default settings, you can use either the Reset button on the back
of the modem router or the Erase function. However, if you cannot find the IP address or lost the password
to access the modem router, you must use the Reset button.

After you reset the modem router to factory default settings, the user name is admin, the password is
password, the LAN IP address is 192.168.0.1 (which is the same as www.routerlogin.net), and the DHCP
server is enabled. For a list of factory default settings, see Factory Settings on page 309.

Use the Reset Button

Note This process erases all settings that you configured in the modem router.

To reset the modem router to factory default settings:

1. On the back of the modem router, locate the Reset button to the right of the left antenna.
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2. Using a straightened paper clip, press and hold the Reset button for at least five seconds.
3. Release the Reset button.

The Power LED starts blinking amber and the configuration is reset to factory default settings. When
the reset is complete, the modem router reboots. This process takes about two minutes.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the reset. For
example, if you are connected to the web management interface, do not close
the browser, click alink, or load anew page. Do not turn off the modem router.
Wait until the modem router finishes restarting and the Power LED turns solid

white.

Erase the Settings

Note This process erases all settings that you configured in the modem router.
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To erase the settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Administration > Backup Settings.
The Backup Settings page displays.

6. Click the Erase button.

The configuration is reset to factory default settings. When the reset is complete, the modem router
reboots. This process takes about two minutes.

Warning
To avoid the risk of corrupting the firmware, do not interrupt the reset. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting
and the Power LED turns solid white.

View the Status and Statistics of the Modem Router

You can view information about the modem router and its ports and the status of the Internet connection
and WiFi network. In addition, you can view traffic statistics for the various ports.

View Information About the Modem Router and the Internet,
Modem, and WiFi Settings

You can view modem router information, the Internet port status, and WiFi settings.

To view information about the modem router and the Internet, modem, and WiFi settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://iwww.routerlogin.net.
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A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
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& Router Information + Internet Port

Hardware Version

Firmware Version

GUI Language Version
LAN Port

MAC Address

IP Address

DHCP Server

D7000
Vv1.0.0.14_1.01
V1.0.0.14

A4:2B:8CF8.CE46
192.168.0.1
On

MAC Address

Internet IP Address
IPTV IP Address

Internet Connection
IPTV Connection

IP Subnet Mask

Domain Name Server

Ad4:2B:8C:F8:CE.47

100.168.100.147
0.0.0.0

PPPoE
DHCP

100.168.100.1
100.168.100.1

Name (SSID)

Region

Channel

Mode

Wireless AP
Broadcast Name
Wi-Fi Protected Setup

NETGEAR47
USA

Auto (4)

Up to 600 Mbps
ON

ON

Configured

Name (SSID)

Region

Channel

Mode

Wireless AP
Broadcast Name
Wi-Fi Protected Setup

NETGEAR47-5G
USA
149+153(P)+157+161

Up 1o 1300 Mbps
ON

ON

Configured

A Guest Network (2.4GHz) A Guest Network (5.0GHz)

Name (SSID) NETGEAR_Guest1 NETGEAR-

Name (SSID) 5G_Guest!
Wireless AP OFF

Wireless AP OFF
Broadcast Name ON

Broadcast Name ON

Allow guests to see each
other and access my local OFF
network

Allow guests to see each
other and access my local OFF
network
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The information onscreen uses the following color coding:

» A green flag & indicates that the cable connection or Internet connection is fine and no problems
exist. For a WiFi network, the network is enabled and secured.

» Ared XHindicates that configuration problems exist for the cable connection or Internet connection
or the connection is down. For a WiFi network, the network is disabled or down.

* Anamber exclamation mark @ indicates that the cable port or Internet port is configured but cannot
get an Internet connection (for example, because the cable is disconnected), that a WiFi network
is enabled but unprotected, or that another situation that requires your attention occurred.

The following table describes the fields of the six panes on the ADVANCED Home page.

Field

Description

Router Information

Hardware Version

The modem router model.

Firmware Version

The version of the modem router firmware. If you upgrade the
firmware on the modem router, the version changes.

GUI Language Version

The version of the modem router firmware. If you upgrade the
firmware on modem router, the version changes.

LAN Port

The settings of the LAN port. For information about how to configure the LAN settings, see Manage
the Modem Router’s LAN IP Address Settings on page 219 and Disable the Built-In DHCP Server on

page 227.

MAC Address The Media Access Control (MAC) address. This address is the
unique physical address that is assigned to the Ethernet LAN
port.

IP Address The IP address that the Ethernet LAN port uses. The default
IP address is 192.168.0.1.

DHCP Displays whether the DHCP server of the modem router is

enabled for devices that are attached to the LAN.

Internet Port

The settings of Internet port. The Internet connection can run through the ADSL port with DSL service
or through the WAN Ethernet port with cable or fiber service. For information about how to configure
the Internet settings, see one of the following sections:
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Field

Description

* Set Up Your Modem Router for DSL Service on page 24

* Set Up the Modem Router for Cable or Fiber Service on page 32

* Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63

* Manually Set Up a Cable or Fiber Internet Connection on page 73

MAC Address The Media Access Control (MAC) address. This address is the
unique physical address that is assigned to the Internet port.

IP Address The IP address that the Internet port uses. If this field does not
display an address or displays 0.0.0.0 as the address, the
modem router is not connected to the Internet.

Connection The type of Internet connection, which can be a PPPoE

connection, PPPoA connection, fixed IP address connection,
or DHCP connection.

IP Subnet Mask

The IP subnet mask that the Internet port uses.

Gateway IP Address

The IP address of the gateway that the Internet port uses.

Domain Name Server

The IP address of the Domain Name System (DNS) server that
the Internet uses.

Wireless Settings (2.4GHz)

The settings of the WiFi port for the 2.4 GHz band of the main network. For information about how
to configure the settings of the main network, see the following sections:

* Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 102

» Control the WiFi Radios on page 123

* Manage Advanced WiFi Features on page 129

Name (SSID) The WiFi network name for the 2.4 GHz band of the main
network.

Region The location (country).

Channel The channel that the 2.4 GHz band of the main network uses.
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Field

Description

Wireless AP

Displays whether the 2.4 GHz band of the main network is
enabled.

Broadcast Name

Displays whether the 2.4 GHz band of the main network
broadcasts its SSID.

Wi-Fi Protected Setup

Displays whether the modem router keeps its existing WiFi
settings when you use WPS to connect a device to the 2.4 GHz
band of the main network:

* Configured. The modem router keeps its existing WiFi
settings. This is the default setting.

* Not configured. The modem router generates a random
SSID and passphrase and changes the security mode to
WPA/WPA2-PSK mixed mode.

For more information, see Manage the WPS Settings on
page 127.

Wireless Settings (5.0GHz)

The settings of the WiFi port for the 5 GHz band of the main network. For information about how to
configure the settings of the main network, see the following sections:

* Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 102

e Control the WiFi Radios on page 123

e Manage Advanced WiFi Features on page 129

Name (SSID) The WiFi network name for the 5 GHz band of the main network.
Region The location (country).

Channel The channel that the 5 GHz band of the main network uses.
Wireless AP Displays whether the 5 GHz band of the main network is

enabled.

Broadcast Name

Displays whether the 5 GHz band of the main network
broadcasts its SSID.

Manage the Modem Router and Monitor the Traffic

245




Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

Field

Description

Wi-Fi Protected Setup

Displays whether the modem router keeps its existing WiFi
settings when you use WPS to connect a device to the 5 GHz
band of the main network:

* Configured. The modem router keeps its existing WiFi
settings. This is the default setting.

* Not configured. The modem router generates a random
SSID and passphrase and changes the security mode to
WPA/WPA2-PSK mixed mode.

For more information, see Manage the WPS Settings on
page 127.

Guest Network (2.4GHz)

The settings of the WiFi port for the 2.4 GHz band of the guest network. For information about how
to configure the settings of the guest network, see Manage the Basic WiFi Settings and WiFi Security

of the Guest Network on page 117.

Name (SSID) The WiFi network name for the 2.4 GHz band of the guest
network.
Wireless AP Displays whether the 2.4 GHz band of the guest network is

enabled.

The WiFi LED on the front of the modem router is not affected
by the status of the guest network.

Broadcast Name

Displays whether the 2.4 GHz band of the guest network
broadcasts its SSID.

Allow guest to access My Local
Network

Displays whether users of the 2.4 GHz band of the guest
network are allowed to access the main network.

Guest Network (5.0GHz)

The settings of the WiFi port for the 5 GHz band of the guest network. For information about how to
configure the settings of the guest network, see Manage the Basic WiFi Settings and WiFi Security

of the Guest Network on page 117.

Name (SSID)

The WiFi network name for the 5 GHz band of the guest
network.
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Field Description

Wireless AP Displays whether the 2.4 GHz band of the main network is
enabled.

Broadcast Name Displays whether the 5 GHz band of the guest network

broadcasts its SSID.

Allow guest to access My Local Displays whether users of the 5 GHz band of the guest network
Network are allowed to access the main network.

View the Traffic Statistics

You can view the traffic statistics for the ports of the modem router.

To view the traffic statistics for the ports of the modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home page displays.

6. Inthe Internet Port pane, click the Show Statistics button.
The Show Statistics pop-up window opens.

The following table describes the fields and columns of the Show Statistics pop-up window.

Field or Column Description

System Up Time The time elapsed since the modem router was last restarted.
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Field or Column

Description

described in this table.

Port The statistics for the WAN (Internet over Ethernet) port, LAN (Ethernet)
ports, WLAN b/g/n port, and WLAN a/n/ac port. For each port, the
screen displays the information that is described in this table.

Status The link status of the port.

TxPkts The number of packets that were transmitted on this port since reset
or manual clear.

RxPkts The number of packets that were received on this port since reset or
manual clear.

Collisions The number of packets that collided on this port since reset or manual
clear.

Tx Bl/s The number of bytes per second that were transmitted on this port
since reset or manual clear.

Rx Bl/s The number of bytes per second that were received on this port since
reset or manual clear.

Up Time The time elapsed since this port acquired the link.

ADSL Link

In addition to the xDSL firmware version, the screen displays the ADSL link information that is

Link Rate

The downstream and upstream link rates in Kbps.

Line Attenuation

The downstream and upstream Line Attenuation (LATN) in dB. The
LATN expresses the signal quality.

Noise Margin The downstream and upstream Signal-to-Noise Ratio Margin (SNRM)
in dB. The SNRM expresses the signal quality in relation to interference.
Poll Interval The interval at which the statistics are updated in this screen.

Change the Traffic Statistics Polling Frequency

You can change the polling frequency or stop traffic polling.
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To change the traffic statistics polling frequency or stop polling:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home page displays.

6. In the Internet Port pane, click the Show Statistics button.
A pop-up window displays.

7. Change the polling frequency or stop polling:

To change the polling frequency, do the following:
a. Inthe Poll Interval field, enter a time in seconds.

b. Click the Set Interval button.

To stop polling, click the Stop button.

View or Change aTCP/IP Internet Connection

You can view information about a TCP/IP Internet connection of the modem router and renew or release
such a connection.

To view or change the TCP/IP Internet connection status:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
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The BASIC Home page displays.

Select ADVANCED > ADVANCED Home.

The ADVANCED Home page displays.

In the Internet Port pane, click the Connection Status button.

The Connection Status pop-up window opens. The fields that display depend on the type of Internet
connection.

The following table describes the fields for a TCP/IP connection with DHCP.

Field Description

IP Address The IP address that is assigned by the ISP to the modem router.
Subnet Mask The subnet mask that is assigned by the ISP to the modem router.
Default Gateway The IP address of the default gateway of the ISP that the modem router

communicates with.

DHCP Server The IP address of the DHCP server of the ISP that issues the IP address
to the modem router.

DNS Server The IP address of the Domain Name System (DNS) server of the ISP
that provides translation of network names to IP addresses.

To renew the Internet connection when the connection is active, click the Renew button.
To terminate the Internet connection when the connection is active, click the Release button.
Click the Close Window button.

The pop-up window closes.

View or Change a PPPoE or PPPoA Internet Connection

You can view information about a PPPoE or PPPoOA Internet connection of the modem router and establish
or terminate such a connection.

To view or change the PPPoE or PPPOA Internet connection status:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > ADVANCED Home.

The ADVANCED Home page displays.

In the Internet Port pane, click the Connection Status button.

The Connection Status pop-up window opens. The fields that display depend on the type of Internet
connection.

The following table describes the fields for a PPPoE connection.

Field Description

Connection Time The time elapsed since the connection was established.
Connection Status The status can be Connected or Disconnected.

Negotiation The negotiation can be a series of dashes, which indicates that the

connection is not established, or successful (Success).

Authentication The authentication can be a series of dashes, which indicates that the
connection is not established, or successful (Success).

IP Address The IP address that is assigned by the ISP to the modem router.

Subnet Mask The subnet mask that is assigned by the ISP to the modem router.

To establish the Internet connection when the connection is down, click the Connect button.
To terminate the Internet connection when the connection is active, click the Disconnect button.
Click the Close Window button.

The pop-up window closes.

View Devices Currently on the Network

You can view the active wired and WiFi devices in both the network to which the modem router is connected
and the modem router network. If you do not recognize a WiFi device, it might be an intruder.
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To display the wired and WiFi devices:

1.
2.

6.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.
Select BASIC > Attached Devices.
The Attached Devices page displays.

Wired devices are connected to the modem router with Ethernet cables. WiFi devices are connected
to the modem router through the WiFi network, in either the 2.4 GHz band or the 5 GHz band.

The following table describes the fields on the Attached Devices page.

Field Description

Status The status of the device in the network (Allowed or Blocked).

Device Name The device name, if detected.

IP Address The IP address that the modem router assigned to the device when it

joined the network. This number can change when a device is
disconnected and rejoins the network.

MAC Address The unique MAC address. The MAC address does not change and is
usually shown on the product label.

To refresh the information onscreen, click the Refresh button.

The information onscreen is updated.

Manage the Activity Log and Syslog

The log is a detailed record of the websites users on your network accessed or attempted to access and
many other modem router actions. Up to 256 entries are stored in the log. You can manage which activities
are logged.
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View the Logs

To manage which activities are logged and view the log:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

The BASIC Home page displays.
4. Select ADVANCED > Administration > Logs.
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Current Time: Sunday, Jan 02, 2011 01:53:15

[admin login] from source 192.168.0.2

[admin login] from source 192.1685.0.2

[DHCE IP: (192.168.0.2)] to MAC address &60:6C:66:DRA:94:7C
[admin login] from source 192.1685.0.2

[admin login] from source 192.168.0.2

[DHCE IP: (1%2.168.0.2)] to MAC address &60:6C:66:DR:94:7C
[Initialized, firmware wversion: V1.0.0.14 1.0.1 ]

] T 3

Clea Log Send Log

Include in Log

& Attempted access to allowed sites

[¥] attempted access to blocked sites and senvices
Connections to the Web-based interface of this Router
Router operation (startup, gettime etc)

Known DoS attacks and Port Scans

Port Forwarding / Port Triggering

[l wireless access

[¥] Automatic Internet connection reset
ReadyShare

¥IvPN Semvice

Syslog
@ Disable

) Broadcast on LAN

) Sendto this Syslog server IP address

The Logs page shows the following information:
e Action. The action that occurred, such as whether Internet access was blocked or allowed.

* Source. The name, IP address, or MAC address of the target device, application, or website for
this log entry.

e Target. The name, IP address, or MAC address of the target device, application, or website for
this log entry.

To refresh the log screen, click the Refresh button.
To clear the log entries, click the Clear Log button.
To email the log immediately, click the Send Log button.
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The modem router emails the logs to the address that you specified (see Set Up Security Event Email
Notifications on page 156).

Specify Which Activities Are Logged

You can specify which activities are logged. These activities display in the log and are forwarded to the
syslog server if you enabled the syslog server function.

To manage which activities are logged:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Logs.

The Logs page displays.

Select the check boxes that correspond to the activities that you want to be logged.
By default, all check boxes are selected.

Clear the check boxes that correspond to the activities that you do not want to be logged.
Click the Apply button.

Your settings are saved.

Specify a Syslog Server

You can let the modem router send the logs to a syslog server on your LAN or to an external syslog server.
The modem router can also broadcast the syslog server message on your LAN.

To specify a syslog server and enable forwarding of log messages:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.

Manage the Modem Router and Monitor the Traffic
255



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Logs.

The Logs page displays.

Scroll down to the Syslog section.

By default, the Disable button is selected and no log messages are forwarded.

Select how log messages are forwarded:

Broadcast on LAN. The modem router broadcasts log messages on your LAN but does not send
log messages to a syslog server.

Send to this Syslog server IP address. The modem router sends log messages to an internal or
external syslog server, for which you must enter the IP address.

Click the Apply button.

Your settings are saved.

Monitor and Meter Internet Traffic

Traffic metering allows you to monitor the volume of Internet traffic that passes through the modem router
Internet port. With the traffic meter utility, you can set limits for traffic volume, set a monthly limit, and get
a live update of traffic usage.

Start the Traffic Meter Without Traffic Volume Restrictions

You can monitor the traffic volume without setting a limit.

To start or restart the traffic meter without configuring traffic volume restrictions:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
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The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Traffic Meter.

Internet Traffic Meter
" |Enable Traffic Mater

2 Traffic volume control by | No limit
Monthly limit (Mbytes)
Round up data volume for each connection by 0 (Mbytes)

Connection time control
Monthly limit (Hours)

Traffic Counter
Restart traffic counter at O 100 |am Onthe 1st day of each maonth

Traffic Control
Pop up a warning message
0 MbytesMinutes before the monthly limit is reached
When the monthly limit is reached
Tumn the Internet LED to flashing greenfamber
Disconnect and disable the Internet connection

6. Select the Enable Traffic Meter check box.
By default, no traffic limit is specified and the traffic volume is not controlled.

7. Inthe Traffic Counter section, set the traffic counter to begin at a specific time and date.
If you want the traffic counter to start immediately, click the Restart Counter Now button.
9. Click the Apply button.

o

Your settings are saved and the modem router restarts.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Traffic Statistics and Traffic Status on page 257.

View the Traffic Statistics and Traffic Status

If you enabled the traffic meter (see Start the Traffic Meter Without Traffic Volume Restrictions on page
256), you can view the traffic statistics and traffic status.
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To view the traffic statistics and status of the traffic meter:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://Iwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter page displays.

6. Scroll down to the Internet Traffic Statistics section.

Internet Traffic Statistics

Start Date/Time:Monday, 22 Jun 2015 10:10 AM
Current Date/Mime:Monday, 22 Jun 2015 10:20 AM
Traffic Volume LeftNo limit

‘ Period ‘ Connection Time Traffic Volume (Mbytes)
(hh:mm) Upload/Avg  Download/Avg Total/Avg
[ Today | [ o077 | 743 | 819
[ Yesterday | [ o000 | 000 [ 000
[ This week | [ o701 | 743106 | 8.191.17
[ This month | [ 077003 | 743025 | 8.190.27
| Lastmonth | | 000000 | 000000 | 0.000.00

Retresn Y matiosaus

The Internet Traffic Statistics section displays when the traffic counter was started and what the traffic
balance is. The table displays information about the connection time and traffic volume in MB.

7. To refresh the information onscreen, click the Refresh button.
The information onscreen is updated.

8. To display more information about the data traffic and to change the polling interval, click the Traffic
Status button.
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The Traffic Status pop-up window displays.

Restrict Internet Traffic by Volume

You can record and restrict the traffic by volume in MB. This is useful when your ISP measures your traffic
in volume.

To record and restrict the Internet traffic by volume:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Traffic Meter.
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Internet Traffic Meter
"] Enable Traffic Meter

@) Traffic volume control by | Mo limit
Monthly limit (Mbytes)
Round up data volume for each connection by 0 (Mbytes)

Connection time control
Monthly limit (Hours)

Traffic Counter

Restart traffic counter at 0 100 am Onthe 1st day of each manth

Restart Counter Now

Traffic Control
Pop up a warning message

0 MbytesMinutes before the monthly limitis reached
When the monthly limit is reached
Turn the Internet LED to flashing greenfamber
Disconnect and disable the Internet connection

Select the Enable Traffic Meter check box.
Select the Traffic volume control by radio button.
From the corresponding menu, select an option:

Download only. The restriction is applied to incoming traffic only.
Both Directions. The restriction is applied to both incoming and outgoing traffic.

In the Monthly Limit field, enter how many MBytes (MB) per month are allowed.

If your ISP charges you for extra data volume when you make a new connection, enter the extra data
volume in MB in the Round up data volume for each connection by field.

In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

In the Traffic Control section, enter a value in minutes to specify when the modem router issues a
warning message before the monthly limit in hours is reached.

This setting is optional. The modem router issues a warning when the balance falls under the number
of minutes that you enter. By default, the value is 0 and no warning message is issued.

Select one or more of the following actions to occur when the limit is reached:
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Turn the Internet LED to flashing white/amber. This setting is optional. When the traffic limit is
reached, the Internet LED blinks alternating white and amber.

Disconnect and disable the Internet connection. This setting is optional. When the traffic limit
is reached, the Internet connection is disconnected and disabled.

14. Click the Apply button.

Your settings are saved and the modem router restarts.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Traffic Statistics and Traffic Status on page 257.

Restrict Internet Traffic by Connection Time

You can record and restrict the traffic by connection time. This is useful when your ISP measures your
connection time.

To record and restrict the Internet traffic by time:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Advanced Setup > Traffic Meter.
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Traffic

Traffic

RA = &= =
Meter

i i S
ADD

Internet Traffic Meter
"] Enable Traffic Meter

@) Traffic volume control by | Mo limit
Monthly limit (Mbytes)
Round up data volume for each connection by 0 (Mbytes)

Connection time control
Monthly limit (Hours)

Traffic Counter

Restart traffic counter at 0 100 |am Onthe 1st day of each maonth

Traffic Control
Pop up a warning message

0 MbytesMinutes before the monthly limitis reached
When the monthly limitis reached
Tum the Internet LED to flashing greenfamber
Disconnect and disable the Internet connection

6. Select the Enable Traffic Meter check box.
7. Select the Connection time control radio button.

Note The modem router must be connected to the Internet for you to be able to select the
Connection time control radio button.

8. Inthe Monthly Limit field, enter how many hours per month are allowed.

Note The modem router must be connected to the Internet for you to be able to enter
information in the Monthly Limit field.

9. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

10. In the Traffic Control section, enter a value in minutes to specify when the modem router issues a
warning message before the monthly limit in hours is reached.
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This setting is optional. The modem router issues a warning when the balance falls under the number
of minutes that you enter. By default, the value is 0 and no warning message is issued.

11. Select one or more of the following actions to occur when the limit is reached:

Turn the Internet LED to flashing white/amber. This setting is optional. When the traffic limit is
reached, the Internet LED alternates blinking white and amber.

Disconnect and disable the Internet connection. This setting is optional. When the traffic limit
is reached, the Internet connection is disconnected and disabled.

12. Click the Apply button.
Your settings are saved and the modem router restarts.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Traffic Statistics and Traffic Status on page 257.

Unblock the Traffic Meter After the Traffic Limit Is Reached

If you configured the traffic meter to disconnect and disable the Internet connection after the traffic limit
is reached, you cannot access the Internet until you unblock the traffic meter.

Note If your ISP set a traffic limit, your ISP might charge you for the overage traffic.

To unblock the traffic meter:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter page displays.

6. In the Traffic Control section, clear the Disconnect and disable the Internet connection check box.
7. Click the Apply button.
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Your settings are saved and the modem router restarts.

Manage the Modem Router Remotely

The remote management feature lets you access your modem router securely over the Internet to view
or change its settings. You need to know the modem router's WAN IP address to use this feature. For
information about a different type of remote access, that is, remote access using Dynamic DNS, see
Access Storage Devices Through the Internet on page 197.

Note Be sure to change the password for the user name admin to a secure password.
The ideal password contains no dictionary words from any language and contains
uppercase and lowercase letters, numbers, and symbols. It can be up to 30
characters. See Change the admin Password on page 41.

To set up remote management:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Remote Management.
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| Turn Remote Management On

Remote Management Address:
hitps://100.168.110.147:3443

Allow Remote Access By
Only This Computer.

IP Address Range: From

IP Address List

@ Everyone

Port Number: 8443

Select the Turn Remote Management On check box.

In the Allow Remote Access By section, specify the external IP addresses to be allowed to access

the modem router’s remote management:

Note For enhanced security, restrict access to as few external IP addresses as practical.

Select one of the following radio buttons and configure the options accordingly:

To allow access from a single IP address on the Internet, select the Only This Computer radio

button. Enter the IP address to be allowed access.

To allow access from a range of IP addresses on the Internet, select the IP Address Range radio

button. Enter a beginning and ending IP address to define the allowed range.

To allow access from a list of IP addresses on the Internet, select the IP Address List radio button.

Enter up to 10 IP addresses to be allowed access.
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To allow access from any IP address on the Internet, select the Everyone radio button. This radio
button is selected by default.

Specify the port number for accessing the web management interface.

The default is 8443, which is a common alternate for HTTPS. For greater security, enter a custom
port number for the remote web management interface. Choose a number from 1024 to 65535, but
do not use the number of any common service port.

Click the Apply button.

Your settings are saved.

Configure the Modem Router as a DSL Modem Only

By default, the modem router functions as both a modem and a router. You can change the operation
mode to a mode in which the modem router functions as a DSL modem only with the routing, firewall,
wireless support, and traffic meter features disabled.

A typical use of such a mode is when the modem router is used only for DSL connectivity behind a router,
firewall, or security device manager that provides routing, firewall, wireless support, and traffic meter
features.

To configure the modem router as a DSL modem only:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Device Mode.
The Device Mode page displays.

From the Device Mode menu, select Modem (Modem Only).
Click the Apply button.

Your settings are saved. The modem router restarts.
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Use VPN to Access Your Network 12

You can use OpenVPN software to remotely access your modem router using virtual private networking
(VPN). This chapter explains how to set up and use VPN access.

The chapter includes the following sections:

* Set Up a VPN Connection on page 268

* Use VPN to Access the Modem Router’'s USB Device and Media on page 272
» Use VPN to Access Your Internet Service at Home on page 273
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Set Up a VPN Connection

A virtual private network (VPN) lets you use the Internet to securely access your network when you are
not home. This type of VPN access is called a client-to-gateway tunnel. The computer is the client, and
the modem router is the gateway. To use the VPN feature, you must log in to the modem router and
enable VPN, and you must install and run VPN client software on the computer.

Note The modem router does not support iOS or Android VPN client software.

VPN uses DDNS or a static IP address to connect with your modem router.

To use a DDNS service, register for an account with a host name (sometimes called a domain name).
You use the host name to access your network. The modem router supports these accounts: NETGEAR,
No-IP, and Dyn. See Set Up and Manage Dynamic DNS on page 193.

If your Internet service provider (ISP) assigned a static WAN IP address (such as 50.196.x.x or 10.X.X.X)
that never changes to your Internet account, the VPN can use that IP address to connect to your home
network.

Specify VPN Service in the Modem Router

You must specify the VPN service settings in the modem router before you can use a VPN connection.

To specify the VPN service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > VPN Service.
The VPN Service page displays.

6. Select the Enable VPN Service check box.
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By default, the VPN uses the UDP service type and uses port 12974. If you want to customize the
service type and port, NETGEAR recommends that you change these settings before you install the
OpenVPN software.

To change the service type, scroll down and select the TCP radio button.

To change the port, scroll down to the Service Port field, and type the port number that you want to
use.

Note For information about configuring the type of access, see Use VPN to Access Your
Internet Service at Home on page 273.

Click the Apply button.

Your changes are saved. VPN is enabled in the modem router, but you must install and set up OpenVPN
software on your computer before you can use a VPN connection (see Install OpenVPN Software on
Your Computer on page 269).

Install OpenVPN Software on Your Computer

You must install this software on each computer that you plan to use for VPN connections to your modem
router.

To install VPN client software:

1.

2.
3.
4

5.
6.

Visit openvpn.net/index.php/download/community-downloads.html.

In the Windows Installer section of the screen, double-click the openVPN-install-xxx.exe link.
Download the file.

To install the Open VPN software on your computer, click the openVPN-install-xxx.exe file.

OpenVPN 2.3.2-1003 Setup =@

Welcome to the OpenVPN
2.3.2-1003 Setup Wizard

This wizard will guide you through the installation of
OpenVPN , an Open Source VPN package by James Yonan.

Note that the Windows version of OpenVPN will only run on
Windows XP, or higher.

MNext > Cancel

Click the Next button.
Read the License Agreement and click the | Agree button.
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OpenVPN 2.3.2-1003 Setup (=@
Choose Components
Choose which features of OpenVPN 2.3.2-1003 you want to
install.

Select the components to install/upgrade. Stop any OpenVPN processes or the OpenVPN
service if itis running. All DLLs are installed locally.

Sdectcomponeﬂubomstall: .._.. BN User e
[¥] OpenvPN Service
[¥] TaP Virtual Ethernet Adapter £
[] OpenvPN GUI
[¥] OpenvPN File Associations
[[] OpenssL Utiities o

Description i : o= :
Space required: 3.9MB

[ <Back |[ mext> | [ cance |

7. Leave the check boxes selected as shown in the previous figure, and click the Next button.

8. To specify the destination folder, click the Browse button, select a destination folder, and click the
Next button.

-"] Windows Security =
Would you like to install this device software?

~  Name: TAP-Windows Provider VO Network adapters
&' Publisher: OpenVPN Technologies, Inc

| Ahways trust software from "OpenVPN [ Instan_| [ Don'tInstall
Technologies, Inc.”,

& You should only install driver software from publi you trust. How can | decide which
device software is safe to install?

9. Click the Install button.

The window displays the progress of the installation and then displays the final installation window.

OpenVPN 23.2-1003 Setup E=3Eol B

Completing the OpenVPN 2.3.2-1003
Setup Wizard

OpenVPN 2.3.2-1003 has been installed on your computer,
Click Finish to dose this wizard.

(o )

10. Click the Finish button.

11. Unzip the configuration files that you downloaded and copy them to the folder where the VPN client
is installed on your device.
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For a client device with Windows 64-bit system, the VPN client is installed at C:\Program
files\OpenVPN\config\ by default.

12. For a client device with Windows, modify the VPN interface name to NETGEAR-VPN:
a. InWindows, select Start > Control Panel > Network and Internet > Network Connections.

b. Inthelocal area connection list, find the local area connection with the device name TAP-Windows
Adapter.

c. Select the local area connection and change its name (not its device name) to NETGEAR-VPN.

If you do not change the VPN interface name, the VPN tunnel connection will fail.

Use a VPN Tunnel

After you set up the modem router to use VPN and install the OpenVPN application on your computer,
you can open a VPN tunnel from your computer to your modem router over the Internet.

For the VPN tunnel to work, the local LAN IP address of the remote router must use a different LAN IP
scheme from that of the local LAN where your VPN client computer is connected. If both networks use
the same LAN IP scheme, when the VPN tunnel is established, you cannot access your home router or
your home network with the OpenVPN software.

The default LAN IP address scheme for the modem router is 192.x.x.x. The most common IP schemes
are 192.x.x.x, 172.x.x.x, and 10.x.x.x. If you experience a conflict, change the IP scheme either for your
home network or for the network with the client VPN computer. For information about changing these
settings, see Manage the Modem Router’s LAN IP Address Settings on page 219.

To open a VPN tunnel:

1. Launch the OpenVPN application with administrator privileges.

[} OpenVPN 2.3.2-1003 Setup =3 lic]

Welcome to the OpenVPN
2.3.2-1003 Setup Wizard

This wizard will guide you through the installation of
OpenVPN , an Open Source VPN package by James Yonan.

Note that the Windows version of OpenVPN will only run on
Windows XP, or higher.

Next > Cancel |

The OpenVPN icon displays in the Windows taskbar.
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Tip You can create a shortcut to the VPN program, then use the shortcut to access the
settings and select the run as administrator check box. Then every time you use this
shortcut, OpenVPN automatically runs with administrator privileges.

2. Right-click the OpenVPN icon.

View Log
Edit Config
Change Password

Settings...
Bxit

3. Select Connect.

The VPN connection is established. You can do the following:
e Launch a web browser and log in to your modem router.

» Use Windows file manager to access the modem router's USB device and download files.

Use VPN to Access the Modem Router’'s USB Device and Media

To access a USB device and download files:

1. In Windows file manager, select the Network folder.

Organize » Metwork and Sharing Center Add a printer Add a wireless device

4 5 Favorites =g Computer (2)
M Desktop
s Downloads L& NETGEARL ' READYSHARE
= Recent Places
& Vault Timeline 4 Media Devices (3)
S LTI : (11— . » B .
4 Libraries -\«L lifestyle_MNAS: ReadyMNAS 104 \Lé METGEARL: Netgearuser: ReadyDLMA: DT000
» 15 Documents : - ‘@
» 4 Music 4 Metwork Infrastructure (2)
&, Pictures 2
B wideos ‘? WNDR4500 (Gateway) ‘g 7 D7000 [Gateway)

4% Computer
& Windows7_05 (C)
~> Remaovable Disk (D)
@ Lenovo_Recovery (Q)
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The network resources display. The ReadySHARE icon is in the Computer section and the remote
ReadyDLNA: D7000 icon is in the Media Devices section (if DLNA is enabled in the modem router).

2. If the icons do not display, click the Refresh button to update the page.

If the local LAN and the remote LAN are using the same IP scheme, the remote ReadyDLNA: D7000
icon does not display in the Media Devices section and the D7000 (Gateway) icon does not display
in the Network Infrastructure section.

3. To access the USB device, click the ReadySHARE icon.
4. To access media on the modem router’s network, click the ReadyDLNA: D7000 icon.

Use VPN to Access Your Internet Service at Home

When you are away from home and you access the Internet, you usually use a local Internet service
provider. For example, at a coffee shop you might be given a code that lets you use the coffee shop’s
Internet service account to surf the web.

The modem router lets you use a VPN connection to access your own Internet service when you are away
from home. You might want to do this if you travel to a geographic location that does not support all the
Internet services that you use at home. For example, your Netflix account might work at home but not in
a different country.

Set Up VPN Client Internet Access in the Modem Router

By default, the modem router is set up to allow VPN connections only to your home network but you can
change the setting to allow Internet access. Accessing the Internet remotely through a VPN might be
slower than accessing the Internet directly.

To allow VPN clients to use your home Internet service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > VPN Service.
The VPN page displays.

6. Select the Enable VPN Service radio button.

7. Scroll down to the Clients will use this VPN connection to access section, and select the All sites on
the Internet & Home Network radio button.
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When you access the Internet with the VPN connection, instead of using a local Internet service, you
use the Internet service from your home network.

Note By default, the Auto radio button is selected. The Auto option uses an automatic
detection system that enables VPN access only for necessary services and sites
and might not include full Internet access.

8. Click the Apply button.
Your settings are saved.

9. Click the For Windows or For Non Windows button and download the configuration files for your
VPN clients.

10. Unzip the configuration files and copy them to the folder where the VPN client is installed on your
device.

For a client device with Windows 64-bit system, the VPN client is installed at C:\Program
files\OpenVPN\config\ by default.

Block VPN Client Internet Access in the Modem Router

By default, the modem router is set up to allow VPN connections only to your home network, not to the
Internet service for your home network. If you changed this setting to allow Internet access, you can
change it back.

To allow VPN clients to access only your home network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > VPN Service.
The VNP page displays.

6. Select the Enable VPN Service radio button.

7. Scroll down to the Clients will use this VPN connection to access section, and select the Home Network
only radio button.

8. Click the Apply button.
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Your settings are saved.

9. Click For Windows or For Non Windows button and download the configuration files for your VPN
clients.

10. Unzip the configuration files and copy them to the folder where the VPN client is installed on your
device.

For a client device with Windows 64-bit system, the VPN client is installed at C:\Program
files\OpenVPN\config\ by default.

Use aVPN Tunnel to Access Your Internet Service at Home

To access your Internet service:

1. Set up the modem router to allow VPN access to your Internet service.
See Set Up VPN Client Internet Access in the Modem Router on page 273.

2. On your computer, launch the OpenVPN application.
The OpenVPN icon displays in the Windows taskbar.

3. Right-click the icon and select Connect.
4. When the VPN connection is established, launch your Internet browser.
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Manage Port Forwarding and Port 13
Triggering

You can use port forwarding and port triggering to set up rules for Internet traffic for services and applications.
You need networking knowledge to set up these features.

This chapter includes the following sections:
* Manage Port Forwarding to a Local Server for Services and Applications on page 276

* Manage Port Triggering for Services and Applications on page 283
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Manage Port Forwarding to a Local Server for Services and
Applications

If a server is part of your network, you can allow certain types of incoming traffic to reach the server. For
example, you might want to make a local web server, FTP server, or game server visible and available
to the Internet.

The modem router can forward incoming traffic with specific protocols to computers on your local network.
You can specify the servers for applications and you can also specify a default DMZ server to which the
modem router forwards all other incoming protocols (see Set Up a Default DMZ Server on page 217).

Forward Incoming Traffic for a Default Service or Application

You can forward traffic for a default service or application to a computer on your network.

To forward incoming traffic for a default service or application:

1.
2.

Decide which type of service, application, or game you want to provide.
Find the local IP address of the computer on your network that will provide the service.

The server computer must always receive the same IP address. To specify this setting, use the
reserved IP address feature. See Manage Reserved LAN IP Addresses on page 222.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
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Port Forwarding / Port Triggering

Please select the service type.
@ Port Forwarding
' Port Triggering

Service Name Server IP Address
FTP - 192 .168 .0 g + Add
# Service Name External Starting Port Internal Starting Port Server IP Address

m % Delete Service + Add Custom Service
Arrange by internal IP

8. Make sure that the Port Forwarding radio button is selected.
9. From the Service Name menu, select the service or application.

If the service or application that you want to add is not in the list, create a port forwarding rule with a
custom service or application (see Add a Port Forwarding Rule with a Custom Service or Application
on page 278).

10. In the Server IP Address field, enter the IP address of the computer that must provide the service or
that runs the application.

11. Click the Add button.

Your settings are saved and the rule is added to the table.

Add a Port Forwarding Rule with a Custom Service or
Application
The modem router lists default services and applications that you can use in port forwarding rules. If the

service or application is not predefined, you can add a port forwarding rule with a custom service or
application.

To add a port forwarding rule with a custom service or application:

1. Find out which port number or range of numbers the service or application uses.

You can usually find this information by contacting the publisher of the service or application or through
user groups or news groups.

2. Launch an Internet browser from a computer or WiFi device that is connected to the network.
3. Type http://www.routerlogin.net.

A login window opens.

4. Enter the user name and password for the modem router.

Manage Port Forwarding and Port Triggering
278



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

The user name is admin. The default password is password. The user name and password are
case-sensitive.

5. Click the OK button.
The BASIC Home page displays.

6. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

7. Make sure that the Port Forwarding radio button is selected.
8. Click the Add Custom Service button.

Senice Name

Service Type TCP/UDP ~
Starting Port
External port range
(Specify port numbers andfor port ranges split by commas ,example:30,50-60,65500-65510)
¥ Use the same port range for Intemal port
Internal port range
(Specify port numbers andior port ranges split by commas ,example:30,50-60,65500-65510)
Server IP Address 152 ./168 . 0O
Or select from currently attached devices

192.168.0.2 BUSINESSLAPTOP

9. Specify a new port forwarding rule with a custom service or application as described in the following
table.

Field Description

Service Name Enter the name of the custom service or application.

Service Type Select the protocol (TCP or UDP) that is associated with the service or
application.

If you are unsure, select TCP/UDP.

External Port Range Enter one or more port numbers, one or more ranges of port numbers, or
a combination of both.

Divide ports and port ranges by commas.

Internal Port Range Specify the internal ports by one of these methods:
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Field Description

* Leave the Use the same port range for Internal port check box
selected.

* Inthe Internal Port Range field, enter one or more port number, one
or more ranges of port numbers, or a combination of both.

Divide ports and port ranges by commas.

Service IP address Either enter an IP address in the Service IP address field or select the
radio button for an attached device that is listed in the table.

10. Click the Apply button.

Your settings are saved. The rule is added to the table on the Port Forwarding / Port Triggering page.

11. To arrange the table entries by internal IP address, click the Arrange by internal IP button.

The lowest internal IP address displays at the top and the highest at the bottom.

Change a Port Forwarding Rule

You can change an existing port forwarding rule.

To change a port forwarding rule:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
The BASIC Home page displays.
Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
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Port Forwarding / Port Triggering

Please select the service type.
@ Port Forwarding

*} Port Triggering

Service Name Server IP Address

FTP - 192 .168 .0 ! + Add
# Service Name External Starting Port Internal Starting Port Server IP Address
1 cDDB 8880-2880 8880-8880 192.168.0.212
2 LWAPP 1222212223 1222212223 192.168.0.58

# Edit Service + Add Custom Service
Arrange by internal IP

The previous figure shows two custom port forwarding rules.

6. Make sure that the Port Forwarding radio button is selected.
In the table, select the radio button next to the service or application name.
8. Click the Edit Service button.

~

The Ports - Custom Services page displays.
9. Change the settings.

For more information about the settings, see Add a Port Forwarding Rule with a Custom Service or
Application on page 278.

10. Click the Apply button.

Your settings are saved. The changed rule displays in the table on the Port Forwarding / Port Triggering
page.

Remove a Port Forwarding Rule

You can remove a port forwarding rule that you no longer need.

To remove a port forwarding rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

Port Forwarding / Port Triggering

Please select the service type.
@ Port Forwarding

"} Port Triggering

Service Name Server IP Address

FTP - 192 .168 .0 ! + Add
# Service Name External Starting Port Internal Starting Port Server IP Address
1 cooB 8880-8880 8880-8880 192.168.0.212
2 LWAPP 1222212223 1222212223 192.168.0.58

» Edit Service + Add Custom Service
Arrange by internal IP

The previous figure shows two custom port forwarding rules.

6. Make sure that the Port Forwarding radio button is selected.
In the table, select the radio button next to the service or application name.
8. Click the Delete Service button.

~

The rule is removed from the table.

Application Example: Make a Local Web Server Public

If you host a web server on your local network, you can use port forwarding to allow web requests from
anyone on the Internet to reach your web server.

To make a local web server public:

1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP address
reservation.
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In this example, your modem router always gives your web server an IP address of 192.168.0.33.

2. On the Port Forwarding / Port Triggering screen, configure the modem router to forward the HTTP
service to the local address of your web server at 192.168.0.33.

HTTP (port 80) is the standard protocol for web servers.

3. (Optional) Register a host name with a Dynamic DNS service, and specify that name on the Dynamic
DNS screen of the modem router.

Dynamic DNS makes it much easier to access a server from the Internet because you can enter the
name in the Internet browser. Otherwise, you must know the IP address that the ISP assigned, which
typically changes.

How the Modem Router Implements the Port Forwarding
Rule

The following sequence shows the effects of a port forwarding rule:

1. When you enter the URL www.example.com in your browser, the browser sends a web page request
message with the following destination information:

* Destination address. The IP address of www.example.com, which is the address of your modem
router.

» Destination port number. 80, which is the standard port number for a web server process.

2. The modem router receives the message and finds your port forwarding rule for incoming port 80
traffic.

3. The modem router changes the destination IP address in the message to 192.168.0.123 and sends
the message to that computer.

4. Your web server at IP address 192.168.0.123 receives the request and sends a reply message to
your modem router.

5. Your modem router performs Network Address Translation (NAT) on the source IP address and sends
the reply through the Internet to the computer or WiFi device that sent the web page request.

Manage Port Triggering for Services and Applications

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

e An application must use port forwarding to more than one local computer (but not simultaneously).

e An application must open incoming ports that are different from the outgoing port.

With port triggering, the modem router monitors traffic to the Internet from an outbound “trigger” port that
you specify. For outbound traffic from that port, the modem router saves the IP address of the computer

that sent the traffic. The modem router temporarily opens the incoming port or ports that you specify in
your rule and forwards that incoming traffic to that destination.
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Port forwarding creates a static mapping of a port number or range of ports to a single local computer.
Port triggering can dynamically open ports to any computer when needed and close the ports when they
are no longer needed.

Note If you use applications such as multiplayer gaming, peer-to-peer connections, real-time
communications such as instant messaging, or remote assistance, enable Universal
Plug and Play (UPnP). See Improve Network Connections with Universal Plug and Play
on page 171.

Add a Port Triggering Rule

The modem router does not provide default services and applications for port triggering rules. You must
define a custom service or application for each port triggering rule.

To add a port triggering rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

6. Select the Port Triggering radio button.
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Port Forwarding / Port Triggering

® Cancel

Please select the sermvice type.
2 Port Forwarding
'@ Port Triggering

[ Disable Port Triggering
Port Triggering Time-out (in minutes) 20
Port Triggering Portmap Table

# Enable Service Name Service Type Inbound Connection Service User

+ Add Service | ra Edit Service x Delete Service

7. Click the Add Service button.

Port Triggering

Service

Senice Name:

Senvice User: Any A
Senvice Type: TCP ~

Triggering Port {1~65535)

Required Inbound Connection

Senvice Type: TCP -
Starting Port (1~65535)
Ending Port: (1~65535)

8. Specify a new port triggering rule with a custom service or application as described in the following
table.

Field Description

Service

Service Name Enter the name of the custom service or application.

Service User From the Service User menu, select Any, or select Single address
and enter the IP address of one computer:
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Field Description
* Any.This is the default setting and allows any computer on the
Internet to use this service.
* Single address. Restricts the service to a particular computer.
Service Type Select the protocol (TCP or UDP) that is associated with the service or

application.

Triggering Port

Enter the number of the outbound traffic port that must open the inbound
ports.

Required Inbound Connection

Service Type

Select the protocol (TCP or UDP) that is associated with the inbound
connection.

If you are unsure, select TCP/UDP.

Starting Port

Enter the start port number for the inbound connection.

Ending Port

Enter the end port number for the inbound connection.

Your settings are saved and the rule is added to the Port Triggering Portmap Table on the Port
Forwarding / Port Triggering page.

Change a Port Triggering Rule

You can change an existing port triggering rule.

To change a port triggering rule:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are

case-sensitive.

Click the OK button.
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The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

Select the Port Triggering radio button.

Port Forwarding / Port Triggering

Please select the service type.
) Port Forwarding
'@ Port Triggering

[ pisable Port Triggering
Port Triggering Time-out (in minutes) 20
Port Triggering Portmap Table
# Enable Service NHame Service Type Inbound Connection Service User
1 [+ FTPS TCP:990 TCP:989-920 Any
2 ¥ IRC S5L TCP.6697 TCP.6697-6697 192.168.0.114

+ Add Service ra Edit Service ¥ Delete Service

The previous figure shows two port triggering rules.

In the Port Triggering Portmap Table, select the radio button next to the service or application name.
Click the Edit Service button.

The Port Triggering - Services page displays.

Change the settings.

For more information about the settings, see Add a Port Triggering Rule on page 284.
Click the Apply button.

Your settings are saved. The changed rule displays in the Port Triggering Portmap Table on the Port
Forwarding / Port Triggering page.

Remove a Port Triggering Rule

You can remove a port triggering rule that you no longer need.

To remove a port triggering rule:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.
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A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

Select the Port Triggering radio button.

Port Forwarding / Port Triggering

m m pply

Please select the service type.
' Port Forwarding
'@ Port Triggering

["] Disable Port Triggering

Port Triggering Time-out (in minutes) 20
Port Triggering Portmap Table
# Enable Service Name Service Type Inbound Connection Semvice User
1 [ FTPS TCP:990 TCP:989-990 Any
2 [¥] IRC 55L TCP.6697 TCP.6697-6697 192.168.0.114
+ Add Service # Edit Service ¥ Delete Service

The previous figure shows two port triggering rules.

In the Port Triggering Portmap Table, select the radio button next to the service or application name.
Click the Delete Service button.

The rule is removed from the Port Triggering Portmap Table.

Specify the Time-Out for Port Triggering

The time-out period for port triggering controls how long the inbound ports stay open when the modem
router detects no activity. A time-out period is required because the modem router cannot detect when
the service or application terminates.
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To specify the time-out for port triggering:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

Select the Port Triggering radio button.

The port triggering settings display.

In the Port Triggering Time-out field, enter a value up to 9999 minutes.

The default setting is 20 minutes.

Click the Apply button.

Your settings are saved.

Disable Port Triggering

By default, port triggering is enabled. You can disable port triggering temporarily without removing any
port triggering rules.

To disable port triggering:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.
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The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.

6. Select the Port Triggering radio button.
The port triggering settings display.

7. Select the Disable Port Triggering check box.

If this check box is selected, the modem router does not apply port triggering rules even if you specified
them.

8. Click the Apply button.

Your settings are saved.

Application Example: PortTriggering for Internet Relay Chat

Some application servers, such as FTP and IRC servers, send replies to multiple port numbers. Using
port triggering, you can tell the modem router to open more incoming ports when a particular outgoing
port starts a session.

An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at destination port
6667. The IRC server not only responds to your originating source port but also sends an “identify” message
to your computer on port 113. Using port triggering, you can tell the modem router, “When you initiate a
session with destination port 6667, you must also allow incoming traffic on port 113 to reach the originating
computer.”

The following sequence shows the effects of this port triggering rule:

1. You open an IRC client program to start a chat session on your computer.

2. Your IRC client composes a request message to an IRC server using a destination port number of
6667, the standard port number for an IRC server process. Your computer then sends this request
message to your modem router.

3. Your modem router creates an entry in its internal session table describing this communication session
between your computer and the IRC server. Your modem router stores the original information,
performs Network Address Translation (NAT) on the source address and port, and sends this request
message through the Internet to the IRC server.

4. Noting your port triggering rule and observing the destination port number of 6667, your modem router
creates another session entry to send any incoming port 113 traffic to your computer.

5. The IRC server sends a return message to your modem router using the NAT-assigned source port
(for example, port 33333) as the destination port and also sends an “identify” message to your modem
router with destination port 113.

6. When your modem router receives the incoming message to destination port 33333, it checks its
session table to see if a session is active for port number 33333. Finding an active session, the modem
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router restores the original address information replaced by NAT and sends this reply message to
your computer.

When your modem router receives the incoming message to destination port 113, it checks its session
table and finds an active session for port 113 associated with your computer. The modem router
replaces the message’s destination IP address with your computer’s IP address and forwards the
message to your computer.

When you finish your chat session, your modem router eventually senses a period of inactivity in the
communications. The modem router then removes the session information from its session table, and
incoming traffic is no longer accepted on port numbers 33333 or 113.
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14

This chapter provides information to help you diagnose and solve problems you might experience with your

modem router. If you do not find the solution here, check the NETGEAR support site at

http://support.netgear.com for product and contact information.

This chapter contains the following sections:

Perform Diagnostics on page 292

Quick Tips for Troubleshooting on page 295

Troubleshoot with the LEDs on page 297

You Cannot Log In to the Modem Router on page 298
Troubleshoot the Internet Connection on page 299

Changes Are Not Saved on page 304

Troubleshoot the WiFi Connectivity on page 304
Troubleshoot Your Network Using the Ping Utility on page 305
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Perform Diagnostics

The modem router lets you perform various diagnostic tasks. For normal operation, these tasks are not
required.

Perform a DNS Lookup

Use this test to find the IP address of a web, FTP, mail, or other server on the Internet.

To look up an IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.

5. Select ADVANCED > Administration > Diaghostics.
The Diagnostics page displays.

6. Inthe Internet Name field, enter the server’s host name such as www.netgear.com.
7. Click the Lookup button.

The results of the lookup display in the IP address and DNS Server fields.

Ping an IP Address

Use this test to send a ping packet request to an IP address to test the connection. If the request times
out because no reply is received, the destination might be unreachable. However, some network devices
can be configured not to respond to a ping.

To ping an IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Diagnostics.
The Diagnostics page displays.

In the IP address field, enter an IP address.
Click the Ping button.

The Diagnostics - Ping page displays the results of the ping test.

To return to the Diagnostics page, click the Back button.

Display the Routing Table

Displaying the modem router’s internal routing table can assist you or NETGEAR technical support in
diagnosing routing problems.

To display the routing table:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Diagnostics.
The Diagnostics page displays.

Click the Display button.

The Diagnostics - Routing Table page displays the routing table.
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To return to the Diagnostics page, click the Back button.

Reboot the Modem Router from the Web Management
Interface

You or NETGEAR technical support can reboot the modem router from the web management interface,
either locally or remotely, for example, when the modem router seems to be unstable or is not operating
normally.

To reboot the modem router from the web management interface:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > Administration > Diagnostics.
The Diagnostics page displays.

Click the Reboot button.
A confirmation pop-up window displays.
Click the OK button.

The modem router reboots.

Quick Tips for Troubleshooting

The following table includes tips for troubleshooting some common problems.

Table 27. Quick tips for troubleshooting

Problem Possible Solution

Your network is Restart your network:
unresponsive or does
not function normally.
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Problem

Possible Solution

1
2
3.
4

Turn off and unplug the DSL, cable, or fiber modem.
Turn off the modem router.
Plug in the DSL, cable, or fiber modem and turn it on. Wait two minutes.

Turn on the modem router and wait two minutes.

If network problems still occur, make sure that your ISP does not require you to

use the MAC address of the computer that was used to initially register the ISP

account. If your ISP does require that you do this, you must change the modem

router MAC address that the modem router uses. For more information, see one
of the following sections:

e Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73

You cannot connect
over an Ethernet
cable to the modem
router.

Make sure that the Ethernet cables are securely plugged in.

Make sure that your computer or device does not use a static IP address but is
configured to receive an IP address automatically with DHCP. (For most devices,
DHCP is the default setting.)

You cannot connect
over WiFi to the
modem router.

Make sure that the WiFi settings in your WiFi device and modem router match
exactly.

For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi
security settings of the modem router and WiFi computer must match exactly. The
default SSID and password are on the product label (see Bottom Panel Product
Label on page 17).

Make sure that your WiFi device supports the security that you are using for your
WiFi network (WEP, WPA, or WPA2). For information about WiFi security settings,
see Manage the Basic WiFi Settings and WiFi Security of the Main Network on
page 102.

Make sure that the modem router is not too far from your WiFi device or too close.
Move your WiFi device near the modem router but at least 6 feet (1.8 meters)
away and see if the signal strength improves.

Make sure that the WiFi signal is not blocked by objects between the modem router
and your WiFi device.

Make sure that the WiFi LED on the modem router is not off.

If this LED is off, both WiFi radios might be disabled. For more information about
the WiFi radios, see Control the WiFi Radios on page 123.

Make sure that the modem router’'s SSID broadcast is not disabled.

If the modem router’s SSID broadcast is disabled, the WiFi network name is hidden
and does not display in your WiFi device’s scanning list. To connect to a hidden
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Problem Possible Solution

network, you must enter the network name and the WiFi password. For more
information about the SSID broadcast, see Manage the Basic WiFi Settings and
WiFi Security of the Main Network on page 102.

* Make sure that your WiFi device does not use a static IP address but is configured
to receive an IP address automatically with DHCP. (For most devices, DHCP is
the default setting.)

Troubleshoot with the LEDs

When you turn on the power, the LEDs light as described here:

1.
Two seconds after the power is first applied, the Power LED lights solid amber for about 10

seconds, turns off for about 20 seconds, and then lights solid amber again.

2. About two minutes after the power is first applied, the Power LED lights solid white, indicating that the
startup procedure is complete and the modem router is ready.

Verify the following:

The Internet LED is blinking white or solid white.
The DSL LED @ is solid white.

The 2.4 GHz WiFi LED and 5 GHz WiFi LED are blinking white or solid white (unless
you turned off the wireless radios).

A USB 3.0 port LED is blinking white or solid white for any connected USB device.

An Ethernet port LED is blinking white or solid white for any connected and powered-on
Ethernet device.

The WiFi LED is solid white (unless you turned off the wireless radios).

The WPS LED is solid white.

You can use the LEDs for troubleshooting. For more information, see the following sections:
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* Power LED Is Off on page 298

e Power LED Remains Solid Amber on page 298

*  WIiFi LED Is Off on page 298

e Troubleshoot the Internet Connection on page 299

Power LED Is Off

If the Power LED and other LEDs are off when your modem router is turned on, do the following:
» Make sure that the Power On/Off button on the back is in the on position, that is, it is pushed in.

» Make sure that the power cord is correctly connected to your modem router and that the power supply
adapter is correctly connected to a functioning power outlet.

* Make sure that you are using the 12 VDC 3.5A power adapter that NETGEAR supplied for this product.

If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware
problem, contact technical support at www.netgear.com/support.

Power LED Remains Solid Amber

Two seconds after the power is first applied, the Power LED lights solid amber for about 10 seconds,
turns off for about 20 seconds, and then lights solid amber again. About two minutes after the power is
first applied, the Power LED lights solid white, indicating that the startup procedure is complete and the
modem router is ready.

If the Power LED remains solid amber and does not turn solid white, a failure occurred or the modem
router is malfunctioning.

If the Power LED does not turn solid white, do the following:

1. Turn the power off and back on and wait several minutes to see if the modem router recovers.

2. If the modem router does not recover, ptress and hold the Reset button to return the modem router
to its factory settings.

If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware
problem, contact technical support at www.netgear.com/support.

WiFi LED Is Off

If the WiFi LED remains off, check to see if both radios on the modem router are disabled (see Control
the WiFi Radios on page 123). By default, both radios are enabled and the WiFi LED lights solid white.

You Cannot Log In to the Modem Router

If you are unable to log in to the modem router from a computer on your local network and use the web
management interface, check the following:
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* Ifyou are using an Ethernet-connected computer, check the Ethernet connection between the computer
and the modem router.

* Make sure that the IP address of your computer is on the same subnet as the modem router. If you
are using the recommended addressing scheme, your computer’s address is in the range of 192.168.0.2
to 192.168.0.254.

* Make sure that your computer can reach the modem router's DHCP server. Recent versions of Windows
and Mac OS generate and assign an IP address if the computer cannot reach a DHCP server. These
autogenerated addresses are in the range of 169.254.x.x. If your IP address is in this range, check
the connection from the computer to the modem router and reboot your computer.

e If your modem router’s IP address was changed and you do not know the current IP address, use an
IP scanner application to detect the IP address. If you still cannot find the IP address, clear the modem
router’s configuration to factory defaults. This sets the modem router’s IP address to 192.168.0.1. For
more information, see Return the Modem Router to Its Factory Default Settings on page 238 and Factory
Settings on page 309.

* Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using Internet
Explorer, click the Refresh button to be sure that the Java applet is loaded.

* Try quitting the browser and launching it again.

* Make sure that you are using the correct login information. The user name is admin, and the default
password is password. Make sure that Caps Lock is off when you enter this information.

» If you are attempting to set up your modem router behind an existing router in your network, set up
the modem router as a WiFi access point (see Use the Modem Router as a WiFi Access Point on
page 131).

« If you are attempting to set up your modem router as a replacement for an ADSL gateway in your
network, the modem router cannot perform many gateway services. For example, the modem router
cannot convert DSL or cable data into Ethernet networking information. NETGEAR does not support
such a configuration.

Troubleshoot the Internet Connection

If your modem router cannot access the Internet, check the DSL connection, then the WAN TCP/IP
connection.

Troubleshoot the DSL Link

If your modem router is unable to access the Internet, first determine whether the DSL link with the service
provider is working. The DSL LED indicates the state of this connection.

DSL LED Is Solid White

If the DSL link LED lights solid white @ the DSL connection is good. You can be confident that the
service provider connected your line correctly and that your wiring is correct.
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DSL LED Is Blinking White

If the DSL LED is blinking white @ your modem router is attempting to make a DSL connection with
the service provider. If the modem router establishes a DSL connection, the DSL LED turns solid white.
This connection process generally lasts several minutes.

If the DSL LED does not turn solid white, disconnect all telephones on the line. If this solves the problem,
reconnect the telephones one at a time, being sure to use a microfilter on each telephone. If the microfilters
are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a solid white DSL LED, a problem with your wiring might
exist. If the telephone company tested the DSL signal at your network interface device (NID), then wiring
in your house might be of poor quality.

DSL LED Is Off or Internet LED Is Off

If the DSL LED is off @ the Internet LED is off , or both are off, disconnect all telephones on the
line. If this solves the problem, reconnect the telephones one at a time, being sure to use a microfilter on
each telephone. If the microfilters are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a blinking white or solid white DSL LED, check the following:
* Check to see that the telephone company made the connection to your line and tested it.

* Verify that you are connected to the correct telephone line. If more than one phone line is installed,
be sure that you are connected to the line with the DSL service. It might be necessary to use a swapper
if your DSL signal is on pins 1 and 4 or the RJ-11 jack. The modem router uses pins 2 and 3.

Internet LED Is Off

If the Internet LED is off , the modem router cannot connect to the Internet. Verify the following:

» Check to see that your login credentials are correct or that the information you entered for the ISP
connection is correct. For more information, see one of the following sections:
e Manually Set Up an ADSL Internet Connection on page 51

e Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73

* Check to see if your ISP is experiencing a problem—it might not be that the modem router cannot
connect to the Internet, but rather that your ISP cannot provide an Internet connection.

Obtain an Internet IP Address

If the modem router cannot access the Internet but the Internet LED lights solid white, see if the
modem router can obtain an Internet IP address from the ISP. Unless the modem router is assigned a
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static IP address, the modem router requests an IP address from the ISP. You can determine whether
the request was successful using the web management interface.

To check the Internet IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://lwww.routerlogin.net.

A login window opens.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

4. Click the OK button.
The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home page displays.
6. Inthe Internet Port pane, check to see that the IP Address field shows a valid IP address.

If the field shows 0.0.0.0, your modem router did not obtain an IP address from your ISP.

If your modem router cannot obtain an IP address from the ISP, the problem might be one of the following:
» Your Internet service provider (ISP) might require a login program. Ask your ISP whether they require
PPP over Ethernet (PPPoE) or some other type of login.

» If you selected a login program, the service name, user name, or password could be incorrectly set.
Before you make any changes, verify that the modem router can get a PPPoE or PPPoA connection
(see Verify the PPPoE or PPPoA Connection on page 302).

* Your ISP might check for your computer’s host name. Assign the computer host name of your ISP
account as the account name. For more information, see one of the following sections:
e Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73
» If your ISP allows only one Ethernet MAC address to connect to Internet and checks for your computer’s MAC

address, inform your ISP that you bought a new network device and ask them to use the modem router’s MAC
address.

e Configure your modem router to clone your computer's MAC address. For more information, see one of the
following sections:
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* Manually Set Up an ADSL Internet Connection on page 51
« Manually Set Up a VDSL Internet Connection on page 63
« Manually Set Up a Cable or Fiber Internet Connection on page 73

Verify the PPPoE or PPPoA Connection

If you use a PPPoE or PPPoA connection to your ISP, make sure that the connection works.

To verify that your PPPoOE or PPPOA connection is working:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://www.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > ADVANCED Home.
The ADVANCED Home page displays.

In the Internet Port pane, check to see that the IP Address field shows a valid IP address and that
the Connection field shows PPPoE or PPPoA.

In the Internet Port pane, click the Connection Status button.
The Connection Status page displays.
Check the following:

The Connection Status field shows Connected.

The Connection Time field does not show 00:00:00.

If the PPPOE or PPPoA connection is not working, make sure that your service name, user name, and
password are set correctly. Or your ISP might not be able to provide an Internet connection. For more
information, see one of the following sections:
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Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service on page 57
Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 68
Specify a Cable or Fiber Connection with a Login Requirement and PPPoE Service on page 79

Reestablish the PPPoE or PPPOA Connection

If your PPPOE or PPPoA configuration information is correct (see Verify the PPPoE or PPPoA Connection
on page 302), your PPPoE or PPPoA connection is working.

To reconnect if your PPPoE or PPPoA connection does not function:

1.
2.

Launch an Internet browser from a computer or WiFi device that is connected to the network.
Type http://lwww.routerlogin.net.

A login window opens.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and password are
case-sensitive.

Click the OK button.

The BASIC Home page displays.

Select ADVANCED > ADVANCED Home.

The ADVANCED Home page displays.

In the Internet Port pane, click the Connection Status button.
The Connection Status page displays.

Click the Connect button.

The modem router attempts to reconnect.

If you cannot connect after several minutes, you might be using an incorrect service name, user name,
or password. Or your ISP might not be able to provide an Internet connection. For more information, see
one of the following sections:

Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoOE Service on page 57
Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 68
Specify a Cable or Fiber Connection with a Login Requirement and PPPoE Service on page 79

Note Unless you connect manually, the modem router does not authenticate using PPPoE
or PPPoA until data is transmitted to the network.
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Troubleshoot Internet Browsing

If your modem router can obtain an IP address but your computer is unable to load any web pages from
the Internet, it might be for one of the following reasons:

The traffic meter is enabled, and the limit was reached.

By configuring the traffic meter not to block Internet access when the traffic limit is reached, you can
resume Internet access (see Unblock the Traffic Meter After the Traffic Limit Is Reached on page 263).
If your ISP sets a usage limit, they might charge you for the overage.

Your computer might not recognize any DNS server addresses.

A DNS server is a host on the Internet that translates Internet names (such as www addresses) to
numeric IP addresses. Typically your ISP provides the addresses of one or two DNS servers for your
use. If you entered a DNS address when you set up the modem router, reboot your computer and
verify the DNS address. Alternatively, you can configure your computer manually with DNS addresses,
as explained in your operating system documentation.

The modem router might not be configured as the TCP/IP router on your computer.

For information about TCP/IP problems, see Troubleshoot Your Network Using the Ping Utility on
page 305.

If your computer obtains its information from the modem router by DHCP, reboot the computer and
verify the modem router address.

Changes Are Not Saved

If the modem router does not save the changes that you make in the web management interface, do the
following:

When entering configuration settings, always click the Apply button before moving to another page
or tab or your changes are lost.

Click the Refresh or Reload button in the web browser. It is possible that the changes occurred but
that the old settings remain in the web browser’s cache.

Troubleshoot the WiFi Connectivity

If you are experiencing trouble connecting over WiFi to the modem router, try to isolate the problem:

Make sure that the WiFi settings in your WiFi device and modem router match exactly.

For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings
of the modem router and WiFi computer must match exactly. The default SSID and password are on
the product label (see Bottom Panel Product Label on page 17).

Does the WiFi device that you are using find your WiFi network?
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If not, check the WiFi LED on the top of the modem router. If this LED is off, both WiFi radios
might be disabled. For more information about the WiFi radios, see Control the WiFi Radios on page
123.

e If you disabled the modem router's SSID broadcast, your WiFi network is hidden and does not display
in your WiFi client's scanning list. (By default, SSID broadcast is enabled.) For more information, see
View or Change the Basic WiFi Settings on page 102.

» Does your WiFi device support the security that you are using for your WiFi network (WEP, WPA, or
WPA2)? For information about changing the WiFi security, see View or Change the Basic WiFi Settings
on page 102.

Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

If your WiFi device finds your network but the signal strength is weak, check these conditions:

e Is your modem router too far from your WiFi device or too close? Place your WiFi device near the
modem router but at least 6 feet (1.8 meters) away and see whether the signal strength improves.

» Are objects between the modem router and your WiFi device blocking the WiFi signal?

Troubleshoot Your Network Using the Ping Utility

Most network devices and routers contain a ping utility that sends an echo request packet to the designated
device. The device then responds with an echo reply. You can easily troubleshoot a network using the
ping utility in your computer or workstation.

Test the LAN Path to Your Modem Router

You can ping the modem router from your computer to verify that the LAN path to your modem router is
set up correctly.

To ping the modem router from aWindows computer:

1. From the Windows taskbar, click the Start button and select Run.
2. Inthe field provided, enter ping followed by the IP address of the modem router, as in this example:

ping 192.168.0.1
3. Click the OK button.
A message such as the following one displays:
Pinging <IP address> with 32 bytes of data
If the path is working, you see this message:

Reply from < IP address >: bytes=32 time=NN ms TTL=xxx
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If the path is not working, you see this message:

Request timed out

If the path is not functioning correctly, one of the following problems might be occurring:

Wrong physical connections

For a wired connection, make sure that the numbered LAN port LED is lit for the port to which you are
connected.

Check that the appropriate LEDs are on for your network devices. If your modem router and computer
are connected to a separate Ethernet switch, make sure that the link LEDs are lit for the switch ports
that are connected to your computer and modem router.

Wrong network configuration

Verify that the Ethernet card driver software and TCP/IP software are both installed and configured
on your computer.

Verify that the IP address for your modem router and your computer are correct and that the addresses
are on the same subnet.

Test the Path from Your Computer to a Remote Device

After you verify that the LAN path works correctly, test the path from your computer to a remote device:

1.
2.

From the Windows toolbar, click the Start button and select Run.
In the field provided, enter

ping -n 10 IP address

where IP address is the IP address of a remote device such as your ISP’s DNS server.

If the path is functioning correctly, replies as described in Test the LAN Path to Your Modem Router on
page 305 display. If you do not receive replies, do the following:

Check to see that the IP address of your modem router is listed as the default router in your computer.
If the IP configuration of your computer is assigned by DHCP, this information is not visible in your
computer’'s Network Control Panel. Verify that the IP address of the modem router is listed as the
default router.

Check to see that the network address of your computer (the portion of the IP address specified by
the netmask) is different from the network address of the remote device.

If your ISP assigned a host name to your computer, enter that host name as the account name. For
more information, see one of the following sections:

» Specify an ADSL Connection Without a Login Requirement on page 51
» Specify a VDSL Connection Without a Login Requirement on page 63
» Specify a Cable or Fiber Connection Without a Login Requirement on page 74

Your ISP might be rejecting the Ethernet MAC addresses of all but one of your computers.

Many broadband ISPs restrict access by allowing traffic only from the MAC address of your modem,
but some additionally restrict access to the MAC address of a single computer connected to that

Diagnostics and Troubleshooting
306



Nighthawk AC1900 WiFi VDSL/ADSL Modem Router Model D7000

modem. In this case, configure your modem router to clone or spoof the MAC address from the
authorized computer. For more information, see one of the following sections:
e Manually Set Up an ADSL Internet Connection on page 51

* Manually Set Up a VDSL Internet Connection on page 63
* Manually Set Up a Cable or Fiber Internet Connection on page 73
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This appendix covers the following topics:
» Factory Settings on page 309

e Technical Specifications on page 311
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Factory Settings

You can reset the modem router to the factory default settings that are shown in the following table.

For more information about resetting the modem router to its factory settings, see Return the Modem
Router to Its Factory Default Settings on page 238.

Table 28. D7000 modem router factory default settings

Feature

Default Behavior

Router login

User login URL

www.routerlogin.net (or www.routerlogin.com or 192.168.0.1)

User name (case-sensitive)

admin

Login password (case-sensitive)

password

Internet connection

WAN MAC address

Use default hardware address

WAN MTU size Determined by the protocol that is used for the Internet
connection (see MTU Concepts on page 99)
Port speed Autosensing

Local network (LAN)

LAN IP address

192.168.0.1

Subnet mask

255.255.255.0

DHCP server

Enabled

DHCP range

192.168.0.2 to 192.168.0.254

DHCP starting IP address

192.168.0.2

DHCP ending IP address

192.168.0.254

DMz

Disabled
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Feature

Default Behavior

Time zone

* North America: Pacific Standard Time
* Europe: GMT
* Other continents: Varies by region

Time adjusted for daylight saving time Enabled
Main WiFi network
WiFi communication Enabled

SSID name

See product label

Security

WPA2-PSK (AES)

WiFi passphrase

See product label

Country/region

* North America: United States
* Europe: Europe
*  Other continents: Varies by region

RF channel

Auto. The available channels depend on the region.

Transmission speed

Auto

Note Throughput can vary. Network conditions
and environmental factors, including volume
of network traffic, building materials and
construction, and network overhead, affect
the data throughput rate.

Operating mode

*  Upto 600 Mbps at 2.4 GHz
*  Upto 1300 Mbps at 5 GHz

Transmit power 100%
Guest WiFi network
WIiFi communication Disabled
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Feature Default Behavior
SSID name * 2.4 GHz band: NETGEAR_Guestl

* 5 GHz band: NETGEAR-5G_Guestl
Security None (open network)

Allow guests to access main network

Disabled

General WiFi settings

Radio transmission power

100 percent, nonconfigurable

20/40 MHz coexistence Enabled
Fragmentation length 2346
CTS/RTS threshold 2347

Preamble mode

Long Preamble

WPS

WPS capability

Enabled

Modem router’s PIN

Enabled; see the web management interface (select
ADVANCED > Advanced Setup >Wireless Settings)

Keep Existing Wireless Settings

Enabled

Technical Specifications

Table 29. D7000 modem router specifications

Feature Description

Data and routing protocols |TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, Dynamic DNS, UPnP, and SMB
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Feature Description

* North America: 120V, 60 Hz, input
* UK, Australia: 240V, 50 Hz, input
* Europe: 230V, 50 Hz, input

¢ Allregions: 12V @ 3.5A output

Power adapter

Dimensions Dimensions: 285 x 185 x 50 mm (11.22 x 7.26 x 1.97 in.)
Weight Weight: 750 g (1.65 Ib)

Operating temperature 0° to 40°C (32° to 104°F)

Operating humidity 90% maximum relative humidity, noncondensing

«  EN55022:2010/AC:2011, Class B
* CISPR 22:2008, Class B
¢ AS/NZS CISPR 22:2009/Amdt 1:2010, Class B

Electromagnetic emissions

LAN Four RJ-45 ports supporting 10BASE-T, 100BASE-TX, and 1000BASE-T
WAN One RJ-45 port supporting 10BASE-T, 100BASE-TX, and 1000BASE-T
DSL One RJ-11 asynchronous DSL (ADSL/VDSL) port

WiFi Maximum WiFi signal rate complies with the IEEE 802.11 standard.

Note Throughput can vary. Network conditions and environmental
factors, including volume of network traffic, building materials
and construction, and network overhead, affect the data
throughput rate.

Radio data rates Auto-rate sensing

 |EEE 802.11ac 2.0
* |EEE 802.11n version 2.0

* |EEE 802.11n 256QAM IEEE 802.11g, IEEE 802.11b 2.4 GHz IEEE
802.11n, IEEE 802.11a 5.0 GHz

Data encoding standards

Maximum computers per WiFi|Limited by the amount of WiFi network traffic generated by each node (typically
network 50-70 nodes).
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Feature Description

e 2.4 GHz band
e US:2.412-2.462 GHz

* Europe: 2.412-2.472 GHz
* Australia: 2.412—-2.472 GHz
e Japan: 2.412-2.472 GHz
* 5 GHz band
* US:5.18-5.24 + 5.745-5.825 GHz
* Europe: 5.18-5.24 GHz
* Australia: 5.18-5.24 + 5.745-5.825 GHz
e Japan:5.18-5.24 GHz

Operating frequency range

802.11 security WPA2-PSK, WPA-PSK, WPA/WPA2 (mixed mode), WPA/WPA2 Enterprise,
and WEP

* VDSL2,VDSL, ADSL2+, ADSL2, and ADSL multimode
* Up to 100 Mbps, both upstream and downstream

xDSL data rate

* Supports Annex A, L, and M

»  Supports all VDSL2 profiles: 8a, 8b, 8¢, 8d, 12a, 12b, and 17a
* VDSL2 interface compliance with ITU-T993.2

¢ (G.992.1 (G.dmt), Annex A compliant

¢ (G.992.2 (G.lite), Annex A compliant

* ANSI T1.413 compliant

*  (G.992.3 (ADSL2) compliant, Annex A, L, and M

*  (G.992.5 (ADSL2+) compliant, supporting Annex A and M
¢ (G.993.2 compliant, Annex A

* (G.993.5 (Vectoring)

¢ ATM and PTM (dual-priority)
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